Keysight Technologies B2900 Series
Precision Source/Measure Unit

User’s Guide
Notices

Copyright Notice
© Keysight Technologies 2011–2015
No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Keysight Technologies as governed by United States and international copyright laws.

Manual Part Number
B2910-90010

Edition
Edition 1, March 2011
Edition 2, July 2011
Edition 3, November 2014
Edition 4, December 2015

Printed in:
Printed in Malaysia

Published by:
Keysight Technologies International Japan G.K.
9-1, Takakura-cho, Hachioji-shi, Tokyo 192-0033 Japan

Technology Licenses
The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

Declaration of Conformity
Declarations of Conformity for this product and for other Keysight products may be downloaded from the Web. Go to http://www.keysight.com/go/conformity. You can then search by product number to find the latest Declaration of Conformity.

U.S. Government Rights
The Software is “commercial computer software,” as defined by Federal Acquisition Regulation (“FAR”) 2.101. Pursuant to FAR 12.212 and 27.405–3 and Department of Defense FAR Supplement (“DFARS”) 227.7202, the U.S. government acquires commercial computer software under the same terms by which the software is customarily provided to the public. Accordingly, Keysight provides the Software to U.S. government customers under its standard commercial license, which is embodied in its End User License Agreement (EULA), a copy of which can be found at http://www.keysight.com/find/sweula. The license set forth in the EULA represents the exclusive authority by which the U.S. government may use, modify, distribute, or disclose the Software. The EULA and the license set forth therein, does not require or permit, among other things, that Keysight: (1) Furnish technical information related to commercial computer software or commercial computer software documentation that is not customarily provided to the public, or (2) Relinquish to, or otherwise provide, the government rights in excess of these rights customarily provided to the public to use, modify, reproduce, release, perform, display, or disclose commercial computer software or commercial computer software documentation. No additional government requirements beyond those set forth in the EULA shall apply, except to the extent that those terms, rights, or licenses are explicitly required from all providers of commercial computer software pursuant to the FAR and the DFARS and are set forth specifically in writing elsewhere in the EULA. Keysight shall be under no obligation to update, revise or otherwise modify the Software. With respect to any technical data as defined by FAR 2.101, pursuant to FAR 12.211 and 27.404.2 and DFARS 227.7102, the U.S. government acquires no greater than Limited Rights as defined in FAR 27.401 or DFAR 227.7103-5 (c), as applicable in any technical data.

Warranty
THE MATERIAL CONTAINED IN THIS DOCUMENT IS PROVIDED “AS IS,” AND IS SUBJECT TO BEING CHANGED, WITHOUT NOTICE, IN FUTURE EDITIONS. FURTHER, TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, KEYSIGHT DISCLAIMS ALL WARRANTIES, EITHER EXPRESS OR IMPLIED, WITH REGARD TO THIS MANUAL AND ANY INFORMATION CONTAINED HEREIN, INCLUDING BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. KEYSIGHT SHALL NOT BE LIABLE FOR ERRORS OR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH THE FURNISHING, USE, OR PERFORMANCE OF THIS DOCUMENT OR OF ANY INFORMATION CONTAINED HEREIN. SHOULD KEYSIGHT AND THE USER HAVE A SEPARATE WRITTEN AGREEMENT WITH WARRANTY TERMS COVERING THE MATERIAL IN THIS DOCUMENT THAT CONFLICT WITH THESE TERMS, THE WARRANTY TERMS IN THE SEPARATE AGREEMENT SHALL CONTROL.

Open Software License
A portion of the software in this product is licensed under terms of the General Public License Version 2 (“GPLv2”). The text of the license and source code can be found at: www.keysight.com/find/GPLv2

Latest Information
To get the latest firmware/software/electronic manuals/specifications/support information, go to www.keysight.com and type in the product number in the Search field at the top of the page.

About Customer Feedback
We love hearing from you. Please take a few moments and let us know how we can improve this manual. Click here to open the Keysight B2900 manual feedback form.

We respect your privacy. Be assured that Keysight will never sell or rent your information. Nor will Keysight share this information with other companies without your expressed consent. We make a commitment to you that we will respect and protect your privacy. Please see the details of this commitment in our Privacy Statement. Click here to open the statement.
NOTICE: This document contains references to Agilent Technologies. Agilent’s former Test and Measurement business has become Keysight Technologies. For more information, go to www.keysight.com.
COMPLIANCE WITH GERMAN NOISE REQUIREMENTS

This is to declare that this product is in conformance with the German Regulation on Noise Declaration for Machines (Lärmangabe nach der Maschinenlärminformation-Verordnung -3.GSGV Deutschland).

- Herstellerbescheinigung
  GERÄUSCHEMISSION
  Lpa < 70 dB
  am Arbeitsplatz
  normaler Betrieb
  nach DIN 45635 T. 19
- Manufacturer's Declaration
  ACOUSTIC NOISE EMISSION
  Lpa < 70 dB
  operator position
  normal operation
  per ISO 7779

South Korean Class A EMC declaration

This equipment is Class A suitable for professional use and is for use in electromagnetic environments outside of the home.

A급 기기
(업무용 방송통신기자재)
이 기기는 업무용(A급) 전자파적합기기로서 판매자 또는 사용자는 이 점을 주의하시기 바라며, 가정외의 지역에서 사용하는 것을 목적으로 합니다.
Safety Summary

The following general safety precautions must be observed during all phases of operation, service, and repair of this instrument. Failure to comply with these precautions or with specific warnings elsewhere in this manual may impair the protections provided by the instrument. In addition, it violates safety standards of design, manufacture, and intended use of the instrument. Keysight Technologies assumes no liability for customer’s failure to comply with these requirements.

Product manuals may be provided on CD-ROM or in printed form. Printed manuals are an option for many products. Manuals may also be available on the Web. Go to www.keysight.com and type the product model number in the Search field at the top of the page.

NOTE

Do not use this instrument in any manner not specified by the manufacturer. The protective features of this instrument may be impaired if it is used in a manner not specified in the operation instructions.

This instrument is an INDOOR USE product.

This instrument complies with INSTALLATION CATEGORY II for mains input and INSTALLATION CATEGORY I for measurement input terminals, and POLLUTION DEGREE 2 defined in IEC 61010-1.

If an instrument is marked CAT I (IEC Measurement Category I), or it is not marked with a measurement category, its measurement terminals must not be connected to line-voltage mains.

Safety of any system incorporating the equipment is the responsibility of the assembler of the system.

WARNING

Hazardous voltage of up to the instrument’s maximum voltage may appear at High Force, Guard, and High Sense terminals if Interlock terminal is closed. Open the Interlock terminal when the High Force, Guard, and High Sense terminals are accessible. Voltage applied to the terminals will be limited up to ±42 V.

Do not work the interlock function intentionally in order to bring the output voltage to the safe level. While the high voltage indicator is lit, the dangerous voltage by the output voltage or the residual charge appears on the measurement terminal.
• **DANGEROUS PROCEDURE WARNINGS**

Warnings, such as WARNING on the previous page, shall be complied. Procedures throughout in this manual prevent you from potentially hazard. Their instructions contained in the warnings must be followed.

• **BEFORE APPLYING POWER**

Verify that all safety precautions are taken. Make all connections to the instrument before applying power. Note the instrument’s external markings described under “Safety Symbols”.

• **GROUND THE INSTRUMENT**

This is Safety Class I instrument. To minimize shock hazard, the instrument chassis and cabinet must be connected to an electrical ground. The power terminal and the power cable must meet International Electrotechnical Commission (IEC) safety standards.

• **DO NOT OPERATE IN AN EXPLOSIVE ATMOSPHERE**

Do not operate the instrument in the presence of flammable gases or fumes. Operation of any electrical instrument in such an environment constitutes a definite safety hazard.

• **DO NOT REMOVE COVERS**

No operator serviceable parts inside. Refer servicing to qualified personnel. To prevent electrical shock do not remove covers.

• **IN CASE OF DAMAGE**

Instruments that appear damaged or defective should be made inoperative and secured against unintended operation until they can be repaired by qualified service personnel. Return the instrument to a Keysight Technologies sales or service office for services and repair to ensure that safety features are maintained.

• **USE ONLY THE SPECIFIC ACCESSORIES**

Specific accessories satisfy the requirements for specific characteristics for using the instrument. Use the specific accessories, cables, adapters, and so on for safety reasons.
Safety Symbols

The general definitions of safety symbols used on equipment or in manuals are listed below.

- **Direct current.**
- **Alternating current.**
- **Earth ground terminal.**
- **Protective conductor terminal.** For protection against electrical shock in case of a fault. Used with field wiring terminals to indicate the terminal which must be connected to ground before operating equipment.
- **Frame or chassis terminal.** A connection to the frame (chassis) of the equipment which normally includes all exposed metal structures.
- **Grounded terminal which indicates the earth potential.**
- **On supply.**
- **Off supply.**
- **Standby supply.** The equipment will be marked with this symbol is not completely disconnected from AC mains when power switch is in the standby position.
- **In position of a bi-stable push switch.**
- **Out position of a bi-stable push switch.**
- **Hazardous voltage and potential for electrical shock.** Do not touch terminals that have this symbol when the equipment is on.
- **Hot surface.** Avoid contact. Surfaces are hot and may cause personal injury if touched.
- **Caution, refer to accompanying documentation.** The equipment will be marked with this symbol when it is necessary for the user to refer to the instruction manual.
- **Read operator's manual.** To indicate that the operator's manual or card should be read before continuing the operation.

**IEC Measurement Category I**

The CE mark shows that the product complies with all applicable European Directives.

The CSA mark is a registered trademark of the Canadian Standards Association.
The RCM mark is a registered trademark of the Australian Communications Authority. This signifies compliance with the Australian EMC Framework Regulations under the terms of the Radio communications Act.

**ICES/NMB-001**

This ISM device complies with Canadian ICES-001. Cet appareil ISM est conforme à la norme NMB-001 du Canada.

**ISM GROUP I CLASS A**

This is the symbol for an Industrial, Scientific and Medical, Group 1 Class A product. (CISPR 11)

Korea’s safety and EMC mark

China RoHS - Environmentally Green Product Label

China RoHS - Product with Toxic Substance 40 yr EPUP

The Chinese mark for paper-based packaging materials; Paperboard and Corrugated Fiberboard

Plastic Material Coding Identification

---

**WARNING**

A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.

---

**CAUTION**

A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.
Power Supply and Measurement Safety

- Power Supply Safety
  This instrument can output high currents and voltages. Make sure that the load or device under test can safely handle the output current and voltage. Also, make sure that the connection leads can safely withstand the expected currents and are insulated for the expected voltages.

  The instrument outputs may be connected so as to float relative to earth ground. Isolation or floating voltage ratings are indicated on the instrument, near the output terminal or the Chassis ground terminal. There is the danger of electric shock by touching the floated measurement terminals. Keep in mind it to protect yourself. And it is a reason of using the recommended accessories.

- Voltage/Current Measurement Safety
  Multimeters and other instruments capable of measuring high voltages and currents are subject to specific safety concerns because of the circuits to which they may be connected. To safely use these instruments, you need to understand the markings on the instrument near the input terminals, which include the Protection Limits and the IEC Measurement Category.

- Protection Limits
  Keysight multimeters and other voltage measurement instruments provide protection circuitry to prevent damage to the instrument and to protect against the danger of electric shock, provided the Protection Limits are not exceeded. To ensure safe operation of the instrument, do not exceed the Protection Limits shown on the input terminals.
Source/Measure Terminals

Source/measure unit, SMU, can simultaneously perform DC voltage or current output and measurement. Typical SMU has the Force, Sense, and Guard terminals as shown below. Normally the Force, Sense, and Guard are the same potential. Voltage marked around the terminals indicates the Protection Limits.

Force and Sense must be connected to a terminal of a device under test (DUT) for the 4-wire connection (Kelvin connection) which is effective for high current measurement and low resistance measurement. For the 2-wire connection to ease the connections, connect Force only. Do not connect Sense. It must be opened.

Guard should be connected to the guard shield which covers the DUT high side wiring for reducing leakage current caused by the wire. Or else, the Guard must be opened.

Chassis ground (green terminal) should be connected to the ground shield which covers the DUT including the guard shield to minimize the affect of noise. Or else, the chassis ground should be opened.

The following image is the source and measurement terminals of Keysight B2900. For the B2900, the High Force, High Sense, and Guard are the same potential. And the Low Force and Low Sense are the same potential.
High Voltage Shock Hazard

Keysight B2900 can force dangerous voltages (±210 V) at the High Force, Guard, and High Sense terminals. To prevent electric shock hazard, the following safety precautions must be observed during the use of Keysight B2900.

- Use a three-conductor AC power cable to appliance coupler (inlet) and the instrument to an electric ground (safety ground).
- Prepare shielding box which covers interface to a device under test and equipped with interlock circuit that opens when the door is opened.
- Before performing measurement, connect the interlock circuit to the Interlock terminal of this instrument.
- Confirm periodically that the interlock function works normally.
- Before touching the connections of the High Force, Guard, and High Sense terminals, turn the instrument off and discharge any capacitors of the measurement path. If you do not turn the instrument off, complete “all” of the following items, regardless of any instrument’s settings.
  - Terminate source output by pressing the On/Off switch, confirm that the On/Off switch turns off.
  - Confirm that the HV (high voltage) status indicator is not lit.
  - Open the shielding box access door (open the Interlock terminal).
  - Discharge any capacitors if the capacitance is connected to this instrument.
- Warn workers in the vicinity of the instrument about hazardous conditions.
Gefahr durch Hochspannung


- Verwenden Sie ein dreiphasiges AC-Stromkabel für die Gerätsteckvorrichtung (Eingang) und schließen Sie das Instrument an eine Erdung an (Sicherheitserdung).
- Bereiten Sie das Abschirmungsgehäuse vor, dass die Oberfläche eines zu testenden Geräts abdeckt und mit einem Verriegelungsstromkreis ausgestattet ist, der bei geöffneter Tür unterbrochen wird.
- Vor der Messung verbinden Sie den Verriegelungsstromkreis mit dem Interlock-Anschluss dieses Instruments.
- Prüfen Sie in regelmäßigen Abständen, dass die Verriegelungsfunktion ordnungsgemäß funktioniert.
  - Beenden Sie die Messung, indem Sie auf die Taste "On/Off" drücken. Stellen Sie sicher, dass die Statusanzeige "On/Off" nicht leuchtet.
  - Stellen Sie sicher, dass die Anzeige "HV" nicht leuchtet.
  - Öffnen Sie die Tür des Abschirmungsgehäuses (öffnen des Interlock-Anschlusses).
  - Entladen Sie alle Kondensatoren, wenn die Kapazität mit das Instrument verbunden ist.
  - Warnen Sie Mitarbeiter in der Umgebung des Instruments vor den Gefahren.
Danger de choc dû à une haute tension

Une tension dangereuse (max. ± pour; 210 Vdc) émanant du dispositif Keysight B2900 peut être sortie aux bornes High Force, Guard et High Sense, d’appareil de protection ou de détection. Les précautions suivantes doivent être observées contre commotion électrique accidentelle.

• Utilisez un câble d’alimentation CA à trois conducteurs vers le coupleur secteur (entrée) et branchez l’instrument sur une mise électrique à la terre (prise de terre de sécurité).

• Préparez le boîtier de protection qui couvre l’interface avec le dispositif à tester et équipez-le d’un circuit de sécurité qui s’ouvre lors de l’ouverture d’une porte.

• Avant de procéder aux mesures, connectez le circuit de sécurité à la borne Interlock de l’instrument.

• Vérifiez régulièrement le bon fonctionnement de la fonction de sécurité.

• Avant de toucher les connexions des bornes High Force, Guard et High Sense, mettez l’instrument hors tension et déchargez tout condensateur du chemin de mesure. Si vous ne mettez pas l’instrument hors tension, effectuez « toutes » les opérations ci-dessous, quels que soient les paramètres de l’instrument.

  • Terminez les mesures en appuyant sur la touche On/Off ; vérifiez que l’indicateur d’état On/Off est éteint.

  • Vérifiez que le témoin HV est éteint.

  • Ouvrez la trappe d’accès au boîtier de protection (ouvrez la borne Interlock).

  • Déchargez les éventuels condensateurs si la capacité est connectée à l’instrument.

• Informez les personnes travaillant à proximité de l’instrument des conditions.
高電圧感電注意

Keysight B2900 の High Force、Guard、High Sense 端子には、危険電圧が出力されることがあります（最大 ±210 Vdc）。感電事故防止のため、必ず以下の事柄を守ってください。

- 3極電源ケーブルを使用して本器を接地してください。
- ドアを開くことによって開放されるインターロック回路を装備し、被測定デバイスとのインタフェースを覆うことのできるシールド・ボックスを用意してください。
- 測定を開始する前にはインターロック回路を本器の Interlock 端子に接続してください。
- インターロック機能が正常であることを定期的に確認してください。
- High Force、Guard、High Sense 端子に繋がる接続部に触れると本器の電源を断続してください。また、測定系のキャパシタを放電してください。電源を切らない場合は、以下の事項を全て実施してください。
  - On/Offスイッチを持って On/Off スイッチが消灯したことを確認してください。
  - 高電圧警告インジケータ（HV）が消灯していることを確認してください。
  - シールド・ボックスのドアを開けてください（Interlock 端子を開けてください）。
  - 本器にキャパシタが接続されているならば、キャパシタを放電してください。
  - 周囲のほかの作業者に対しても、高電圧危険に対する注意を徹底してください。
Product Stewardship

  
  This product complies with the WEEE Directive (2002/96/EC) marking requirements. The affixed label indicates that you must not discard this electrical/electronic product in domestic household waste.

  Product Category: With reference to the equipment types in the WEEE directive Annex 1, this product is classified as a “Monitoring and Control instrumentation” product.

  Do not dispose in domestic household waste.

  To return unwanted products, contact your local Keysight office or visit the following website for more information.


- LCD Fluorescent Lamp

  Certain products sold by Keysight contain a liquid crystal display (LCD); backlighting for the LCD is provided by a fluorescent lamp which contains mercury, and must be managed, recycled, and/or disposed in accordance with all applicable laws, ordinances and regulations.

  For information on how to recycle or dispose of the fluorescent lamp contained in your own product, visit the following website.


  If you live in the U.S., also visit the following websites.

  http://www.lamprecycle.org
  http://www.eiae.org

  If you have additional questions, please visit the following website.

  http://www.keysight.com/go/contactus

- Perchlorate Information

  Perchlorate Material - special handling may apply. Visit the following website.

  http://www.dtsc.ca.gov/hazardouswaste/perchlorate/

  Equipment's real-time clock battery or coin cell battery may contain perchlorate and may require special handling when recycled or disposed of in California.
In This Manual

This manual describes the front panel operation, installation, and functions of the Keysight Technologies B2900 Precision Source/Measure Unit, SMU. This manual consists of the following chapters.

1. "Getting Started"
   This chapter briefly explains how to use the Keysight B2900 by the front panel operation.

2. "Introduction"
   This chapter describes overview, accessories, and options of the Keysight B2900.

3. "Installation"
   This chapter explains how to install the Keysight B2900, and how to connect the device under test to a test fixture.

4. "Front Panel Reference"
   This chapter provides the reference information of the Keysight B2900 front panel keys and graphical user interface.

5. "Front Panel Operations"
   This chapter explains how to use the Keysight B2900 in the local mode.

6. "Function Details"
   This chapter explains the several functions and initial settings of the Keysight B2900.

NOTE
For the specifications of the B2900, see Data Sheet.
To get the latest Data Sheet, go to www.keysight.com/find/b2901a and click “Technical Support” and “Specifications”.

NOTE
The information is subject to change without notice due to the future enhancement.
The actual screen image on the B2900 may be different from the image shown in this manual.
### Contents

- Inspecting the Shipment ............................................. 3-3
  - Checking the Operation of Keysight B2900 ................... 3-4
  - Checking for Errors ............................................. 3-4
- Installing the Keysight B2900 .................................... 3-6
  - Safety Considerations ........................................... 3-6
  - Environment ..................................................... 3-6
- Connecting the Power Cord ........................................ 3-7
  - Setting the Power Line Frequency ............................... 3-9
  - Setting Date and Time .......................................... 3-9
  - Bench Installation .............................................. 3-9
  - Rack Installation ................................................. 3-10
- Maintenance ......................................................... 3-11
  - Cleaning ........................................................... 3-11
  - Self-test ........................................................... 3-11
  - Self-calibration ................................................... 3-12
  - Calibration ........................................................ 3-13
- Connecting a DUT .................................................... 3-14
  - 2-Wire Connections or 4-Wire Connections ................... 3-15
- Floating .............................................................. 3-16
  - Using Test Leads ................................................ 3-18
- Using the N1295A Test Fixture ..................................... 3-19
- Using the 16442B Test Fixture ..................................... 3-20
  - Guarding ............................................................ 3-23
  - Performing Low Current Measurements ....................... 3-23
- Installing the Interlock Circuit ................................... 3-24
  - Connecting to the Interfaces .................................. 3-27
  - GPIB/USB Interfaces ............................................. 3-27
  - LAN Interface .................................................... 3-29
Contents

Communicating Over the LAN ........................................ 3-31
Using the Graphical Web Interface .............................. 3-31
Using Telnet ............................................................. 3-32
Using Sockets ............................................................. 3-32
Using Digital I/O ........................................................ 3-34
Accessory for Digital I/O Connector ............................ 3-36

4. Front Panel Reference

Hard Keys and Rotary Knob ........................................ 4-3
Display and Assist Keys ............................................. 4-6
Dual View ................................................................. 4-7
Single View ............................................................... 4-9
Graph View ............................................................... 4-19
Roll View ................................................................. 4-21
Status Information .................................................... 4-24
Function Keys ........................................................... 4-25
Config key group ....................................................... 4-26
Output Filter dialog box ............................................. 4-27
Output Connection dialog box ................................. 4-28
Sweep dialog box ....................................................... 4-29
Ranging dialog box .................................................... 4-30
Wait Control dialog box ............................................. 4-31
Function key group .................................................... 4-32
Math Expression dialog box ....................................... 4-32
Composite Limit Test Setup dialog box ...................... 4-33
Limit Test Setup dialog box ....................................... 4-34
Trace Buffer Setup dialog box ................................. 4-36
Trigger key group ..................................................... 4-37
Trigger Configuration dialog box ............................... 4-38
Contents

Result key group ................................................................. 4-40
  Measure Result dialog box ............................................. 4-40
  Limit Test Result dialog box ........................................... 4-41
  Trace Statistical Result dialog box ................................. 4-42
File key group ................................................................. 4-43
  File Selection dialog box ................................................ 4-43
Program key group .......................................................... 4-44
I/O key group ....................................................................... 4-45
  Data Output Format ........................................................... 4-46
  Format (Measure) dialog box ............................................ 4-47
  Format (Math/Limit) dialog box ........................................ 4-47
  Format (Trace) dialog box ............................................... 4-47
  LAN Configuration dialog box ......................................... 4-48
  DIO Configuration dialog box ........................................... 4-48
  DIO Read/Write dialog box .............................................. 4-49
Display key group ............................................................. 4-50
  Display Preference dialog box ......................................... 4-51
System key group ............................................................. 4-52

5. Front Panel Operations

  Basic Operations ............................................................. 5-3
  To Change the Setting in a Field ...................................... 5-3
  To Change the Settings on a Dialog Box ................................ 5-4
  To Use Functions other than Measurement ................................ 5-5
  To Set Power Line Frequency .......................................... 5-6
  To Return to Factory Shipment Condition ........................... 5-6
  To Apply Initial Settings ................................................... 5-6
  To Set Beeper ................................................................. 5-6
  To Set Date and Time ....................................................... 5-6
Contents

To Perform Self-Test ..................................................... 5-7
To Perform Self-Calibration ........................................... 5-7
To Set Operations at Power On ........................................ 5-7
To Display Error Message ............................................. 5-7
To Clear Error Buffer ................................................... 5-8
To Clear Timestamp ..................................................... 5-8
To Set Automatic Clear of Timestamp ............................... 5-8
To Display Firmware Revision ......................................... 5-8
To Display License Information ....................................... 5-8
To Set GPIB Address .................................................... 5-9
To Set Remote Control Command Set ................................ 5-9
To Set Remote Display Mode .......................................... 5-9
To Save/Recall All Setup Information ............................... 5-10
To Enable/Disable Media Transfer Protocol for Easy File Access 5-10
To Enable/Disable the Function to Restore the Trigger Mode Settings on the Local State 5-10
To Enable/Disable Source/Limit Real Time Update by Using Digit Pointer and Knob ........................................ 5-11
To Set Source Output ................................................... 5-12
To Set Source Output Mode ............................................ 5-13
To Apply DC Voltage/Current ......................................... 5-13
To Stop Source Output .................................................. 5-13
To Set Limit Value ....................................................... 5-13
To Set Output Range ..................................................... 5-14
To Set Pulse Output ..................................................... 5-14
To Set Sweep Output ................................................... 5-15
To Set List Sweep Output .............................................. 5-16
To Set Source Output Trigger Parameters ......................... 5-16
To Set Source Wait Time ............................................... 5-17
To Set Output Filter .................................................... 5-17
To Set Connection Type ............................................... 5-18
Contents

To Set Low Terminal State ............................................... 5-18
To Enable or Disable High Capacitance Mode ......................... 5-18
To Enable or Disable Over Voltage/Current Protection ............... 5-19
To Specify Output-Off Status ............................................ 5-19
To Enable or Disable Automatic Output-On Function ................. 5-20
To Enable or Disable Automatic Output-Off Function ............... 5-20
To Set Ranging Mode of the Sweep Source ........................... 5-20
To Set Sweep Direction .................................................... 5-21
To Set Source Output Value after Sweep .............................. 5-21
To Execute Measurement .................................................... 5-22
To Enable Resistance Measurement ..................................... 5-22
To Set Measurement Mode .................................................. 5-23
To Perform Spot Measurement ............................................ 5-23
To Stop Measurement ....................................................... 5-23
To Set Measurement Time ................................................... 5-23
To Set Measurement Range ................................................ 5-24
To Perform Sweep Measurement ......................................... 5-24
To Set Measurement Trigger Parameters ............................... 5-25
To Set Measurement Wait Time ............................................ 5-25
To Set Measurement Auto Range Operation ............................ 5-26
To Enable or Disable Resistance Compensation ...................... 5-26
To Use Math Function ....................................................... 5-27
To Execute Limit Test ....................................................... 5-28
To Set Composite Limit Test .............................................. 5-28
To Set Individual Limit Tests ............................................. 5-29
To Display Limit Test Result .............................................. 5-31
To Use Trace Buffer .......................................................... 5-32
To Set Trace Buffer .......................................................... 5-32
To Display Statistical Data ................................................. 5-33
To Use Program Memory ..................................................... 5-34
Contents

To Select a Program ................................................. 5-34
To Control Program Operation ................................. 5-34

6. Function Details

Limit/Compliance .................................................. 6-3
To Set Compliance .................................................. 6-3
Ranging Mode ....................................................... 6-4
Setting the Ranging Mode ...................................... 6-4
Measurement Time .................................................. 6-5
Aperture Time ....................................................... 6-5
Overhead Time ....................................................... 6-5
To Control Source/Measure Timing ............................ 6-5
Pulse Output ......................................................... 6-7
To Control Pulse Output/Measure Timing ................. 6-7
To Set Pulse Output .............................................. 6-8
Sweep Output ......................................................... 6-9
To Set Sweep Output ............................................. 6-9
List Sweep .......................................................... 6-10
Output Filter ......................................................... 6-11
Over Voltage/Current Protection ............................... 6-12
Output-Off Status .................................................. 6-13
Automatic Output-ON/OFF Function ......................... 6-14
High Capacitance Mode ........................................... 6-15
Resistance Measurement ........................................ 6-16
Resistance Compensation ....................................... 6-16
Math Expression ..................................................... 6-17
Predefined Math Expressions .................................. 6-17
Contents

Resources Used in the Expressions ........................................... 6-18
Limit Test ................................................................................. 6-20
Trace Buffer .............................................................................. 6-23
Program Memory ....................................................................... 6-25
Channel Grouping ..................................................................... 6-26
Trigger System .......................................................................... 6-27
  Trigger Source......................................................................... 6-29
  Device Actions......................................................................... 6-29
  Trigger Output......................................................................... 6-31
File Access Function (Easy File Access) .................................. 6-32
Interlock Function ...................................................................... 6-33
Over Temperature Protection .................................................... 6-34
Initial Settings ........................................................................... 6-35
1 Getting Started
Getting Started

This chapter describes basic operations for Keysight B2900. Before learning the details of B2900, let us briefly cover the use of the B2900 source/measure unit. The operations require only B2900 and the power cord. To get started with the operations, open the measurement terminals.

This chapter consists of the following sections.

• “Applying DC Output”
• “Performing Spot Measurement”
• “Performing Sweep Measurement”
• “Operation Tips”
• “Operation Summary”

NOTE

Turning B2900 on

1. Connect the power cord from the AC input connector (receptacle) on B2900’s rear panel to an AC power outlet at your site.

2. Press the standby switch on the front panel. When the power is on, the LED below the switch is turned green.

B2900 boots up and performs a self-test. After B2900 boots normally, the front panel LCD displays the following view. It will be the Single view for the 1-channel model or the Dual view for the 2-channel model.

NOTE

Connecting your DUT

If you want to connect your device under test, see “Connecting a DUT” on page 3-14.
Applying DC Output

B2900 can be used as a DC voltage or current source. The following procedure configures B2900 as a voltage source and applies a voltage of +500 mV.

Step 1. Setting the Source mode (voltage output)

1. Press the Mode assist key on a 1-ch model, or the Ch1 Mode assist key on a 2-ch model.

   The field pointer appears on the Source mode, and the status changes to EDIT (green). The status information will show EDIT.

2. Press the VOLTS (V) assist key. Or use the rotary knob or arrow keys and to specify the mode, and press the knob to fix the setting.

   The status changes to MOVE (blue). The status information will show MOVE.

Step 2. Setting the Source value (voltage output value)

1. Press the Source assist key on a 1-ch model, or the Ch1 Source assist key on a 2-ch model. Or, use the rotary knob or arrow keys to move the field pointer onto the Source value and press the knob. The field pointer appears on the Source value, and the status changes to EDIT (green).

2. Turn the rotary knob clockwise to increase the value, or counter clockwise to decrease the value. Set the desired value.

   When you press an arrow key, a digit pointer will appear on a digit. Turning the knob will change the value of the digit, or move the decimal point if the pointer is on it.

3. Press the rotary knob to fix the value. The status changes to MOVE (blue).

   The numeric/alpha keys and the unit assist keys are also available for setting the Source value in the same way as for setting the Limit value, shown in the next step.
Getting Started
Applying DC Output

This example sets the Source value to +500 mV.

Step 3. Setting the Limit value (compliance current)

1. Press the Limit assist key on a 1-ch model, or the Ch1 Limit assist key on a 2-ch model. Or, use the rotary knob or arrow keys to move the field pointer onto the Limit value and press the knob. The field pointer appears on the Limit value, and the status changes to EDIT (green).

2. Use the rotary knob, arrow keys, or numeric/alpha keys to set the value.

3. Press one of the unit assist keys to set the unit and fix the value. The status changes to MOVE (blue).

This example sets the Limit value to 1 mA.

Step 4. Enabling the channel

Press the Ch 1 switch to enable channel 1. This turns the switch green. Channel 1 starts applying the voltage specified by the Source value.

Step 5. Disabling the channel

Press the Ch 1 switch to disable channel 1. This turns off the switch light.
Performing Spot Measurement

B2900 can be used as a DC voltage or current meter. The following procedure performs one point current measurement.

Step 1. Setting the measurement mode (current measurement)

Press the Measure assist key on a 1-ch model, or the Ch1 Measure assist key on a 2-ch model. And press the AMPS (I) assist key.

The rotary knob and arrow keys are also available for setting the measurement mode, in the same way as for setting the Source mode under “Applying DC Output”.

Step 2. Enabling the channel

Press the Ch 1 On/Off switch to enable channel 1. This turns the switch green. Channel 1 starts applying the voltage specified by the Source value.

Step 3. Starting measurement

- Press the Trigger key to start a single (one shot) measurement. Spot measurement is performed once.
- Press the Auto key to start a repeat (continuous) measurement. Spot measurement is performed repeatedly.

The measurement results will be displayed in the left half of the LCD.

The following example shows the measurement results for a 1 kΩ resistor connected between the High Force and Low Force terminals of channel 1.

Step 4. Disabling the channel

Press the Ch 1 On/Off switch to disable channel 1. This turns off the switch light.
Performing Sweep Measurement

B2900 supports sweep measurements. The following example applies a staircase sweep voltage and measures the current at each step voltage.

**Step 1.** Press the key to display the Single view.

**Step 2.** Set the Source mode, Limit value, and measurement mode as shown in “Applying DC Output” and “Performing Spot Measurement”.

This example sets the voltage output, a 10 mA limit value, and both current and voltage measurements.

**Step 3.** Setting the Sweep parameters

1. Press the More assist key to change the assist keys.
2. Press the Show Sweep assist key to display the Sweep setup parameters.
3. Press the rotary knob to change the status to EDIT (green).
4. Press the LINEAR SINGLE assist key to set the linear single sweep mode.

The source shape indicator shows the staircase icon, and the status changes to MOVE (blue).
5. Use the rotary knob, arrow keys, or numeric/alpha keys to set the Start (sweep start value), Stop (sweep stop value), and Step (sweep step value) or Points (number of sweep steps).

This example sets Start to 1 V, Stop to 2 V, and Points to 11.

Step 4. Press the View key to display the Graph view.

Step 5. Enabling the channel

Press the Ch 1 switch to enable channel 1. This turns the switch green.

Channel 1 starts applying the voltage specified by the Source value.

Step 6. Press the Trigger key to start a single (one shot) measurement. Sweep measurement is performed once. And the measurement results will be displayed on the graph.

Step 7. Press the Auto Scale assist key to fit the trace in the graph scale.

The following example shows the measurement results for a 1 kΩ resistor connected between the High Force and Low Force terminals of channel 1.

Step 8. Disabling the channel

Press the Ch 1 switch to disable channel 1. This turns off the switch light.
Operation Tips

This section introduces key operation and status information on B2900.

- “Changing the View Mode”
- “Editing the Setup”
- “Status Information”

Figure 1-1  Changing the View Mode

For details about the View mode, see “Display and Assist Keys” on page 4-6.
For more information about the front panel keys, see “Hard Keys and Rotary Knob” on page 4-3.

If the field pointer is in the EDIT (green) status on the Source or Limit (Compliance) field, turning the knob changes the setting value of the source channel in real time.

For details about the status information, see “Status Information” on page 4-24.
Operation Summary

This section summarizes front panel operations on B2900.

- “Basic Operations”
- “Channel Setup”
- “Source Setup”
- “Measurement Setup”
- “Display Setup”
- “File Operations”
- “Miscellaneous Functions”
- “Interface Setup”
- “System Setup and Operations”

For details about front panel operations, see Chapter 4, “Front Panel Reference.”
### Table 1-1  Basic Operations

<table>
<thead>
<tr>
<th>Task</th>
<th>Relevant front panel key</th>
</tr>
</thead>
<tbody>
<tr>
<td>To turn the B2900 on/off</td>
<td>Standby switch</td>
</tr>
<tr>
<td>To change the display mode</td>
<td>View key</td>
</tr>
<tr>
<td>To enable/disable the specified channel</td>
<td>Ch 1 On/Off switch or Ch 2 On/Off switch</td>
</tr>
<tr>
<td>To cancel the previous setup operation</td>
<td>Cancel/Local key</td>
</tr>
<tr>
<td>To return to the upper menu of a function key or softkey</td>
<td>Cancel/Local key</td>
</tr>
<tr>
<td>To return to the local status from the remote status</td>
<td>Cancel/Local key</td>
</tr>
<tr>
<td>To start a single (one shot) output/measurement</td>
<td>Trigger key</td>
</tr>
<tr>
<td>To start a repeat (continuous) measurement</td>
<td>Auto key</td>
</tr>
<tr>
<td>To move the field pointer</td>
<td>Rotary knob or arrow keys</td>
</tr>
<tr>
<td>To move the digit pointer</td>
<td>Rotary knob or arrow keys</td>
</tr>
<tr>
<td>To switch the EDIT/MOVE status</td>
<td>Rotary knob on a setup field</td>
</tr>
<tr>
<td>To select the setup value</td>
<td>Assist keys, rotary knob, or arrow keys</td>
</tr>
<tr>
<td>To save/recall all setup information of the B2900</td>
<td>Config &gt; Save or Recall function keys</td>
</tr>
</tbody>
</table>

### Table 1-2  Channel Setup

<table>
<thead>
<tr>
<th>Task</th>
<th>Relevant front panel key</th>
</tr>
</thead>
<tbody>
<tr>
<td>To enable/disable the specified channel</td>
<td>Ch 1 On/Off switch or Ch 2 On/Off switch</td>
</tr>
<tr>
<td>To select the sensing type; 2-wire or 4-wire</td>
<td>Config &gt; Source &gt; Connection function keys</td>
</tr>
<tr>
<td>To select the low terminal status; grounded or floating</td>
<td>Config &gt; Source &gt; Connection function keys</td>
</tr>
<tr>
<td>To enable/disable high capacitance mode</td>
<td>Config &gt; Source &gt; Connection function keys</td>
</tr>
<tr>
<td>To enable/disable over voltage/current protection</td>
<td>Config &gt; Source &gt; Connection function keys</td>
</tr>
<tr>
<td>To enable/disable resistance compensation</td>
<td>Config &gt; Measure &gt; R Compen function keys</td>
</tr>
<tr>
<td>To enable/disable 2-channel synchronous operation</td>
<td>Config &gt; Common &gt; Group function keys</td>
</tr>
</tbody>
</table>
Table 1-3  Source Setup

<table>
<thead>
<tr>
<th>Task</th>
<th>Relevant front panel key</th>
</tr>
</thead>
<tbody>
<tr>
<td>To enable/disable source output</td>
<td>Ch 1 On/Off switch or Ch 2 On/Off switch</td>
</tr>
<tr>
<td>To select source output mode</td>
<td>Mode, Ch1 Mode, or Ch2 Mode assist key</td>
</tr>
<tr>
<td>To set source output value</td>
<td>Source, Ch1 Source, or Ch2 Source assist key</td>
</tr>
<tr>
<td>To set limit/compliance value</td>
<td>Limit, Ch1 Limit, or Ch2 Limit assist key</td>
</tr>
<tr>
<td>To set constant source ranging mode</td>
<td>Speed assist key or Hide Sweep/Pulse/Trigger assist key on Single view</td>
</tr>
<tr>
<td>To set sweep source</td>
<td>Show Sweep assist key on Single view</td>
</tr>
<tr>
<td>To set list sweep source</td>
<td>Edit assist key in the EDIT status for the LIST sweep Start/Stop/Points field</td>
</tr>
<tr>
<td>To set sweep source ranging mode</td>
<td>Config &gt; Source &gt; Sweep function keys</td>
</tr>
<tr>
<td>To set sweep direction</td>
<td>Config &gt; Source &gt; Sweep function keys</td>
</tr>
<tr>
<td>To set source output value after sweep</td>
<td>Config &gt; Source &gt; Sweep function keys</td>
</tr>
<tr>
<td>To set pulse source</td>
<td>Show Pulse assist key on Single view</td>
</tr>
<tr>
<td>To set output filter</td>
<td>Config &gt; Source &gt; Filter function keys</td>
</tr>
<tr>
<td>To select output-off status</td>
<td>Config &gt; Source &gt; Connection function keys</td>
</tr>
<tr>
<td>To enable/disable automatic output ON</td>
<td>Config &gt; Source &gt; Connection function keys</td>
</tr>
<tr>
<td>To enable/disable automatic output OFF</td>
<td>Config &gt; Source &gt; Connection function keys</td>
</tr>
</tbody>
</table>

Table 1-4  Measurement Setup

<table>
<thead>
<tr>
<th>Task</th>
<th>Relevant front panel key</th>
</tr>
</thead>
<tbody>
<tr>
<td>To enable/disable the specified channel</td>
<td>Ch 1 On/Off switch or Ch 2 On/Off switch</td>
</tr>
<tr>
<td>To select measurement mode</td>
<td>Measure, Ch1 Measure, or Ch2 Measure assist key</td>
</tr>
<tr>
<td>To set measurement speed</td>
<td>Speed assist key on Single view</td>
</tr>
</tbody>
</table>
### Operation Summary

<table>
<thead>
<tr>
<th>Task</th>
<th>Relevant front panel key</th>
</tr>
</thead>
<tbody>
<tr>
<td>To set measurement ranging mode</td>
<td>Speed assist key or Hide Sweep/Pulse/Trigger assist key on Single view</td>
</tr>
<tr>
<td>To define automatic ranging operation</td>
<td>Config &gt; Measure &gt; Ranging function keys</td>
</tr>
<tr>
<td>To set measurement wait time</td>
<td>Config &gt; Common &gt; Wait function keys</td>
</tr>
</tbody>
</table>

**Table 1-5**  
**Display Setup**

<table>
<thead>
<tr>
<th>Task</th>
<th>Relevant front panel key</th>
</tr>
</thead>
<tbody>
<tr>
<td>To change the display mode</td>
<td>View key</td>
</tr>
<tr>
<td>To change the color set</td>
<td>Display &gt; Color function keys</td>
</tr>
<tr>
<td>To enable zoom-in</td>
<td>Display &gt; Zoom &gt; ON function keys</td>
</tr>
<tr>
<td>To disable zoom-in</td>
<td>Zoom Out assist key for the zoom-in display status</td>
</tr>
<tr>
<td>To change the data digits</td>
<td>Display &gt; Digits function keys</td>
</tr>
<tr>
<td>To enable/disable the front panel display in the remote condition</td>
<td>Display &gt; Remote function keys</td>
</tr>
</tbody>
</table>

**Table 1-6**  
**File Operations**

<table>
<thead>
<tr>
<th>Task</th>
<th>Relevant front panel key</th>
</tr>
</thead>
<tbody>
<tr>
<td>To save a measurement result data to USB memory</td>
<td>File &gt; Save &gt; Measure function keys</td>
</tr>
<tr>
<td>To save a math result data to USB memory</td>
<td>File &gt; Save &gt; Math function keys</td>
</tr>
<tr>
<td>To save a limit test result data to USB memory</td>
<td>File &gt; Save &gt; Limit Test function keys</td>
</tr>
<tr>
<td>To save a trace buffer data to USB memory</td>
<td>File &gt; Save &gt; Trace function keys</td>
</tr>
<tr>
<td>To save a system setting data to USB memory</td>
<td>File &gt; Save &gt; Config function keys</td>
</tr>
<tr>
<td>To save a graph screen damp to USB memory</td>
<td>Dump Screen assist key on Graph or Roll view</td>
</tr>
<tr>
<td>To load a system setting data from USB memory</td>
<td>File &gt; Load &gt; Config function keys</td>
</tr>
<tr>
<td>To load a list sweep data from USB memory</td>
<td>Load assist key in the EDIT status for the LIST sweep Start/Stop/Points field</td>
</tr>
</tbody>
</table>
### Table 1-7  Miscellaneous Functions

<table>
<thead>
<tr>
<th>Task</th>
<th>Relevant front panel key</th>
</tr>
</thead>
<tbody>
<tr>
<td>To enable/disable Source/Limit real time update by using digit pointer and knob</td>
<td>Display &gt; Pref. function keys</td>
</tr>
<tr>
<td>To see measurement result</td>
<td>Result &gt; Measure function keys</td>
</tr>
<tr>
<td>To use math expression</td>
<td>Function &gt; Math function keys</td>
</tr>
<tr>
<td>To see math result</td>
<td>Result &gt; Measure function keys</td>
</tr>
<tr>
<td>To set limit test</td>
<td>Function &gt; Limit Test function keys</td>
</tr>
<tr>
<td>To see limit test result</td>
<td>Result &gt; Limit Test function keys</td>
</tr>
<tr>
<td>To set trace buffer</td>
<td>Function &gt; Trace function keys</td>
</tr>
<tr>
<td>To see trace statistical result</td>
<td>Result &gt; Trace function keys</td>
</tr>
<tr>
<td>To select program memory</td>
<td>Program &gt; Catalog function keys</td>
</tr>
<tr>
<td>To control program memory</td>
<td>Program &gt; Control function keys</td>
</tr>
<tr>
<td>To set trigger parameters easily</td>
<td>Show Trigger assist key on Single view</td>
</tr>
<tr>
<td>To set trigger parameters in detail</td>
<td>Function &gt; Trigger &gt; Config function keys</td>
</tr>
<tr>
<td>To control trigger system</td>
<td>Function &gt; Trigger &gt; Initiate/Abort/Immediate function keys</td>
</tr>
</tbody>
</table>

### Table 1-8  Interface Setup

<table>
<thead>
<tr>
<th>Task</th>
<th>Relevant front panel key</th>
</tr>
</thead>
<tbody>
<tr>
<td>To specify measurement data elements</td>
<td>I/O &gt; Format &gt; Measure function keys</td>
</tr>
<tr>
<td>To specify math and limit test data elements</td>
<td>I/O &gt; Format &gt; Math/Limit function keys</td>
</tr>
<tr>
<td>To specify trace statistical data elements</td>
<td>I/O &gt; Format &gt; Trace function keys</td>
</tr>
<tr>
<td>To select data output format</td>
<td>I/O &gt; Format &gt; Data Type function keys</td>
</tr>
<tr>
<td>To enable/disable byte swap of binary data</td>
<td>I/O &gt; Format &gt; Data Swap function keys</td>
</tr>
<tr>
<td>To set LAN configuration</td>
<td>I/O &gt; LAN &gt; Config function keys</td>
</tr>
<tr>
<td>To see status of LAN interface</td>
<td>I/O &gt; LAN &gt; Status function keys</td>
</tr>
</tbody>
</table>
## Operation Summary

### Table 1-9 System Setup and Operations

<table>
<thead>
<tr>
<th>Task</th>
<th>Relevant front panel key</th>
</tr>
</thead>
<tbody>
<tr>
<td>To reset all of LAN connections</td>
<td>I/O &gt; LAN &gt; Reset function keys</td>
</tr>
<tr>
<td>To sets LAN settings to the default settings</td>
<td>I/O &gt; LAN &gt; Default function keys</td>
</tr>
<tr>
<td>To enable/disable Media Transfer Protocol for easy file access</td>
<td>I/O &gt; USB function keys</td>
</tr>
<tr>
<td>To see status of USB interface</td>
<td>I/O &gt; USB function keys</td>
</tr>
<tr>
<td>To set GPIB address</td>
<td>I/O &gt; GPIB function keys</td>
</tr>
<tr>
<td>To see status of GPIB interface</td>
<td>I/O &gt; GPIB function keys</td>
</tr>
<tr>
<td>To set configuration of Digital I/O</td>
<td>I/O &gt; DIO &gt; Config function keys</td>
</tr>
<tr>
<td>To read/write a value set to Digital I/O</td>
<td>I/O &gt; DIO &gt; R/W function keys</td>
</tr>
<tr>
<td>To set power line frequency</td>
<td>System &gt; PLC function keys</td>
</tr>
<tr>
<td>To return to the factory shipment condition</td>
<td>System &gt; More &gt; Factory function keys</td>
</tr>
<tr>
<td>To apply initial settings</td>
<td>System &gt; Reset function keys</td>
</tr>
<tr>
<td>To perform self-calibration</td>
<td>System &gt; Cal/Test &gt; Self-Cal function keys</td>
</tr>
<tr>
<td>To perform self-test</td>
<td>System &gt; Cal/Test &gt; Self-Test function keys</td>
</tr>
<tr>
<td>To check errors</td>
<td>System &gt; Error &gt; Log function keys</td>
</tr>
<tr>
<td>To clear error log</td>
<td>System &gt; Error &gt; Clear function keys</td>
</tr>
<tr>
<td>To clear time stamp</td>
<td>System &gt; Timestamp &gt; Clear function keys</td>
</tr>
<tr>
<td>To set automatic clear of time stamp</td>
<td>System &gt; Timestamp &gt; Auto CLR function keys</td>
</tr>
<tr>
<td>To set start-up operation</td>
<td>System &gt; More &gt; Start-up function keys</td>
</tr>
<tr>
<td>To enable/disable beep and sound</td>
<td>System &gt; More &gt; Sound function keys</td>
</tr>
<tr>
<td>To select remote control command set</td>
<td>System &gt; More &gt; Language function keys</td>
</tr>
</tbody>
</table>
## Operation Summary

<table>
<thead>
<tr>
<th>Task</th>
<th>Relevant front panel key</th>
</tr>
</thead>
<tbody>
<tr>
<td>To enable/disable the function to restore the trigger mode settings on the local state</td>
<td>Display &gt; Pref. function keys</td>
</tr>
<tr>
<td>To set date and time</td>
<td>System &gt; More &gt; Info. &gt; Date/Time function keys</td>
</tr>
<tr>
<td>To perform firmware update</td>
<td>System &gt; More &gt; Info. &gt; Update &gt; Firmware function keys</td>
</tr>
<tr>
<td>To perform demonstration</td>
<td>System &gt; More &gt; Info. &gt; Demo. function keys</td>
</tr>
</tbody>
</table>
Introduction

This chapter describes the basic functions and features of the Keysight B2900, and consists of the following sections.

- “Keysight B2900 Series”
- “Front View”
- “Rear View”
- “Source/Measure Unit”
- “Operation and Functions”
- “Software and Drivers”
- “Accessories”
- “Options”
Keysight B2900 Series

Keysight B2900 is a series of precision SMU (source/measure unit, SMU). B2900 provides the LCD, front panel keys, and rotary knob for applying voltage/current or measuring voltage/current/resistance. B2900 also supports several functions, such as sweep output, pulse output, arbitrary waveform generation, limit test, trace buffer, math expressions, and graph plot. Hence, B2900 can be used as a DC (constant) voltage/current source, sweep voltage/current source, pulse generator, arbitrary waveform generator, and multimeter.

The product lineup of the Keysight B2900 series includes the following products.

<table>
<thead>
<tr>
<th>Model No.</th>
<th>Number of SMU channels</th>
<th>Effective set and measure value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Minimum resolution</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Set</td>
</tr>
<tr>
<td>B2901A</td>
<td>1</td>
<td>1 pA, 1 µV</td>
</tr>
<tr>
<td>B2902A</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>B2911A</td>
<td>1</td>
<td>0.01 pA, 0.1 µV</td>
</tr>
<tr>
<td>B2912A</td>
<td>2</td>
<td></td>
</tr>
</tbody>
</table>

B2900 is a LAN eXtended Interface Core compliant instrument.
Front View

This section describes the front view of the Keysight B2900 series.

- **Standby switch**
  
  Turns the instrument on or off. When the power is on, the LED below the switch is turned green.

- **Display**
  
  Displays the source setup, measurement result, status information, etc. For details, see Chapter 4, “Front Panel Reference.”

- **Trigger key**
  
  Starts a single (one shot) output/measurement or initiates trigger system. If a repeat measurement is in progress, stops it.

  The single measurement is performed with the DC bias output, staircase sweep output, pulsed bias output, or pulsed sweep output set to the channel. One single measurement can contain the maximum of 100000 measurement points.

  Once a single measurement starts, the data buffer (maximum 100000 data) is cleared, and the last single measurement result is stored in the buffer. The measurement result is displayed on the Single view, Dual view, Graph view, or Roll view.

**NOTE**

If measurement is not performed properly, check the trigger setting. The trigger type must be set to AUTO, or the trigger count (Count) must be set properly. See “Trigger parameters” on page 4-17.
• Auto key

Starts a repeat (continuous) measurement. If a repeat measurement is in progress, stops it.

The repeat measurement is performed with the DC bias output of the Source value. And the measurement result is displayed on the Single view, Dual view, or Roll view. The repeat measurement result is not stored in the buffer.

• USB-A connector

Used to connect a USB memory. After disconnecting the USB memory, wait 10 seconds before connecting it again or new one.

**CAUTION**

Turning the instrument off while the USB memory is being accessed may damage the device.

• Function keys

Six function keys are available below the display. They are assigned to the softkeys, Config, Function, Trigger, Result, File, Program, I/O, System, and More. For details, see Chapter 4, “Front Panel Reference.”

• Assist keys

Five assist keys are available to the right of the display. They are assigned to several softkeys, such as Mode, Source, Limit, Measure, and More. The softkey assignment depends on the display mode (Single, Graph, Roll, or Dual). For details, see Chapter 4, “Front Panel Reference.”

• View key

Changes the display mode. Pressing the key changes the mode as shown below.

- **On B2901A**: Single → Graph → (return to Single)
- **On B2902A**: Dual → Single for channel 1 → Single for channel 2 → Graph → (return to Dual)
- **On B2911A**: Single → Graph → Roll → (return to Single)
- **On B2912A**: Dual → Single for channel 1 → Single for channel 2 → Graph → Roll → (return to Dual)

• Cancel / Local key

Cancels the setup operation if the instrument is in the local status. Returns the instrument to the local status if it is in the remote status.
Introduction
Front View

• Numeric/alpha keys
  Used to enter the value of setup parameters such as the source output value, limit (compliance) value, and message, specified by the field pointer.

• Rotary knob
  If the field pointer is in the MOVE (blue) status, turning the knob moves the pointer. Pressing the knob fixes the pointer position and changes the pointer status to EDIT (green).

  If the field pointer is in the EDIT (green) status, turning the knob changes the value of the setup parameter specified by the pointer. Pressing the knob fixes the value and changes the pointer status to MOVE (blue).

• Left and right keys
  If the field pointer is in the MOVE (blue) status, pressing the key moves the pointer.

  If the field pointer is in the EDIT (green) status, pressing the key changes the value of the setup parameter specified by the pointer.

  If the field pointer is in the EDIT (green) status on a numeric value entry field, pressing the key changes the pointer to a digit pointer.

• On/Off switch(es)
  Used to enable or disable the SMU channel. Turns the channel off if it is in the output status even if it is in the remote status. One switch on 1-channel models, and two switches on 2-channel models.

  The switch turns green if the channel is enabled.

  The switch turns red if the channel is in the high voltage state.

• Channel 1 source/measure terminals
  Terminals for SMU channel 1. High Force, Low Force, High Sense, Low Sense, Guard, and chassis ground. For details, see “Connecting a DUT” on page 3-14

CAUTION
Never connect the Guard terminal to any output, including circuit common, chassis ground, or any other guard terminal. Doing so will damage the B2900.

CAUTION
Do not apply current to the chassis ground terminal. Doing so will damage the B2900.
Rear View

This section describes the rear view of the Keysight B2900 series.

- Channel 2 source/measure terminals
  Only on 2-channel models. Terminals for SMU channel 2. High Force, Low Force, High Sense, Low Sense, Guard, and chassis ground. For details, see “Connecting a DUT” on page 3-14

  CAUTION

  Never connect the Guard terminal to any output, including circuit common, chassis ground, or any other guard terminal. Doing so will damage the B2900.

  CAUTION

  Do not apply current to the chassis ground terminal. Doing so will damage the B2900.

- GPIB interface connector
  Use a Keysight 82357A/B USB/GPIB interface or Keysight 10833A/B/C/D GPIB cable to connect to an external computer or equipment.

- Cooling fan

- AC input connector
  AC power cord is connected to this receptacle.

- LAN interface connector
  Connects to 10/100 Base-T interface. Left LED indicates activity. Right LED indicates link integrity.
Introduction

Rear View

- **USB-B connector**
  Connects to USB interface.

- **Digital I/O connector**
  D-sub 25 pin female connector for general purpose I/O (GPIO). Can be used as trigger input/output terminals or as an interface to a handler or the likes. For details, see “Using Digital I/O” on page 3-34

  Pins 16 and 24 and pins 17 and 25 are reserved for the interlock function. If the terminals are open, the instrument output is limited to ±42 V. Be sure to connect the terminals to the Keysight 16442B test fixture or another DUT interface before performing measurements. If you do not use 16442B, you need to install an interlock circuit. For details on how to install the interlock circuit, see “Installing the Interlock Circuit” on page 3-24.

---

**WARNING**

Dangerous voltage, instrument maximum output voltage may appear at the High Force, High Sense, and Guard terminals if the Interlock terminal is closed.

Une tension dangereuse, une tension de sortie maximale de l'appareil peut apparaître aux bornes High Force, High Sense et Guard si la borne Interlock est fermée.

---

**NOTE**

Serial Number

You will need the instrument’s serial number when using the Keysight Technologies telephone assistance program. The serial number label is attached to the bottom of the instrument.
Source/Measure Unit

The source/measure unit (SMU) can apply voltage or current, and can measure current or voltage.

Figure 2-1 shows a simplified SMU circuit diagrams. The SMU can perform the following operations.

- Applies voltage and measures current
- Applies current and measures voltage
- Applies voltage and measures voltage
- Applies current and measures current

Figure 2-1  Simplified SMU Circuit Diagram
Measurement Parameters

B2900 supports the following measurement parameters.

- Current
- Voltage
- Resistance
- Power

Resistance data is given by Resistance=$V_{\text{meas}}/I_{\text{meas}}$.

Power data is given by Power=$V_{\text{meas}} \times I_{\text{meas}}$.

In the above formula, $V_{\text{meas}}$ is the voltage measurement data, and $I_{\text{meas}}$ is the current measurement data.

For using the resistance compensation, see “Resistance Compensation” on page 6-16.

Limit/Compliance

B2900 has a compliance feature that limits the output voltage or current to prevent damage to the device under test. When the SMU applies voltage, you can specify the current limit/compliance. When the SMU applies current, you can specify the voltage limit/compliance. For details about limit/compliance, see “Limit/Compliance” on page 6-3.
Output and Measurement Ranges

This section describes typical specifications of the Keysight B2900 series.

- Maximum voltage and current: see Figure 2-2.
- Maximum power: 31.8 W
- Output/measurement value and resolution: see Table 2-2 to Table 2-7.

Figure 2-2  Maximum Voltage and Current
### Table 2-2: Current Output Range

<table>
<thead>
<tr>
<th>Range value</th>
<th>Setting resolution</th>
<th>DC output current or pulse peak/base current a b</th>
<th>Maximum voltage</th>
<th>Pulse width t c</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>B2901A</td>
<td>B2902A</td>
<td>DC output</td>
<td>Pulsed output</td>
</tr>
<tr>
<td>10 nA d</td>
<td>10 fA</td>
<td>10 fA</td>
<td>±210 V</td>
<td>50 μs ≤ t ≤ t_{max}</td>
</tr>
<tr>
<td>100 nA</td>
<td>1 pA</td>
<td>100 fA</td>
<td>0 ≤</td>
<td>I</td>
</tr>
<tr>
<td>1 μA</td>
<td>10 pA</td>
<td>1 pA</td>
<td>0 ≤</td>
<td>I</td>
</tr>
<tr>
<td>10 μA</td>
<td>100 pA</td>
<td>10 pA</td>
<td>0 ≤</td>
<td>I</td>
</tr>
<tr>
<td>100 μA</td>
<td>1 nA</td>
<td>100 pA</td>
<td>0 ≤</td>
<td>I</td>
</tr>
<tr>
<td>1 mA</td>
<td>10 nA</td>
<td>1 nA</td>
<td>0 ≤</td>
<td>I</td>
</tr>
<tr>
<td>10 mA</td>
<td>100 nA</td>
<td>10 nA</td>
<td>0 ≤</td>
<td>I</td>
</tr>
<tr>
<td>100 mA</td>
<td>1 μA</td>
<td>100 nA</td>
<td>0 ≤</td>
<td>I</td>
</tr>
<tr>
<td>1 A</td>
<td>10 μA</td>
<td>1 μA</td>
<td>0 ≤</td>
<td>I</td>
</tr>
<tr>
<td></td>
<td>105 mA &lt;</td>
<td>I</td>
<td>≤ 1.05 A</td>
<td>±21 V</td>
</tr>
<tr>
<td></td>
<td>0 ≤</td>
<td>I</td>
<td>≤ 1.05 A</td>
<td>□</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□</td>
<td>±180 V</td>
<td></td>
</tr>
<tr>
<td>1.5 A</td>
<td>105 mA &lt;</td>
<td>I</td>
<td>≤ 1.515 A</td>
<td>±210 V</td>
</tr>
<tr>
<td></td>
<td>0 ≤</td>
<td>I</td>
<td>≤ 1.515 A</td>
<td>□</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□</td>
<td>±180 V</td>
<td>50 μs ≤ t ≤ 10 ms</td>
</tr>
<tr>
<td>3 A</td>
<td>105 mA &lt;</td>
<td>I</td>
<td>≤ 1.515 A</td>
<td>±210 V</td>
</tr>
<tr>
<td></td>
<td>0 ≤</td>
<td>I</td>
<td>≤ 1.515 A</td>
<td>□</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□</td>
<td>±180 V</td>
<td>50 μs ≤ t ≤ 10 ms</td>
</tr>
<tr>
<td>10 A</td>
<td>105 mA &lt;</td>
<td>I</td>
<td>≤ 3.03 A</td>
<td>±210 V</td>
</tr>
<tr>
<td></td>
<td>1.515 A &lt;</td>
<td>I</td>
<td>≤ 3.03 A</td>
<td>±6 V</td>
</tr>
<tr>
<td></td>
<td>0 ≤</td>
<td>I</td>
<td>≤ 10.5 A</td>
<td>□</td>
</tr>
<tr>
<td></td>
<td>0 ≤</td>
<td>I</td>
<td>≤ 1.515 A</td>
<td>□</td>
</tr>
<tr>
<td></td>
<td></td>
<td>□</td>
<td>±180 V</td>
<td>50 μs ≤ t ≤ 10 ms</td>
</tr>
</tbody>
</table>

a: DC output

b: Pulsed output

c: Pulse width
Table 2-3 Voltage Output Range

<table>
<thead>
<tr>
<th>Range value</th>
<th>Setting resolution</th>
<th>DC output voltage or pulse peak/base voltage</th>
<th>Maximum current a</th>
<th>Pulse width t b</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>B2901A B2902A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.2 V</td>
<td>1 µV</td>
<td>0 ≤</td>
<td>V</td>
<td>≤ 0.21 V</td>
</tr>
<tr>
<td></td>
<td>0.1 µV</td>
<td></td>
<td>±10.5 A</td>
<td>±10.5 A with 50 µs ≤ t ≤ 1 ms</td>
</tr>
<tr>
<td>2 V</td>
<td>10 µV</td>
<td>0 ≤</td>
<td>V</td>
<td>≤ 2.1 V</td>
</tr>
<tr>
<td></td>
<td>0.1 µV</td>
<td></td>
<td>±105 mA</td>
<td>±105 mA</td>
</tr>
<tr>
<td>20 V</td>
<td>100 µV</td>
<td>0 ≤</td>
<td>V</td>
<td>≤ 6 V</td>
</tr>
<tr>
<td></td>
<td>10 µV</td>
<td></td>
<td>±105 mA</td>
<td>±105 mA</td>
</tr>
<tr>
<td>200 V</td>
<td>1 mV</td>
<td>0 ≤</td>
<td>V</td>
<td>≤ 6 V</td>
</tr>
<tr>
<td></td>
<td>100 µV</td>
<td></td>
<td>±105 mA</td>
<td>±105 mA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6 V &lt;</td>
<td>V</td>
<td>≤ 21 V</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>0 ≤</td>
<td>V</td>
</tr>
</tbody>
</table>

a. Table 2-4 shows the limitations when using Channels 1 and 2 for DC output or Pulsed output with 50 µs ≤ t ≤ t max (=99.9999 ks).
b. Maximum base current is 500 mA for the pulse with 50 µs ≤ t ≤ 1 ms, and 50 mA for the pulse with 50 µs ≤ t ≤ 2.5 ms or 50 µs ≤ t ≤ 10 ms.
c. Maximum duty cycle is 99.9999 % for the pulse with 50 µs ≤ t ≤ t max, and 2.5 % for the pulse with 50 µs ≤ t ≤ 1 ms, 50 µs ≤ t ≤ 2.5 ms, or 50 µs ≤ t ≤ 10 ms.
d. Available for the B2911A and B2912A. Not available for the B2901A and B2902A.
Table 2-4  
Limitations for using Channels 1 and 2

<table>
<thead>
<tr>
<th>Channel 1 voltage V1</th>
<th>Channel 2 voltage V2</th>
<th>Current limit a</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 &lt;</td>
<td>V1</td>
<td>≤ 6 V</td>
</tr>
<tr>
<td>6 V &lt;</td>
<td>V1</td>
<td>≤ 21 V</td>
</tr>
<tr>
<td>6 V &lt;</td>
<td>V1</td>
<td>≤ 21 V</td>
</tr>
<tr>
<td>6 V &lt;</td>
<td>V1</td>
<td>≤ 21 V</td>
</tr>
</tbody>
</table>

a. I1: Channel 1 current, I2: Channel 2 current

Table 2-5  
Current Measurement Range

<table>
<thead>
<tr>
<th>Range value</th>
<th>Current measurement value</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>10 nA a</td>
<td>0 ≤</td>
<td>I</td>
</tr>
<tr>
<td>100 nA</td>
<td>0 ≤</td>
<td>I</td>
</tr>
<tr>
<td>1 µA</td>
<td>0 ≤</td>
<td>I</td>
</tr>
<tr>
<td>10 µA</td>
<td>0 ≤</td>
<td>I</td>
</tr>
<tr>
<td>100 µA</td>
<td>0 ≤</td>
<td>I</td>
</tr>
<tr>
<td>1 mA</td>
<td>0 ≤</td>
<td>I</td>
</tr>
<tr>
<td>10 mA</td>
<td>0 ≤</td>
<td>I</td>
</tr>
<tr>
<td>100 mA</td>
<td>0 ≤</td>
<td>I</td>
</tr>
<tr>
<td>1 A</td>
<td>0 ≤</td>
<td>I</td>
</tr>
<tr>
<td>1.5 A</td>
<td>0 ≤</td>
<td>I</td>
</tr>
<tr>
<td>3 A</td>
<td>0 ≤</td>
<td>I</td>
</tr>
<tr>
<td>10 A b</td>
<td>0 ≤</td>
<td>I</td>
</tr>
</tbody>
</table>

a. Available for the B2911A and B2912A. Not available for the B2901A and B2902A.
b. Available for pulse mode. Not available for DC mode.
### Table 2-6 Voltage Measurement Range

<table>
<thead>
<tr>
<th>Range value</th>
<th>Voltage measurement value</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.2 V</td>
<td>$0 \leq</td>
<td>V</td>
</tr>
<tr>
<td>2 V</td>
<td>$0 \leq</td>
<td>V</td>
</tr>
<tr>
<td>20 V</td>
<td>$0 \leq</td>
<td>V</td>
</tr>
<tr>
<td>200 V</td>
<td>$0 \leq</td>
<td>V</td>
</tr>
</tbody>
</table>

### Table 2-7 Resistance Measurement Range\(^1\)

<table>
<thead>
<tr>
<th>Range value</th>
<th>Resistance measurement value</th>
<th>Display resolution</th>
<th>Test current</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 $\Omega$</td>
<td>$0 &lt; R \leq 2$ $\Omega$</td>
<td>1 $\mu$Ω</td>
<td>1 A</td>
</tr>
<tr>
<td>20 $\Omega$</td>
<td>$2$ $\Omega &lt; R \leq 20$ $\Omega$</td>
<td>10 $\mu$Ω</td>
<td>100 mA</td>
</tr>
<tr>
<td>200 $\Omega$</td>
<td>$20$ $\Omega &lt; R \leq 200$ $\Omega$</td>
<td>100 $\mu$Ω</td>
<td>10 mA</td>
</tr>
<tr>
<td>2 $k\Omega$</td>
<td>$200$ $\Omega &lt; R \leq 2$ $k\Omega$</td>
<td>1 $m$Ω</td>
<td>1 $mA$</td>
</tr>
<tr>
<td>20 $k\Omega$</td>
<td>$2$ $k\Omega &lt; R \leq 20$ $k\Omega$</td>
<td>10 $m$Ω</td>
<td>100 $\mu$A</td>
</tr>
<tr>
<td>200 $k\Omega$</td>
<td>$20$ $k\Omega &lt; R \leq 200$ $k\Omega$</td>
<td>100 $m$Ω</td>
<td>10 $\mu$A</td>
</tr>
<tr>
<td>2 $M\Omega$</td>
<td>$200$ $k\Omega &lt; R \leq 2$ $M\Omega$</td>
<td>1 $\Omega$</td>
<td>1 $\mu$A</td>
</tr>
<tr>
<td>20 $M\Omega$</td>
<td>$2$ $M\Omega &lt; R \leq 20$ $M\Omega$</td>
<td>10 $\Omega$</td>
<td>100 nA</td>
</tr>
<tr>
<td>200 $M\Omega$</td>
<td>$20$ $M\Omega &lt; R \leq 200$ $M\Omega$</td>
<td>100 $\Omega$</td>
<td>10 nA</td>
</tr>
</tbody>
</table>

---

1. The resistance measurement range is effective for the resistance measurements set to the AUTO mode which is selected by the :SENS:RES:MODE command.
Operation and Functions

Front Panel Interface

4.3” color TFT WQVGA (480×272, with LED backlight) provides a graphical user interface (GUI) with the following features.

• 4-view modes (Single, Dual, Graph, Roll view)
• Easy-to-use key operations
• Easy access to basic and advanced source/measurement capabilities

Single view

Single view provides basic and advanced settings and display capabilities for the selected channel from the front panel of the instrument. No additional controller or software is required.

Dual view

Dual view provides the basic settings and display capabilities for both channels 1 and 2. Up to 6½ digits can be displayed in the Dual view mode. This mode is available only for the B2902A and B2912A.

Graph view

Graph view displays measurement results on XY graphs (such as I-V and I-t/V-t curves) on up to 2 channels. This is useful for quick evaluation of device characteristics, especially those obtained from sweep measurements.

Roll view

Roll view draws I-t or V-t curves similar to the curves drawn by a strip chart recorder. Up to 1000 acquired data points can be displayed and updated while the measurement is still in progress. Roll view’s continuous measurement capability is especially useful for monitoring low frequency phenomena. Roll view is available only for the B2911A and B2912A.

Easy-to-Use Key Operations

• Numeric/alpha keys, assist keys, and rotary knob for easy operation
• Numeric/alpha keys enable direct input of alphanumerical values.
• Assist key guides operation on the front panel.
Easy Access to Source/Measurement Capabilities

• Settings:
  • V/I source mode
  • Source value
  • Limit (Compliance) value
  • Sweep parameters
  • Pulse parameters
  • Measure speed
  • Range setting
  • Trigger setting

• Result Displays:
  • Numeric results fully up to 6½ digits both in Single and Dual view modes
  • Characterization in Graph view and Roll view
  • Data list

• Advanced Capabilities:
  • Limit testing by user definable limits working with component handlers
  • Trace memory for accumulating measurement (or math) result and collecting their statistics

• File Operations (USB memory):
  Save:
  • System configuration
  • Measurement/Math result
  • Limit test result
  • Trace data
  • Graph screen dump
  Load:
  • System configuration
  • List sweep data
Source/Measurement Capabilities

Sweep Measurement

- Number of steps: 1 to 2500
- Sweep mode: linear, logarithmic (log), or list
- Sweep direction: single or double
- Type: DC or pulse
- Minimum programmable value to create list sweep waveform:
  - B2901A/B2902A: 20 µs with 1 µs resolution
  - B2911A/B2912A: 10 µs with 1 µs resolution

Digitizing/Sampling Measurement

Digitizing/sampling measurement can be performed by appropriate setting of measure speed and trigger interval.

Minimum trigger interval (maximum speed of measurement):

- B2901A/B2902A: 20 µs (50000 points/s)
- B2911A/B2912A: 10 µs (100000 points/s)

Data Buffers

Data buffers are array of measurement elements. Each elements hold the following values.

- Measured voltage
- Measured current
- Measured resistance
- Time stamp
- Measurement status
- Source setting

Maximum buffer size: 100000 points/channel
Program and Interface Capabilities

Programming Language
The B2900 supports SCPI (Standard Commands for Programmable Instruments).
- Default command set: Supports all of the advanced features of the B2900.
- Conventional command set: Supports industry standard conventional SCPI command set for basic compatibility.

Program Memory
Program memory allows you to store long strings of SCPI command lines once into the built-in volatile memory and then recall those strings multiple times while the program is executing using a single SCPI command. By storing the command strings in memory, the time that would have been spent sending those same commands over a communication bus is eliminated. For tests that utilize lots of repeated code (such as subroutines), program memory can dramatically reduce test times.
- Maximum number of characters of program name: 32 with alphabets, numbers, hyphens, and underscores
- Maximum memory size: 100 KB (2500 lines typical)

LXI
LXI core conformant. The B2900 follows specified LAN protocols and adhere to LXI requirements such as a built-in Web control server and IVI-COM driver.
- Ethernet: 10/100Base-T
- USB2.0: USB-TMC488 protocol (rear × 1)
- GPIB: IEEE-488.2 compliant

USB File System
USB 2.0 high-speed mass storage (MSC) class device (front × 1)
**Digital I/O Interface**

- Connector: 25-pin female D
- Input/output pins: 14 open drain I/O bits
- Absolute maximum input voltage: 5.25 V
- Absolute minimum input voltage: −0.25 V
- Logic low maximum input voltage: 0.8 V
- Logic high minimum input voltage: 2.0 V
- Maximum source current: 1 mA, Vout = 0 V
- Maximum sink current: 50 mA, Vout = 5 V
- 5 V power supply pin:
  Limited to 600 mA, solid state fuse protected
- Safety interlock pin:
  One active high pin and one active low pin. Activation of both pin enables output voltage > 42 V.
Software and Drivers

- Keysight B2900A Quick I/V Measurement Software
  The B2900 includes PC-based Keysight B2900A Quick I/V Measurement Software. This powerful software makes it easy to quickly setup and perform I/V measurements and to display the measurement data in a table or graph without the need to perform any programming. The software allows you to control up to four channels over a GPIB or LAN connection, or one B2900 via a USB connection.
  Operating System: Windows 7 (64 bit/32 bit), XP SP3 (32 bit)
  Other requirements: Microsoft .NET framework 4.0 or later and Keysight IO Libraries 16.0 or later

- Graphical Web Interface
  The Graphical Web Interface is a web browser based instrument control panel. It enables you to set up and perform a measurement easily and quickly from a web browser using the built-in web server. This allows you to control one B2900 over a LAN connection.

- IVI-C or IVI-COM drivers
  Compatible with Windows 7 (64 bit/32 bit), XP SP3 (32 bit) IO Libraries 16.0 or later. Supports Keysight VEE, Microsoft Visual Studio (Visual Basic, Visual C++, Visual C#), National Instruments LabWindows and LabVIEW.

- LabVIEW driver (VI)
  National Instruments LabVIEW 7.0 or later. LabView drivers are available at NI.COM.

**NOTE**
For the latest system requirements, go to [www.keysight.com/find/b2900a](http://www.keysight.com/find/b2900a) and get the information.
Accessories

Furnished Accessories
The Keysight B2900 is furnished with the following accessories.

• Quick Reference, 1 ea.
• Product Reference CD-ROM, 1ea.
• Keysight IO Libraries CD-ROM, 1ea.
• Keysight EasyEXPERT for PC Software CD, 1ea.
• License-to-use for EasyEXPERT
• Power cord, 1 ea.
• USB cable, 1 ea.


Available Accessories
For the available accessories for the Keysight B2900 series, see the catalog Accessories for the Keysight B2900 Precision Instrument Family.

To get the latest catalog, go to www.keysight.com/find/b2901a and click “Technical Support” and “Catalogs”.

# Options

Table 2-8 lists the options for the Keysight B2900.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calibration</td>
<td></td>
</tr>
<tr>
<td>A6J</td>
<td>ANSI Z540 compliant calibration</td>
</tr>
<tr>
<td>UK6</td>
<td>Commercial calibration certificate with test data</td>
</tr>
<tr>
<td>Printed Manual (User’s Guide)</td>
<td></td>
</tr>
<tr>
<td>0B0</td>
<td>No printed manual (printed manual is not shipped)</td>
</tr>
<tr>
<td>AB0</td>
<td>Traditional Chinese</td>
</tr>
<tr>
<td>AB2</td>
<td>Simplified Chinese</td>
</tr>
<tr>
<td>ABA</td>
<td>English</td>
</tr>
<tr>
<td>ABJ</td>
<td>Japanese</td>
</tr>
<tr>
<td>Rack Mount Kit</td>
<td></td>
</tr>
<tr>
<td>1CM</td>
<td>Rack mount kit</td>
</tr>
</tbody>
</table>
Introduction
Options
3 Installation
This chapter describes how to install Keysight B2900 and accessories and consists of the following sections.

- “Inspecting the Shipment”
- “Installing the Keysight B2900”
- “Maintenance”
- “Connecting a DUT”
- “Installing the Interlock Circuit”
- “Connecting to the Interfaces”
- “Communicating Over the LAN”
- “Using Digital I/O”

**WARNING**

To avoid electrical shock and instrument damage, turn the instrument off before connecting or disconnecting measurement cable.

Mettez la machine hors tension pour fixer le connecteur ou pour retirer le connecteur de l’unité centrale.

**WARNING**

There are potentially hazardous voltages (±210 V) present at the High Force, High Sense, and Guard terminals of this instrument. To prevent electrical shock, the following safety precautions must be observed during the use of the instrument.

- Use a three-conductor AC power cord to connect the cabinet (if used) and the instrument to an electrical ground (safety ground).
- If an interlock circuit is not installed in your test fixture or connection interface, you must install and connect the interlock circuit that opens the interlock terminal when the shielding box access door is opened.
- If you change the connection interface, test fixture, prober, and such, connect an interlock cable to the one actually used.
- Confirm periodically that the interlock function works normally.
- Before touching the connections on the High Force, High Sense, and Guard terminals, turn the instrument off and discharge any capacitors. If you do not turn the instrument off, complete all of the following items, regardless of the instrument settings.
  - Press the On/Off switch, and confirm that the switch turns off.
• Confirm that the On/Off switch does not turn red.
• Open the fixture cover or the shielding box access door (open interlock).
• Discharge any capacitors connected to a channel.
• Warn persons working around the instrument about dangerous conditions.

**WARNING**

Une tension dangereuse (max. ± pour; 210 Vdc) émanant du dispositif l'instrument peut être sortie aux bornes High Force, High Sense et Guard. Les précautions suivantes doivent être obserées contre commotion électrique accidentelle.

• Utilisez un cordon d'alimentation CA à trois connecteurs pour connecter la cabine (si utilisée) et l'instrument à la mise électrique à la terre (sol de sécurité).
• Si un circuit de sécurité n'est pas installé dans votre test d'installation ou dans votre interface de connexion, vous devez installer et connecter le circuit de sécurité qui ouvre la borne d'enclenchement lorsque la porte d'accès à la protection de la boîte est ouverte.
• Si vous changez l'interface de connexion, un test d'installation, la sonde, ou toute autre élément, connectez un cordon d'enclenchement à celui utilisé actuellement.
• Vérifiez régulièrement que la fonction de verrouillage fonctionne normalement.
• Avant de toucher les connexions des bornes High Force, High Sense et Guard, éteignez l'instrument et déchargez tous les condensateurs. Si vous n'éteignez pas l'appareil, complétez tous les éléments suivants, indépendamment des réglages de l'appareil.
• Appuyez sur le bouton On/Off, et confirmez que le signal lumineux est éteint.
• Vérifiez que le bouton On/Off ne devienne pas rouge.
• Ouvrez le couvercle d'appareil ou la protection du boîtier de la porte d'accès (verrouillage ouvert).
• Déchargez tous les condensateurs connectés au réseau.
• Informez les personnes se trouvant à proximité de l'appareil à propos des conditions dangereuses.
Inspecting the Shipment

Perform the following inspections when the Keysight B2900 and accessories arrive at your site.

1. Before unpacking any component, inspect all boxes for any signs of damage that might have occurred during shipment, such as:
   - dents
   - scratches
   - cuts
   - water marks
   If you suspect any damage, contact your nearest Keysight Sales and Support Office.

2. When you open the boxes that contain the B2900 and accessories, check the components against the contents lists attached to the boxes.
   If anything is missing, contact your nearest Keysight Sales and Support Office.

3. Verify the operation of B2900 as described in “Checking the Operation of Keysight B2900”.
   If any problem occurs, contact your nearest Keysight Sales and Support Office.

Checking the Operation of Keysight B2900

1. Make sure that the standby switch is set to off.

2. Connect the power cord from the B2900’s rear panel AC input connector (receptacle) to an AC power outlet at your site.

3. Press the standby switch to turn on the instrument.
   The initialization screen will appear on the B2900’s front panel display, and the power-on self-test is automatically executed.
   If the B2900 is operating normally, the front panel LCD displays as shown in Figure 3-1 or 3-2.
Checking for Errors

Errors can be checked as described below.

1. Press the More > System > Error > Log function keys. This opens the Error Log dialog box.

2. Check the errors displayed on the dialog box.
   If no error is detected, “0, No Error” is displayed.

3. Press the OK softkey to close the dialog box.
Installing the Keysight B2900

This section describes information you must pay attention to when installing the Keysight B2900.

- “Safety Considerations”
- “Environment”
- “Connecting the Power Cord”
- “Setting the Power Line Frequency”
- “Setting Date and Time”
- “Bench Installation”
- “Rack Installation”

Safety Considerations

Refer to the Safety Summary page at the beginning of this guide for general safety information. Before installation or operation, check the B2900 and review this guide for safety warnings and instructions. Safety warnings for specific procedures are located at appropriate places throughout this guide.

Environment

WARNING

Do not operate the instrument in dusty environment, or in the presence of flammable gases, corrosive gases, or fumes.

Ne pas utiliser l’appareil dans un endroit poussiéreux, ou en présence de gaz inflammables, corrosifs ou de fumée.

Environmental conditions for the B2900 are described below. The B2900 is designed for use in indoor facilities.

- Temperature range
  - Operating: 0 °C to +55 °C
  - Storage: −30 °C to +70 °C
- Humidity range
  - Operating: 30 % to 80 %RH, non-condensing
Storage 10 % to 90 %RH, non-condensing

- Altitude

**Operating** 0 m to 2,000 m (6,561 ft.)

**Storage** 0 m to 4,600 m (15,092 ft.)

- Power requirement: 100-240 V (±10 %), 50/60 Hz

- Maximum volt-amps (VA): 250 VA

- Dimensions

  Without handle and feet: 88 mm (H) × 213 mm (W) × 450 mm (D)

  Bench configuration (with handle and feet): 180 mm (H) × 260 mm (W) × 480 mm (D)

Fan cools the instrument by drawing air through the sides and exhausting it out the back. The instrument must be installed in a location that allows sufficient space at the sides and back of the instrument for adequate air circulation.

### Connecting the Power Cord

**WARNING**

FIRE HAZARD: Use only the power cord supplied with your instrument. Using other types of power cord may cause overheating of the power cord, resulting in fire.

SHOCK HAZARD: The power cord provides the chassis ground through a third conductor. Be sure to connect to a three-conductor type power outlet with the correct pin grounded.

RISQUE D’INCENDIE: utilisez uniquement le câble d'alimentation fourni avec votre appareil. L'utilisation d'autres types de câble d'alimentation peut provoquer une surchauffe du câble d'alimentation et provoquer un incendie.

RISQUE DE CHOC ÉLECTRIQUE: le câble d’alimentation fournit la masse du châssis par le biais d’un troisième conducteur. Assurez-vous de connecter la prise d'alimentation de type trois conducteurs avec la broche correcte mise à la terre.

**NOTE**

The detachable power cord may be used as an emergency disconnecting device. Removing the power cord will disconnect AC input power to the instrument.
### Installation

#### Installing the Keysight B2900

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Plug Details</th>
<th>PN Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>900</td>
<td></td>
<td>BS 1363/A, 250 V, 10 A</td>
<td>8120-4420</td>
</tr>
<tr>
<td>901</td>
<td></td>
<td>AS/NZS 3112, 250 V, 10 A</td>
<td>8120-4419</td>
</tr>
<tr>
<td>902</td>
<td></td>
<td>IEC 60277-1, 250 V, 10 A</td>
<td>8121-1226</td>
</tr>
<tr>
<td>903</td>
<td></td>
<td>NEMA 5-15P, 125 V, 10 A</td>
<td>8120-6825</td>
</tr>
<tr>
<td>904</td>
<td></td>
<td>NEMA 6-15P, 250 V, 10 A</td>
<td>8120-3996</td>
</tr>
<tr>
<td>905</td>
<td></td>
<td>SEV 1011, 250 V, 10 A</td>
<td>8120-4416</td>
</tr>
<tr>
<td>906</td>
<td></td>
<td>SB 107-2-D1, 250 V, 10 A</td>
<td>8121-1655</td>
</tr>
<tr>
<td>907</td>
<td></td>
<td>IS 1293 and IS 6538, 250 V, 10 A</td>
<td>8121-1690</td>
</tr>
<tr>
<td>908</td>
<td></td>
<td>JIS C 8303, 125 V, 12 A</td>
<td>8121-0743</td>
</tr>
<tr>
<td>909</td>
<td></td>
<td>Israel SI 32, 250 V, 10 A</td>
<td>8121-0724</td>
</tr>
<tr>
<td>910</td>
<td></td>
<td>IRAM 2073, 250 V, 10 A</td>
<td>8121-0725</td>
</tr>
<tr>
<td>911</td>
<td></td>
<td>CEI 23-16, 250 V, 10 A</td>
<td>8121-0722</td>
</tr>
<tr>
<td>912</td>
<td></td>
<td>GB 1002 figure 3, 250 V, 10 A</td>
<td>8120-8376</td>
</tr>
<tr>
<td>913</td>
<td></td>
<td>SANS 164-1, 250 V, 10 A</td>
<td>8120-0564</td>
</tr>
<tr>
<td>914</td>
<td></td>
<td>NEMA WD-6, 250 V, 10 A</td>
<td>8120-0674</td>
</tr>
<tr>
<td>915</td>
<td></td>
<td>NBR 14136, 250 V, 10 A</td>
<td>8121-1809</td>
</tr>
<tr>
<td>916</td>
<td></td>
<td>CNS 10917-2, 125 V, 10 A</td>
<td>8121-1635</td>
</tr>
<tr>
<td>917</td>
<td></td>
<td>CS 0017, 250 V, 10 A</td>
<td>8121-1638</td>
</tr>
</tbody>
</table>
Connect the power cord to the IEC 60320 connector on the rear of the instrument. If the wrong power cord was shipped with your instrument, contact Keysight Technologies.

The AC input on the back of your instrument is a universal AC input. It accepts nominal line voltages in the range of 100 to 240 VAC.

**Setting the Power Line Frequency**

The power line frequency must be set properly for the AC power at your site. Press the following function keys to set the frequency to 50 Hz or 60 Hz.

- For setting to 50 Hz: More > System > PLC > 50 Hz
- For setting to 60 Hz: More > System > PLC > 60 Hz

**Setting Date and Time**

You can set the date and time on the Date and Time dialog box opened by pressing System > Info. > Date/Time function keys.

**Bench Installation**

Do not block the air intake at the sides and the exhaust at the rear of the B2900. Minimum clearances for bench operation are 5 mm along the sides and 100 mm along the back.

For easier display viewing and measurement terminal access, you can tilt up the front of the instrument by turning the handle. To adjust the handle, grab the handle by the sides and pull outward. Then, rotate the handle to the desired position.
Installation
Installing the Keysight B2900

Rack Installation

**NOTE**
Use the Rack Mount kit (Option 1CM) to rack mount the Keysight B2900.

Keysight B2900 can be mounted in a 19-inch EIA rack cabinet. It is designed to fit in two rack-units (2U) of space.

Remove the front and rear rubber bumpers and the handle before rack mounting the B2900.

Do not block the air intake at the sides and the exhaust at the rear of the B2900.

**Removing the Bumper**
Stretch a corner of the rubber bumper and slide it off.

**Removing the Handle**
1. Grab the handle by the sides and pull outward. This will allow you to rotate the handle.
2. Rotate the handle to a vertical position. Then, position the instrument horizontally.
3. Pull outward and then lift the handle upward.

**CAUTION**
When reattaching the handle, pay attention to its direction. Incorrect attachment may damage the hardware.
Maintenance

Maintenance should be performed periodically to keep the Keysight B2900 in good condition. If problems arise, contact your nearest Keysight Sales and Support Office.

- “Cleaning”
- “Self-test”
- “Self-calibration”
- “Calibration”

Cleaning

**WARNING**

**SHOCK HAZARD**: To prevent electric shock, unplug the B2900 before cleaning.

*Risques de choc électrique : afin d’éviter tout choc électrique, débranchez le B2900 avant d’effectuer le nettoyage.*

Use a dry cloth or a cloth slightly dampened with water to clean the external case parts. Do not use detergents or chemical solvents. Do not attempt to clean internally.

Self-test

Keysight B2900 provides the self-test function to check the operation. The self-test is automatically performed when the instrument is turned on. It is recommended to perform the self-test for the following condition or purpose. Before performing the self-test, turn the channel output off and disconnect test leads and cables from the terminals.

- If a channel is in the lock condition due to over temperature

  In this condition, the Emergency dialog box is displayed on the gray background screen, however this is not shown in the remote status if the remote display is set to OFF. And the ERR indicator turns on and the On/Off switch is not effective.

  Perform the self-test to unlock the channel. The channel can be used soon if the self-test does not report any problem.

- If you feel that the instrument may be defective
To perform self-test

The following procedure shows how to perform the self-test.

1. If it is in the remote state, press the Cancel / Local key.
2. Press the On/Off switch and confirm that the switch turns off.
3. Disconnect test leads and cables from the channel terminals.
4. Press the following function keys.
   - More > System > Cal/Test > Self-Test
     Confirmation dialog box is opened.
5. Press the OK key. This starts the self-test.

Self-calibration

Keysight B2900 provides the self-calibration function to maintain the measurement performance. If the environmental temperature changes $\pm 3\, ^\circ C$ or more, perform the self-calibration. This is effective for the accurate measurements by minimizing the effect of thermal drift. The self-calibration must be performed after warming-up of 60 minutes. Before performing the self-calibration, turn the channel output off and disconnect test leads and cables from the terminals.

To perform self-calibration

The following procedure shows how to perform the self-calibration.

1. If it is in the remote state, press the Cancel / Local key.
2. Press the On/Off switch and confirm that the switch turns off.
3. Disconnect test leads and cables from the channel terminals.
4. Press the following function keys.
   - More > System > Cal/Test > Self-Cal
     Confirmation dialog box is opened.
5. Press the OK key. This starts the self-calibration.
Calibration

Calibration and adjustments must be performed periodically so that the instruments satisfy the specifications, and keep a good condition. It is recommended to perform the calibration once a year at least. For the calibration and adjustments, contact your nearest Keysight Sales and Support Office. Trained service personnel will perform the calibration and adjustments.
Connecting a DUT

This section describes how to connect a device under test (DUT) to the Keysight B2900 source/measure terminals.

NOTE

Set the channel output off when changing the connections. If not, the DUT may be damaged.

To set the channel output off, press the On/Off switch and confirm that the switch LED turns off.

This section includes the following descriptions.

- “2-Wire Connections or 4-Wire Connections”
- “Floating”
- “Using Test Leads”
- “Using the N1295A Test Fixture”
- “Using the 16442B Test Fixture”
- “Guarding”
- “Performing Low Current Measurements”

NOTE

Connecting the interlock circuit

B2900 provides an interlock function to prevent the user from receiving an electrical shock from high voltages over ±42 V. If the Digital I/O interlock terminal is open, B2900 cannot apply a high voltage.

For high voltage measurement, connect the interlock terminal to the interlock circuit as described in “Installing the Interlock Circuit” on page 3-24.

WARNING

To avoid touching the end of the extension cable or the terminal area with the DUT, cover over the conductors with insulator. Also it is important to protect the terminal area by using the grounded shield cover and such.

To prevent electrical shock and DUT damage, do not connect or disconnect the DUT while the instrument is applying voltage or current.

When you touch the DUT after measurement, devise a countermeasure of residual charge and heat to prevent electrical shock and burn. Use glove and any tool. Also have enough time for discharge and radiation.
Afin d'éviter de toucher l'extrémité du câble d'allongement ou l'aire de la borne avec l'appareil mis sous tension (AST), couvrez les conducteurs avec l'isolant. En outre, il est important de protéger la zone de la borne en utilisant le couvercle d'écran à la mise à terre, ou tout autre élément.

Afin d'éviter toute décharge électrique et dommage MST, ne branchez ou déconnectez pas la sortie MST alors que la source de sortie est appliquée.

Lorsque vous touchez le MST après la mesure, élaborez une contre-mesure de la charge résiduelle et du chauffage afin d'éviter tout choc électrique et toute brûlure. Utilisez des gants et des outils. Prévoyez également du temps pour la décharge et la radiation.

**2-Wire Connections or 4-Wire Connections**

When connecting a DUT, you can choose the connection type either 2-wire connections or 4-wire connections.

If you want to simplify the connections, use 2-wire connections by connecting the Force terminals only and opening the Sense terminals. The Force terminals can be used to apply and measure DC voltage or current.

To make 4-wire connections, remote sensing, well known as Kelvin connections, use both Force and Sense terminals. Connecting the Force and Sense lines together at the terminal of the DUT minimizes the measurement error caused by the residual resistance of the test leads or cables. This connection is effective for low resistance measurements and high current measurements.

To specify the connection type (Sensing Type), perform the following procedure.

1. Press the Config > Source > Connection function keys. This opens the Output Connection dialog box.
2. Set the Sensing Type on this dialog box. Choose 2-WIRE for 2-wire connections, or 4-WIRE for 4-wire connections.
3. Press the OK softkey. For 4-wire connections, the following indicator appears on the Single view or the Dual view.

   4-wire connection indicator:
Floating

With the default setting, Low Force terminal is connected to the chassis ground. However, it can be internally disconnected from the ground for making the floating condition. This setup is used for connecting the source channels in series.

To specify the low terminal status, perform the following procedure. Setting is not saved. Turning off the instrument sets the status to the grounded.

1. Press the Config > Source > Connection function keys. This opens the Output Connection dialog box.

2. Set the Low Terminal State on this dialog box. It must be FLOATING for the floating status, or GROUNDED for the grounded status.

3. Press the OK softkey.

For the floating status, the following indicator appears on the status information area. And then the Low Force and Low Sense terminals can be connected to the maximum of ±250 V.

Channel 1 floating status indicator:

Channel 2 floating status indicator:
Do not apply current to the chassis ground. Doing so will damage the B2900.

WARNING

To prevent electrical shock, do not touch any of measurement circuit at any time while a floating measurement is in progress. Also use accessories that comply with IEC 61010-2-031. All terminals and the extended conductors must be isolated by using insulation caps, sleeves, etc.

Afin d’éviter toute décharge électrique, ne touchez aucune mesure de circuit à tout moment lorsque la mesure de flotte est en cours. Utiliser également des accessoires qui sont conformes à la norme IEC 61010-2-031. Toutes les bornes et les conducteurs prolongés doivent être isolés en utilisant des bouchons d’isolation, des manchons, etc.
Using Test Leads

B2900 source/measure terminals use banana jacks. For connecting a DUT, the following test leads are available. Figure 3-5 shows the connections for two-terminal device measurements.

- Keysight U8201A Combo Test Lead Kit
  
  Couple of test leads, test probes, alligator clips, SMT grabbers, fine-tips test probes, and banana plugs, CAT III 1000 V, 15 A maximum
  
  Two kits are required for 4-wire connections.

- Keysight 11059A Kelvin Probe Set
  
  Test leads for 4-wire connections, 42 V maximum

![Figure 3-5 Connecting a Two-Terminal Device](image)
Using the N1295A Test Fixture

Keysight N1295A is a test fixture which has four triaxial connectors and which supports two 2-wire connections.

Requirements

- Keysight N1295A test fixture furnished with pin clip wire 4 ea. and pin plug wire 2 ea.
- Keysight N1294A-001 banana to triaxial adapter for 2-wire connections
- Triaxial cable, 2 ea. for one 2-wire connection

Connections

1. Attach the banana to triaxial adapter to the B2900 source/measure terminals. See Figure 3-6. If there is some space as “Bad connection”, the contact is not enough.
2. Connect the triaxial cables between the adapter and N1295A as shown in Figure 3-7.
3. Connect the DUT between terminals 1 and 2 for the example in Figure 3-7.

Figure 3-6 Attaching Banana to Triaxial Adapter

Figure 3-7 Keysight N1295A Connection Example

NOTE

Shielding

N1295A is equipped with a cover. To minimize the effect of ambient noise, close the cover when performing measurements.
Connecting a DUT

**CAUTION**

**Maximum voltage and current**

The test fixture and adapters must be used under the following limitations to prevent damage.

Keysight N1294A-001: ±250 V maximum, ±42 V maximum for connecting N1295A

Keysight N1294A-002: ±250 V maximum, ±42 V maximum for connecting N1295A

Keysight N1295A: ±42 V, 1.05 A maximum

**Using the 16442B Test Fixture**

Keysight 16442B is a test fixture which has six triaxial connectors for source/measure unit (SMU), the GNDU connector for the ground unit of a parameter/device analyzer, the Intlk connector for the interlock control, and six coaxial connectors for other instruments. See *Keysight 16442B User's Guide* for details and accessories of the 16442B.

**Requirements**

- Keysight 16442B test fixture furnished with pin clip wire, pin plug wire, etc.
- Keysight N1294A-001 banana to triaxial adapter for 2-wire connections
- Keysight N1294A-002 banana to triaxial adapter for 4-wire connections
- Triaxial cable, 2 ea. for 2-wire connections, and 3 ea. for 4-wire connections

**NOTE**

**Shielding**

16442B is equipped with a cover. To minimize the effect of ambient noise, close the cover when performing measurements.

**CAUTION**

**Maximum voltage and current**

The test fixture and adapters must be used under the following limitations to prevent damage.

Keysight N1294A-001: ±250 V maximum, ±200 V maximum for connecting 16442B

Keysight N1294A-002: ±250 V maximum, ±200 V maximum for connecting 16442B

Keysight 16442B: ±200 V, 1 A maximum for SMU input
1. Attach the banana to triaxial adapter to the B2900 source/measure terminals. See Figure 3-6. If there is some space as “Bad connection”, the contact is not enough.

2. Connect the triaxial cables between the adapter and the 16442B. Figure 3-8 shows a connection example.

3. Connect the DUT on the 16442B wiring panel by using the 16442B’s furnished accessories, socket module, blank board, and wire suitable for the DUT.

Figure 3-9 shows the connection example for the connections of Figure 3-8.

For 2-wire connections, connect the SMU 1 Force terminal to a DUT terminal, and connect the SMU 2 Force terminal to the other DUT terminal.

For 4-wire connections, connect the SMU 1 Force and Sense terminals to a DUT terminal. And connect the SMU 3 Sense and Guard terminals to the other DUT terminal if the adapter’s Low Force/Low Sense connector is connected to the SMU 3 Sense connector. The Low Force signal appears on the Guard terminal.

Figure 3-8 Connection Example between N1294A and 16442B

Figure 3-9 Connection Example of 16442B Wiring Panel
NOTE

Performing high voltage measurement

When the Digital I/O interlock terminal is open, B2900 cannot apply high voltage over ±42 V. To perform high voltage measurements, B2900 must be connected to the interlock circuit installed in 16442B.

Prepare the N1294A-011 or 012 interlock cable, and connect it between the B2900 Digital I/O connector and the 16442B Intlk connector. B2900 can apply a high voltage when the test fixture cover is closed.

WARNING

Hazardous voltage, instrument maximum output voltage may appear at the High Force, High Sense, and Guard terminals if the fixture cover is closed. To prevent electrical shock, do not expose these lines.

Une tension dangereuse, une tension de sortie maximale de l'appareil peut apparaître aux bornes High Force, High Sense et Guard si le couvercle de l'équipement est fermé. Afin d'éviter toute décharge électrique, n'exposez pas ces lignes.
Guarding

Guarding reduces the leakage current between the instrument and a DUT. This is important when you measure a low current.

Figure 3-10 shows the theory of guarding. The buffer amplifier (×1) keeps the potential of the Guard conductor at the same potential as the High Force conductor, so that the current does not flow between the High Force and Guard conductors. Therefore, the current measured by the instrument is the same as the current at the DUT terminal because no current is leaked.

For the connection examples shown in Figures 3-7 and 3-8, the guard is extended to the test fixture input connectors with triaxial cables.

Figure 3-10 Guarding

CAUTION

Never connect the Guard terminal to any output, including circuit common, chassis ground, or any other guard terminal. Doing so will damage the B2900.

Performing Low Current Measurements

With the default setting, 10 nA and 100 nA measurement ranges are not used. For the low current measurements, the measurement range settings must be changed.

To change the measurement range

1. Press the View key to display the Single view.

   If the Range parameters are not displayed in the lower half of the Single view, press the More, Hide Sweep, Hide Pulse, or Hide Trigger assist key to display the Range parameters.

2. Change the setting of the Measure Amps field of the Range parameters.

   Set AUTO for the auto ranging or FIXED for the fixed range.

   Set 10 nA or 100 nA for the minimum or fixed measurement range.
Installing the Interlock Circuit

The interlock circuit is a simple electric circuit, as shown in Figure 3-11. The circuit electrically opens when an access door is opened, and closes when the door is closed.

B2900 cannot apply high voltages over ±42 V when the Digital I/O interlock terminal is open. To perform high voltage measurements, the B2900 interlock terminal must be connected to the interlock circuit installed in the measurement environment such as the shielding box. The interlock circuit is important and necessary to prevent electrical shock when the user touches the measurement terminals.

**WARNING**

Hazardous voltage, instrument maximum output voltage may appear at the High Force, High Sense, and Guard terminals if the fixture cover is closed. To prevent electrical shock, do not expose these lines.

Une tension dangereuse, une tension de sortie maximale de l'appareil peut apparaître aux bornes High Force, High Sense et Guard si le couvercle de l'équipement est fermé. Afin d'éviter toute décharge électrique, n'exposez pas ces lignes.

**Figure 3-11  Interlock Circuit**

**Requirements**

- LED (Keysight part number 1450-0641 or equivalent), 1 ea.
- Mechanical switch (Keysight N1254A-402 or equivalent), 2 ea.
- Resistor, 500 Ω to 1 kΩ (choose lower one to get higher output of LED), 1 ea.
• 25-pin D-sub connector (for wiring, mounted on the shielding box), 1 ea.
• Connection wire
• 25-pin D-sub cable, 1 ea.

Procedure

1. Mount two mechanical switches onto your shielding box, so that the switches close when the access door is closed, and open when the door is opened. See Figure 3-13 for the switch dimensions.

2. Mount an LED onto your shielding box. See Figure 3-12 for the LED dimensions.

   The LED is used as a high voltage indicator which is lit when B2900 is in the high voltage output status.

3. Mount a D-sub connector onto your shielding box.

4. Use a wire and short the following pins of the D-sub connector. See Figure 3-11 for a connection example.

   For the negative logic: Pins 24 and 25
   For the positive logic: Pins 16 and 17

5. Use a wire and connect the two switches in series between the following pins of the D-sub connector. See Table 3-1 for the Digital I/O pin assignment.

   For the negative logic: Pins 16 and some ground pins
   The ground pins are pin numbers 15 and 17 to 21.
   For the positive logic: Pins 24 and some +5 V pins
   The +5 V pins are pin numbers 22, 23, and 25.

6. Use a wire and connect the LED between the pin 14 and some ground pins of the D-sub connector. Then set the pin 14 to HIGH VOLTAGE LAMP. See “DIO Configuration dialog box” on page 4-48.

7. Connect a resistor between the pin 14 and an unused +5 V pin.
Installation
Installing the Interlock Circuit

Figure 3-12 Dimensions of the LED (Keysight part number 1450-0641)

Figure 3-13 Dimensions of the Interlock Switch (Keysight N1254A-402)
Connecting to the Interfaces

CAUTION

Electrostatic discharges greater than 1 kV near the interface connectors may cause the unit to reset and require operator intervention.

B2900 supports GPIB, LAN, and USB interfaces. All three interfaces are live at power-on. Connect your interface cable to the appropriate interface connector. Information on configuring the interfaces can be found later in this section.

The front panel LAN indicator is lit when the LAN port is connected and configured.

B2900 provides Ethernet connection monitoring. With Ethernet connection monitoring, the instrument’s LAN port is continually monitored and automatically reconfigured.

GPIB/USB Interfaces

NOTE

For detailed information about GPIB and USB interface connections, refer to Connectivity Guide installed with the Keysight IO Libraries.

The following steps will help you quickly get started connecting your instrument to the GPIB (General Purpose Interface Bus). The following figure illustrates a typical GPIB interface system.
Installation
Connecting to the Interfaces

1. If you have not already done so, install the Keysight IO Libraries Suite from the CD shipped with your product.

2. If you do not have a GPIB interface card installed on your computer, turn off your computer and install the GPIB card.

3. Connect your instrument to the GPIB interface card using a GPIB interface cable.

4. Use the Connection Expert utility from the Keysight IO Libraries Suite to configure the installed GPIB interface card’s parameters.

5. B2900 is shipped with its GPIB address set to 23. To view or change the GPIB address, press the More function key, then the I/O > GPIB softkeys. The GPIB Configuration dialog box appears.
   
   To change the GPIB address, use the rotary knob or the arrow keys, and press OK to set the value.

6. You can now use the Interactive IO within Connection Expert to communicate with your instrument, or program your instrument using various programming environments.

The following steps will help you quickly get started with connecting your USB-enabled instrument to the USB (Universal Serial Bus). The following figure illustrates a typical USB interface system.

1. If you have not already done so, install Keysight IO Libraries Suite from the CD shipped with your product.

2. Connect the USB device port located on the back of your instrument to the USB port on your computer.

3. With the Connection Expert utility from Keysight IO Libraries Suite running, the computer will automatically recognize the instrument. This may take several seconds. When the instrument is recognized, your computer will display the VISA alias, IDN string, and VISA address.
You can also view the instrument’s VISA address from the front panel. Press the More function key, then the I/O > USB softkeys. The VISA address is shown in the USB Status dialog box.

4. You can now use the Interactive IO within Connection Expert to communicate with your instrument, or program your instrument using various programming environments.

**LAN Interface**

*NOTE*
For detailed information about LAN interface connections, refer to *Connectivity Guide* installed with the Keysight IO Libraries.

The following steps will help you quickly get started with connecting and configuring your instrument on a local area network.

**Connecting to a Site LAN**

A site LAN is a local area network in which LAN-enabled instruments and computers are connected to the network via routers, hubs, and/or switches. They are typically large, centrally-managed networks with services such as DHCP and DNS.

1. If you have not already done so, install the Keysight IO Libraries Suite from the CD shipped with your product.

2. Connect the instrument to the site LAN. The factory-shipped instrument LAN settings are configured to automatically obtain an IP address from the network using DHCP (DHCP is enabled). Note that this may take up to one minute. The DHCP server will register the instrument’s hostname with the dynamic DNS server. The hostname as well as the IP address can then be used to communicate with the instrument. The front panel LAN indicator will turn green when the LAN port has been configured successfully, or turn red if the configuration fails.
Installation
Connecting to the Interfaces

NOTE
If you need to manually configure any instrument LAN settings, see “LAN Configuration dialog box” on page 4-48 for information about configuring the LAN settings from the front panel of the instrument.

3. Use the Connection Expert utility from Keysight IO Libraries Suite to add the B2900 and verify the connection. To add the instrument, you can request Connection Expert to discover the instrument. If the instrument cannot be found, add the instrument using the instrument’s hostname or IP address.

NOTE
If this does not work, refer to the troubleshooting section in Connectivity Guide.

4. You can now use the Interactive IO within Connection Expert to communicate with your instrument, or program your instrument using various programming environments. You can also use the Web browser on your computer to connect to the instrument as described under “Using the Graphical Web Interface” on page 3-31.

Viewing the Active LAN Status

To view the currently active LAN settings, press the More function key, then the I/O > LAN > Status softkeys. The LAN status dialog box appears.

Note that the currently active LAN settings for the IP Address, Subnet Mask, and Default Gateway may be different from the settings specified in the LAN Configuration dialog box, depending on the configuration of the network. If the settings are different, it is because the network has automatically assigned its own settings.

Modifying the LAN Settings

As shipped from the factory, B2900’s pre-configured settings should work in most LAN environments. If you need to manually configure these settings, press the More function key, then the I/O > LAN > Config softkeys. The LAN Configuration dialog box appears.

NOTE
B2900 must be rebooted if the host name is changed.

For the LAN setup parameters, see “LAN Configuration dialog box” on page 4-48.
Communicating Over the LAN

Using the Graphical Web Interface

Your Keysight B2900 Source/Measure Unit has a built-in graphical web interface that lets you control it directly from a Web browser on your computer. Multiple simultaneous connections are allowed, but only from one computer. With additional connections, performance will be reduced. Multiple connections from multiple computers are not allowed.

With the graphical web interface, you can access the front panel control functions including the LAN configuration parameters. This is a convenient way to communicate with the B2900 without using I/O libraries or drivers.

NOTE

The built-in graphical web interface only operates over the LAN interface. It requires Internet Explorer 6+ or Firefox 2+. You will also need the Java Plug-in. This is included in the Java Runtime Environment. Visit the Java’s website.

The graphical web interface is enabled when shipped.
Installation
Communicating Over the LAN

To launch the graphical web interface:

1. Open a Web browser on your computer.
2. Enter the instrument’s hostname or IP address into the browser’s Address field to launch the graphical web interface. The B2900 home page will appear.
3. Click on the Browser Web Control button in the navigation bar on the left to begin controlling your instrument.
4. For additional help about any page, click “Help with this Page”.

If desired, you can control the access to the graphical web interface using password protection. As shipped from the factory, the password is set to keysight or agilent. To change the password, click on the View & Modify Configuration button. Refer to the online help for additional information about setting the password.

Using Telnet

The Telnet utility (as well as sockets), is another way to communicate with B2900 without using I/O libraries or drivers. In all cases, you must first establish a LAN connection from your computer to the B2900 as previously described.

In an MS-DOS Command Prompt box, type “telnet hostname 5024” where hostname is the B2900’s hostname or IP address, and 5024 is the instrument’s telnet port. You should get a Telnet session box with a title indicating that you are connected to the B2900. Type the SCPI commands at the prompt.

Using Sockets

NOTE
Keysight B2900 allows any combination of up to four simultaneous data socket, control socket, or telnet connections to be made.

Keysight instruments are standardized on using port 5025 for SCPI socket services. A data socket on this port can be used to send and receive ASCII/SCPI commands, queries, and query responses. All commands must be terminated with a newline for the message to be parsed. All query responses will also be terminated with a newline.

The socket programming interface also allows control socket connections. The control socket can be used by a client to send device clear and to receive service requests. Unlike the data socket, which uses a fixed port number, the port number for a control socket varies and must be obtained by sending the following SCPI query to the data socket: SYSTem:COMMunicate:TCPip:CONTrol?
Once the port number is obtained, a control socket connection can be opened. As with the data socket, all commands to the control socket must be terminated with a newline, and all query responses returned on the control socket will be terminated with a newline.

To send a device clear, send the string “DCL” to the control socket. When the B2900 has finished performing the device clear, it will echo the string “DCL” back to the control socket.

Service requests are enabled for control sockets using the Service Request Enable register. Once service requests have been enabled, the client program listens on the control connection. When SRQ becomes true, the instrument will send the string “SRQ +nn” to the client. The “nn” is the status byte value, which the client can use to determine the source of the service request.
Using Digital I/O

B2900A has a Digital I/O connector, D-sub 25 pin female, for general purpose input/output (GPIO). It can be used for:

- Trigger input
- Trigger output
- Digital signal input/output
- Digital signal input
- Start of Test (SOT) input (for component handlers)
- Busy status output (for component handlers)
- End of Test (EOT) output (for component handlers)
- Interlock control
- High voltage status output (shared with the digital signal input/output DIO 14)

The pin assignment of the Digital I/O connector is shown in Table 3-1. Pins DIO 1 to DIO 14 can be assigned to one of the above functions, except for interlock control. To set the DIO functions, press the More function key, then the I/O > DIO > Config softkeys. For details, see “DIO Configuration dialog box” on page 4-48.

Figure 3-14 shows the input/output circuits internally connected to each pin of the Digital I/O connector.

For the available accessory, see “Accessory for Digital I/O Connector” on page 3-36.
Figure 3-14  Digital I/O Internal Circuit

Table 3-1  Digital I/O Pin Assignment

<table>
<thead>
<tr>
<th>Description</th>
<th>Pin Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+5 V a</td>
<td>25</td>
<td>DIO 13 (bit 13)</td>
</tr>
<tr>
<td>Interlock control b</td>
<td>24</td>
<td>DIO 12 (bit 12)</td>
</tr>
<tr>
<td>+5 V a</td>
<td>23</td>
<td>DIO 11 (bit 11)</td>
</tr>
<tr>
<td>+5 V a</td>
<td>22</td>
<td>DIO 10 (bit 10)</td>
</tr>
<tr>
<td>GND</td>
<td>21</td>
<td>DIO 9 (bit 9)</td>
</tr>
<tr>
<td>GND</td>
<td>20</td>
<td>DIO 8 (bit 8)</td>
</tr>
<tr>
<td>GND</td>
<td>19</td>
<td>DIO 7 (bit 7)</td>
</tr>
<tr>
<td>GND</td>
<td>18</td>
<td>DIO 6 (bit 6)</td>
</tr>
<tr>
<td>GND</td>
<td>17</td>
<td>DIO 5 (bit 5)</td>
</tr>
<tr>
<td>Interlock control c</td>
<td>16</td>
<td>DIO 4 (bit 4)</td>
</tr>
<tr>
<td>GND</td>
<td>15</td>
<td>DIO 3 (bit 3)</td>
</tr>
<tr>
<td>DIO 14 (bit 14) or High voltage status</td>
<td>14</td>
<td>DIO 2 (bit 2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1</td>
</tr>
</tbody>
</table>
Installation

Using Digital I/O

- Current limit: 600 mA (total current to the pins 22, 23, and 25)
- Used for the positive logic. Connected to the pin 25 for the negative logic.
- Used for the negative logic. Connected to the pin 17 for the positive logic.

Accessory for Digital I/O Connector

The following accessory is available for the Digital I/O connector.

- Keysight N1294A-031 GPIO-BNC Trigger Adapter

  This adapter is used to change the Digital I/O connector to the trigger input/output BNC connectors. The BNC connectors are internally connected to the DIO pins 9 and 10.

  This adapter can be connected directly to the Digital I/O connector.

NOTE

Interlock terminals

If the N1294A-031 adapter is connected to the Digital I/O connector, the Interlock terminals are opened. Then the B2961A/B2962A output voltage is limited to ±42 V.

To use the interlock function, see “Installing the Interlock Circuit” on page 3-24 and extend the Interlock terminals. They can be extended from the adapter internal board through the opening of the adapter top cover.
Front Panel Reference

This chapter provides the reference information of the Keysight B2900 front panel keys and display.

- “Hard Keys and Rotary Knob”
- “Display and Assist Keys”
- “Function Keys”
- “Config key group”
- “Function key group”
- “Trigger key group”
- “Result key group”
- “File key group”
- “Program key group”
- “I/O key group”
- “Display key group”
- “System key group”

**NOTE**

If measurement is not performed properly, check the trigger setting. The trigger type must be set to AUTO, or the trigger count (Count) must be set properly. See “Trigger parameters” on page 4-17.
Hard Keys and Rotary Knob

**Standby switch**

Turns the instrument on or off. When the power is on, the LED below the switch is turned green.

**Trigger**

Starts a single (one shot) output/measurement or initiates trigger system. If a repeat measurement is in progress, stops it.

The single measurement is performed with the DC bias output, staircase sweep output, pulsed bias output, or pulsed sweep output set to the channel. One single measurement can contain the maximum of 100000 measurement points.

Once a single measurement starts, the data buffer (maximum 100000 data) is cleared, and the last single measurement result is stored in the buffer. The measurement result is displayed on the Single view, Dual view, Graph view, or Roll view. Also the last single measurement result can be listed and displayed on the Measure Result dialog box.

**Auto**

Starts a repeat (continuous) measurement. If a repeat measurement is in progress, stops it. The repeat measurement is performed with the DC bias output of the Source value. And the measurement result is displayed on the Single view, Dual view, or Roll view. The repeat measurement result is not stored in the buffer.

The repeat measurement is performed with the following trigger setup. Settings of “Trigger parameters” are ignored.

- Acquire trigger (measurement trigger): Initiate
- ARM acquire count: Infinite
- ARM acquire source: AUTO (automatic internal)
- TRIGger acquire count (Measure Count) 100
- TRIGger acquire source (Measure Trigger): AUTO (automatic internal)
- TRIGger acquire timer period (Measure Period): 10 ms (this is automatically extended if the measurement is not completed.)
- Trigger delay (Source Delay=Measure Delay): 0 s
- Trigger output: Disable

**View**

Changes the display mode. See “Display and Assist Keys” on page 4-6.
Front Panel Reference
Hard Keys and Rotary Knob

**Cancel / Local**
Cancels the setup operation if the instrument is in the local status. Returns the instrument to the local status if it is in the remote status.

**On/Off**
Used to enable or disable the SMU channel. Turns the channel off if it is in the output status even if it is in the remote status. One switch on 1-channel models, and two switches on 2-channel models.

The switch turns green if the channel is enabled.

The switch turns red if the channel is in the high voltage state.

**Numeric/alpha keys**
Used to enter the value for setup parameters such as the source output value, limit (compliance) value, and message, specified by the field pointer. The value can be changed if the field pointer is in the EDIT (green) status.

**Rotary knob**
If the field pointer is in the MOVE (blue) status, turning the knob moves the pointer. Pressing the knob fixes the pointer position and changes the pointer status to EDIT (green).

If the field pointer is in the EDIT (green) status, turning the knob changes the value of the setup parameter specified by the pointer. Pressing the knob fixes the value and changes the pointer status to MOVE (blue).

If the field pointer is in the EDIT (green) status on a setup field other than the Source field and the Limit (Compliance) field, turning the knob changes the setting value. The value is applied by pressing the knob.

If the field pointer is in the EDIT (green) status on the Source or Limit field, turning the rotary knob changes the display value and updates the source channel output in real time. However, if the digit pointer is available, the source channel works depending on the setting of the real time update (the setting of the Immediate V/I Update by Knob field). For the Immediate V/I Update by Knob field, see “Display Preference dialog box” on page 4-51.

If the digit pointer is on a digit of a numeric value entry field, turning the knob changes the value of the digit. Note that changing the value from 9 to 0 or from 0 to 9 changes the value of the next digit.

If the digit pointer is on the decimal point of a numeric value entry field, turning the knob moves the decimal point if the Immediate V/I Update by Knob setup is OFF.
**Left and right keys**  
If the field pointer is in the MOVE (blue) status, pressing the key moves the pointer.

If the field pointer is in the EDIT (green) status, pressing the key changes the value of the setup parameter specified by the pointer.

If the field pointer is in the EDIT (green) status on a numeric value entry field, pressing the key changes the pointer to the digit pointer.

If the digit pointer is on a digit of a numeric value entry field, pressing the key moves the pointer on the digits.
Display and Assist Keys

Keysight B2900 provides several display modes which depend on the model as shown below. The display mode is changed by the View key. Pressing the key changes the mode as shown below.

On B2901A
- Single → Graph → (return to Single)

On B2902A
- Dual → Single for channel 1 → Single for channel 2 → Graph → (return to Dual)

On B2911A
- Single → Graph → Roll → (return to Single)

On B2912A
- Dual → Single for channel 1 → Single for channel 2 → Graph → Roll → (return to Dual)

For each display mode, five assist keys are available on the right side of the display. They are assigned to several softkeys such as Mode, Source, Limit, Measure, and More. The softkey assignment depends on the display mode.

For details of each display mode and assist keys, see the following sections.

- “Dual View”
- “Single View”
- “Graph View”
- “Roll View”
- “Status Information”

The status information is common for all display modes. It is displayed above the bottom softkeys associated with the function keys. This display area is also used to display system messages and error messages.
**Dual View**

Available on B2902A and B2912A. The upper half is for channel 1. The lower half is for channel 2. Each area displays the measurement results, source and measurement settings, and channel status. Most setup parameters can be edited on this display.

**Display area**

1. Channel number. 1 or 2.
2. Latest measurement data
3. Over voltage/current status indicator (OV or OC, red)
4. High capacitance mode indicator (HC)
5. Remote sensing (4-wire connection) status indicator
6. Source function. VOLTS or AMPS.
7. Source shape indicator. DC, pulse, sweep, or pulsed sweep. DC does not show the indicator.
8. Source output value, 5½ digit resolution on B2902A, and 6½ digit resolution on B2912A
9. Limit (Compliance) value

D1. Primary measurement data. Turns orange if the data exceeds the Limit value.
D2. Secondary measurement data. Turns orange if the data exceeds the Limit value.

For the limit test, D2 displays PASS or FAIL instead of the measurement data.
### Assist keys

In the following descriptions, *Ch n* indicates *Ch 1* or *Ch 2*.

#### Ch n Mode
Changes the assist keys to VOLTS (V) and AMPS (I) used to select the source function.
- VOLTS (V) sets the voltage source.
- AMPS (I) sets the current source.

#### Ch n Source
Changes the assist keys to the unit keys shown below.
- μV, mV, and V for the voltage source
- pA, nA, μA, mA, and A for the current source

First, enter or set the output value by using the numeric/alpha keys, rotary knob, and arrow keys. Then press one of the unit keys to apply the value.

#### Ch n Limit
Changes the assist keys to the unit keys shown below.
- pA, nA, μA, mA, and A for the current compliance
- μV, mV, and V for the voltage compliance

First, enter or set the limit value by using the numeric/alpha keys, rotary knob, and arrow keys. Then press one of the unit keys to apply the value.

#### Ch n Measure
Changes the assist keys to AMPS (I), VOLTS (V), OHMS (R), and WATTS (P) used to select the measurement function.
- AMPS (I) sets the current measurement.
- VOLTS (V) sets the voltage measurement.
- OHMS (R) sets the resistance measurement.
- WATTS (P) sets the power measurement.

Resistance data is given by Resistance=$\frac{V_{meas}}{I_{meas}}$.

Power data is given by Power=$V_{meas} \times I_{meas}$.

In the above formula, $V_{meas}$ is the voltage measurement data, and $I_{meas}$ is the current measurement data.

For details on using resistance compensation, see “Resistance Compensation” on page 6-16.

#### More...
Changes the assist keys to *Ch 1* assist keys or *Ch 2* assist keys.
*Ch 1* assist keys are effective for channel 1. *Ch 2* assist keys are effective for channel 2.
Single View

Displays the measurement results, source and measurement settings, and channel status. Most setup parameters can be edited on this display. The lower half displays the setup parameters selected by Assist keys 2.

Display area

1. Channel number. 1 or 2.
2. Latest measurement data
3. Over voltage/current status indicator (OV or OC, red)
4. High capacitance mode indicator (HC)
5. Remote sensing (4-wire connection) status indicator
6. Source function. VOLTS or AMPS.
7. Source shape indicator. DC, pulse, sweep, or pulsed sweep. DC does not show the indicator.
8. Source output value, 5½ digit resolution on B2901A/B2902A, and 6½ digit resolution on B2911A/B2912A
9. Limit (Compliance) value
10. Measurement speed. AUTO, SHORT, MEDIUM, NORMAL, LONG, or MANUAL.
11. Aperture time in seconds or PLC (power line cycle, number of power line cycles per a measurement). Only for the MANUAL speed.

D1. Primary measurement data. Turns orange if the data exceeds the Limit value.
Front Panel Reference
Display and Assist Keys

D2. Secondary measurement data. Turns orange if the data exceeds the Limit value. For the limit test, D2 displays PASS or FAIL instead of the measurement data.

<table>
<thead>
<tr>
<th>Assist keys 1</th>
<th>Mode</th>
<th>Changes the assist keys to VOLTS (V) and AMPS (I) used to select the source function. VOLTS (V) sets the voltage source. AMPS (I) sets the current source.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Changes the assist keys to the unit keys shown below. μV, mV, and V for the voltage source pA, nA, μA, mA, and A for the current source</td>
<td></td>
</tr>
<tr>
<td>Limit</td>
<td>Changes the assist keys to the unit keys shown below. pA, nA, μA, mA, and A for the current compliance μV, mV, and V for the voltage compliance</td>
<td></td>
</tr>
<tr>
<td>Measure</td>
<td>Changes the assist keys to AMPS (I), VOLTS (V), OHMS (R), and WATTS (P) used to select the measurement function. AMPS (I) sets the current measurement. VOLTS (V) sets the voltage measurement. OHMS (R) sets the resistance measurement. WATTS (P) sets the power measurement. Resistance data is given by Resistance=Vmeas/Imeas. Power data is given by Power=Vmeas×Imeas. In the above formula, Vmeas is the voltage measurement data, and Imeas is the current measurement data. For details on using resistance compensation, see “Resistance Compensation” on page 6-16.</td>
<td></td>
</tr>
<tr>
<td>More...</td>
<td>Changes the assist keys to Assist keys 2.</td>
<td></td>
</tr>
</tbody>
</table>
**Assist keys 2**  
**Speed**  
Changes the assist keys to AUTO (1 PLC for 10 nA and 100 nA ranges, 0.01 PLC for other ranges), SHORT (0.01 PLC), MEDIUM (0.1 PLC), NORMAL (1 PLC), LONG (10 PLC), or MANUAL used to select the measurement speed. The aperture time is automatically set to the above values in parentheses. For the aperture time, see “Measurement Time” on page 6-5.

For the MANUAL speed, the aperture time must be set to the right field in seconds or PLC (power line cycle, number of power line cycles per measurement). Move the field pointer to the one by using the arrow keys or rotary knob and press the knob to set the pointer to the EDIT mode. Enter or set the value by using the numeric/alpha keys, knob, or arrow keys, then press the knob or one of the unit keys to apply the value. For setting the seconds value, the following unit keys are available as assist keys.

μs, ms, and s

- **Show Sweep**  
  Displays the sweep setup parameters shown in “Sweep parameters” on page 4-13, and changes the softkey label to *Hide Sweep*.

- **Hide Sweep**  
  Displays the range setup parameters shown in “Range parameters” on page 4-12, and changes the softkey label to *Show Sweep*.

- **Show Pulse**  
  Displays the pulse setup parameters shown in “Pulse parameters” on page 4-16, and changes the softkey label to *Hide Pulse*.

- **Hide Pulse**  
  Displays the range setup parameters shown in “Range parameters” on page 4-12, and changes the softkey label to *Show Pulse*.

- **Show Trigger**  
  Displays the trigger setup parameters shown in “Trigger parameters” on page 4-17, and changes the softkey label to *Hide Trigger*.

- **Hide Trigger**  
  Displays the range setup parameters shown in “Range parameters” on page 4-12, and changes the softkey label to *Show Trigger*.

- **More...**  
  Changes the assist keys to Assist keys 1.

Softkey labels *Show XXXX* and *Hide XXXX* are switched by pressing the key.
Front Panel Reference
Display and Assist Keys

Range parameters

<table>
<thead>
<tr>
<th>Ranges</th>
<th>Source Volts: Spot</th>
<th>Measure Amps</th>
<th>Measure Ohms</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>AUTO</td>
<td>AUTO</td>
<td>AUTO</td>
</tr>
<tr>
<td></td>
<td>200mV</td>
<td>10mA</td>
<td>2 Ω - 200MΩ</td>
</tr>
</tbody>
</table>

The following setup parameters are available. Source or Measure XXXX is decided by the source setting.

Source Volts: Spot  For the voltage source. Selects the range operation AUTO (automatic ranging) or FIXED (fixed range) for the constant voltage output and the source side voltage measurement.

Measure Amps For the voltage source. Selects the range operation AUTO or FIXED for the current measurement.

Source Amps: Spot For the current source. Selects the range operation AUTO or FIXED for the constant current output and the source side current measurement.

Measure Volts For the current source. Selects the range operation AUTO or FIXED for the voltage measurement.

The right field is used to set the range value for the FIXED range operation, or the minimum range value for the AUTO range operation. For the available range values, see “Output and Measurement Ranges” on page 2-11.

NOTE
If the range operation is AUTO, the channel automatically uses the range which provides the best resolution for the source output value or the measurement value.

NOTE
If the pulse output is ON and the range operation is AUTO, the measurement channel uses the minimum range which covers the Limit (Compliance) value.

Measure Ohms Selects the resistance measurement operation AUTO, FIXED, or V/I.

The right field is used to set the resistance measurement range value for the FIXED operation, or the minimum and maximum ranges for the AUTO operation. For the available range values, see Table 2-7 on page 2-15. This setup field is not available for the V/I operation.

For AUTO and FIXED, the channel performs resistance measurement by using the current source and voltage measure condition automatically set by the resistance measurement range setting.
For V/I, the channel performs measurement by using the present source/measure condition, and the resistance value is given by V/I calculation.

**Sweep parameters**

<table>
<thead>
<tr>
<th>Sweep Parameters</th>
<th>LINEAR SINGLE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start</td>
<td>000.0000 mV</td>
</tr>
<tr>
<td>Stop</td>
<td>+1.500000 V</td>
</tr>
<tr>
<td>Points</td>
<td>101</td>
</tr>
<tr>
<td>Step</td>
<td>+015.0000 mV</td>
</tr>
</tbody>
</table>

B2900 can be used as a sweep source, and supports the following sweep operations. The operation can be selected by using the assist keys displayed when the field pointer is in the EDIT (green) status on the Sweep Parameters field.

- LINEAR SINGLE: Sweep from start to stop in a linear incremental step
- LINEAR DOUBLE: Sweep from start to stop to start in a linear incremental step
- LOG SINGLE: Sweep from start to stop in a logarithmic incremental step
- LOG DOUBLE: Sweep from start to stop to start in a log incremental step
- LIST: Sweep of values defined in the List sweep setup list. See “List sweep setup”.

The following setup parameters are available.

- **Start**
  - Sets the sweep start value.

- **Stop**
  - Sets the sweep stop value.

- **Points**
  - Sets the number of sweep steps.

- **Step**
  - Sets the sweep step value (incremental step value). Not available for the LOG and LIST sweep operations.

When the field pointer is in the EDIT (green) status on an entry field, the assist keys are changed to the unit keys as shown below.

- pA, nA, µA, mA, and A for current sweep
- µV, mV, and V for voltage sweep

For the range operation of the sweep source, see “Sweep dialog box” on page 4-29. The range parameters *Source Volt: Spot* and *Source Amps: Spot* are not effective for the AUTO and BEST range operations of the sweep source. They are effective for the constant source and FIXED range operation of the sweep source.
List sweep setup

When the field pointer is in the EDIT (green) status on the LIST sweep Start/Stop/Points field, the following assist keys are available for setting the list sweep source.

**Edit**
Opens the List Sweep dialog box used to set the list sweep source.

**Load**
Opens the Load List Sweep Data dialog box used to load a list sweep data from a USB memory connected to the front panel USB-A connector.

- **List Sweep dialog box**
  This dialog box provides the following fields for setting the list sweep source. After the list is completed, press OK to apply the data and close the dialog box.

  **(data graph)**
  Displays the shape of the list sweep output

  **(data list)**
  Lists the data index in the left cell and the output value in the right cell.

  When the pointer is in the MOVE status, the pointer can be moved in the crosswise direction. And pressing the knob changes the status to EDIT.

  When the right cell is in the EDIT status, the output value can be entered to the cell.

  When the left cell is in the EDIT status, the following assist keys are available for creating and scrolling the list. Then the pointer can be moved in the lengthwise direction. And pressing the knob changes the status to MOVE.

  **Append**
  Adds a line below. The same output value is entered into the right cell.

  **Insert**
  Adds a line above. The same output value is entered into the right cell.

  **Delete**
  Deletes the line.

  **Scroll –100**
  Moves the pointer to the maximum 100 points above.

  **Scroll +100**
  Moves the pointer to the maximum 100 points below.

  **Type**
  Data type V (voltage) or I (current)

  **CH**
  Channel number 1 or 2, only on 2-channel models
### Load List Sweep Data dialog box

This dialog box provides the following fields for loading a list sweep data from a file stored on a USB memory. Highlight a file and press OK to load the data and close the dialog box.

<table>
<thead>
<tr>
<th>Points</th>
<th>Number of data points</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max</td>
<td>Maximum value</td>
</tr>
<tr>
<td>Min</td>
<td>Minimum value</td>
</tr>
</tbody>
</table>

**Points**

- **Max**
- **Min**

**Points**

- **Max**
- **Min**

The following data can be loaded as the list sweep data.

- Comma separated value format, file extension csv
- Carriage return or line feed separated value format, file extension txt
- Space separated value format in a line, file extension prn
Pulse parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pulse</td>
<td>ON</td>
</tr>
<tr>
<td>Peak</td>
<td>+05.00000 V</td>
</tr>
<tr>
<td>Delay</td>
<td>001.2000 mS</td>
</tr>
<tr>
<td>Width</td>
<td>025.0000 mS</td>
</tr>
</tbody>
</table>

B2900 can be used as a pulse source, and supports pulsed output and measurement. Pulse ON or OFF can be selected by using the assist keys displayed when the field pointer is in the EDIT (green) status on the Pulse field.

The following setup parameters are available.

**Peak**
Sets the pulse peak value. Not available for the sweep source which sets the sweep output value to the pulse peak.

The pulse base value is set by the Source field in the upper half of the display area. See “Single View” on page 4-9.

**Delay**
Sets the pulse delay time. The pulse source changes the output level from the base value to the peak value when the delay time elapsed after trigger delay.

**Width**
Sets the pulse width.

When the field pointer is in the EDIT (green) status on an entry field, the assist keys are changed to the unit keys as shown below.

- pA, nA, µA, mA, and A for the peak current
- µV, mV, and V for the peak voltage
- µs, ms, s, and ks for the delay and width
Trigger parameters

<table>
<thead>
<tr>
<th>Trigger</th>
<th>Source</th>
<th>Measure</th>
</tr>
</thead>
<tbody>
<tr>
<td>MANUAL</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Count</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delay</td>
<td>0.000 μs</td>
<td>0.000 μs</td>
</tr>
<tr>
<td>Period</td>
<td>0.000 μs</td>
<td>0.000 μs</td>
</tr>
<tr>
<td>Trigger</td>
<td>AUTO</td>
<td>AUTO</td>
</tr>
</tbody>
</table>

The B2900 supports the following trigger types for triggering source output and measurement. They are effective for setting triggers easily.

The trigger type can be selected by using the assist keys displayed when the field pointer is in the EDIT (green) status on the Trigger field. See Table 4-1 for the trigger types and the setup parameters.

**AUTO**  Automatic trigger type

**SYNC**  Synchronize trigger type

**TIMER**  Timer trigger type

**MANUAL**  Manual trigger type

The following setup parameters are available for setting the source output trigger (transient action) by using the Source column, and the measurement trigger (acquire action) by using the Measure column.

**Count**  Trigger count (number of triggers), 1 to 100000 or INF (infinity). This value is automatically set for the AUTO trigger type. For the other trigger type, set the number of triggers required for each source output and measurement properly. For example, set Source Count = Measure Count = 10 for the sweep measurement with 10 steps.

**Delay**  Sets the trigger delay time.

**Period**  Sets the trigger period.

**Trigger**  Selects the trigger source by using the assist key AUTO, BUS, TIMER, INT\(m\) (only for 2-channel model), LAN, or EXT\(n\), where \(m\) is the integer 1 or 2, and \(n\) is an integer from between 1 and 14. See Table 4-1 for the trigger sources.

When the field pointer is in the EDIT (green) status on the Delay or Period field, the assist keys are changed to the unit keys as shown below.

\(μs\), \(ms\), \(s\), and \(ks\)
Table 4-1  Trigger Types and Setup Parameters

<table>
<thead>
<tr>
<th>Type</th>
<th>Count</th>
<th>Delay</th>
<th>Period</th>
<th>Trigger</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTO</td>
<td>set automatically</td>
<td>0 second</td>
<td>N.A.</td>
<td>AUTO</td>
</tr>
<tr>
<td>SYNC</td>
<td>entered value</td>
<td>entered value</td>
<td>N.A.</td>
<td>AUTO</td>
</tr>
<tr>
<td>TIMER</td>
<td>entered value</td>
<td>entered value</td>
<td>entered value</td>
<td>TIMER</td>
</tr>
<tr>
<td>MANUAL</td>
<td>entered value</td>
<td>entered value</td>
<td>entered value</td>
<td>selected value</td>
</tr>
</tbody>
</table>

*Trigger=AUTO* automatically selects the trigger source best suited for the present operating mode by using internal algorithms.

*Trigger=BUS* uses the remote interface trigger command such as GET, TRIGger, and *TRG.*

*Trigger=TIMER* uses a signal internally generated every interval set by the *Period* parameter.

*Trigger=INT1* or INT2 uses a signal from the internal bus 1 or 2, respectively.

*Trigger=LAN* uses the LXI trigger.

*Trigger=EXTn* uses a signal from the DIO pin *n* which is an output port of the Digital I/O D-sub connector on the rear panel. *n*=1 to 14.

**NOTE**

Setting trigger parameters in detail

For details of the trigger system, see Figure 6-8 on page 6-28.

The Single view provides the trigger types and parameters effective for setting triggers easily. If you want to set the trigger parameters in detail, select the MANUAL trigger type and use the Trigger Configuration dialog box opened by pressing the Trigger > Config function keys. See “Trigger key group” on page 4-37.

The Single view does not contain the setup parameters for the arm layer, but contains the setup parameters for the trigger layer. The Single view setup is given priority over the trigger layer setup on the Trigger Configuration dialog box. Hence, the overlapped parameter values on the dialog box are ignored.
**Graph View**

Displays the graph for plotting the channel 1 and/or 2 measurement or math result. The Graph view can plot up to 5000 data.

**Display area**

1. Graph display status ON or OFF. Only on 2-channel models. \([n]\) is for channel \(n\).
2. Y-axis data type I (A), V (V), R (Ω), P (W), or MATH (see Table 4-2)
3. Y-axis scale LINEAR or LOG
4. X-axis data type I (A), V (V), R (Ω), P (W), MATH, t (s), V1, or V2 (see Table 4-2)
5. X-axis scale LINEAR or LOG
6. Graph maximum value
7. Graph minimum value
8. Channel 1 and/or 2 source output value, limit value, or none (controlled by the Ch \(n\) Source, Ch \(n\) Limit, or Hide Ch \(n\) assist key)
9. Channel 1 and/or 2 Y-axis data at the active X-cursor position. ----.---- is displayed for the no-data position.
10. Cursor data (controlled by the Show Cursors or Hide Cursors assist key)

**First line** Positions and distance (e.g. I1, I2, ∆A) of Y-cursors 1 and 2

**Second line** Positions and distance (e.g. t1, t2, ∆t) of X-cursors 1 and 2
Table 4-2 X and Y Axes Data Types for Graph View

<table>
<thead>
<tr>
<th>Data type</th>
<th>Assist key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I (A)</td>
<td>AMPS (I)</td>
<td>Current measurement data</td>
</tr>
<tr>
<td>V (V)</td>
<td>VOLTS (V)</td>
<td>Voltage measurement data</td>
</tr>
<tr>
<td>R (Ω)</td>
<td>OHMS (R)</td>
<td>Resistance measurement data</td>
</tr>
<tr>
<td>P (W)</td>
<td>WATTS (P)</td>
<td>Power measurement data</td>
</tr>
<tr>
<td>MATH</td>
<td>MATH</td>
<td>Math result data</td>
</tr>
<tr>
<td>t (s)</td>
<td>TIME (t)</td>
<td>Time data. Only for the X-axis data.</td>
</tr>
<tr>
<td>V1</td>
<td>Ch 1 V (V1)</td>
<td>Only on 2-channel models. Voltage data of channel 1 or 2. Only for the X-axis data.</td>
</tr>
<tr>
<td>V2</td>
<td>Ch 2 V (V2)</td>
<td></td>
</tr>
</tbody>
</table>

Assist keys

Auto Scale
Changes graph scale to fit the trace in the graph automatically.

Dump Screen
Opens the File Selection (Dump Screen) dialog box which is used to save the screen dump as a JPEG file.

The file can be saved onto a USB memory connected to the front panel USB-A connector. The file is saved with the specified name. If the file extension is not specified, “.jpg” is added automatically.

Show Cursors
Displays the cursors (Y-cursors 1 and 2, X-cursors 1 and 2, and cursor data) and changes the softkey label to Hide Cursors.

Hide Cursors
Hides the cursors and changes the softkey label to Show Cursors.

Ch n Source
Displays the channel n source output value and changes the softkey label to Ch n Limit.

Ch n Limit
Hides the channel n source output value and displays the limit value. Also changes the softkey label to Hide Ch n.

Hide Ch n
Hides the channel n limit value and changes the softkey label to Ch n Source.

In the above descriptions, Ch n indicates Ch 1 or Ch 2.
**NOTE**

If the number of data exceeds 5000

If the number of measurement data exceeds 5000, the Graph view and the Roll view plot the following data. Where, \( n \) is integer, 1 to 5000.

- Number of data is 5001 to 10000: \([2*(n-1)+1]\)th data
- Number of data is 10001 to 25000: \([5*(n-1)+1]\)th data
- Number of data is 25001 to 50000: \([10*(n-1)+1]\)th data
- Number of data is 50001 to 100000: \([20*(n-1)+1]\)th data

---

**Roll View**

Available on B2911A and B2912A. Displays the time domain graph for plotting the channel 1 and/or 2 measurement data. See Table 4-3 for the Y-axis data types. The Roll view can plot up to 5000 data.
Display area

1. Displays status ON or OFF, on B2911A
   Displays status Ch 1, Ch 2, or OFF, on B2912A
   Two lines can be displayed on the graph. [1] indicates the graph setup for line 1. [2] indicates the graph setup for line 2.
2. Y-axis data type I, V, R, or P.
4. X-axis scale per division s/div.
5. X-axis minimum value (minimum timestamp)
6. Y-axis offset values for line 1 and 2
7. X-axis maximum value (maximum timestamp)
8. Channel 1 and/or 2 source output value, limit value, or none (controlled by the Ch n Source, Ch n Limit, or Hide Ch n assist key)
9. Channel 1 and/or 2 Y-axis data at the active X-cursor position. ----.---- is displayed for the no-data position.
10. Cursor data (controlled by the Line 1 Cursors, Line 2 Cursors, or Hide Cursors assist key)

   **First line** Positions and distance (e.g. I1, I2, ΔA) of Y-cursors 1 and 2

   **Second line** Positions and distance (e.g. t1, t2, Δt) of X-cursors 1 and 2

<table>
<thead>
<tr>
<th>Data type</th>
<th>Assist key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I</td>
<td>AMPS (I)</td>
<td>Current measurement data</td>
</tr>
<tr>
<td>V</td>
<td>VOLTS (V)</td>
<td>Voltage measurement data</td>
</tr>
<tr>
<td>R</td>
<td>OHMS (Ω)</td>
<td>Resistance measurement data</td>
</tr>
<tr>
<td>P</td>
<td>WATTS (P)</td>
<td>Power measurement data</td>
</tr>
<tr>
<td>Assist keys</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Auto Scale</strong></td>
<td>Changes graph scale to fit the trace in the graph automatically.</td>
<td></td>
</tr>
<tr>
<td><strong>Dump Screen</strong></td>
<td>Opens the File Selection (Dump Screen) dialog box which is used to save the screen dump as a JPEG file. The file can be saved onto a USB memory connected to the front panel USB-A connector. The file is saved with the specified name. If the file extension is not specified, “.jpg” is added automatically.</td>
<td></td>
</tr>
<tr>
<td><strong>Line 1 Cursors</strong></td>
<td>Displays the cursors (Y-cursors 1 and 2, X-cursors 1 and 2, and cursor data) for line 1, and changes the sofkey label to <strong>Line 2 Cursors</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>Line 2 Cursors</strong></td>
<td>Displays the cursors (Y-cursors 1 and 2, X-cursors 1 and 2, and cursor data) for line 2, and changes the sofkey label to <strong>Hide Cursors</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>Hide Cursors</strong></td>
<td>Hides the cursors and changes the sofkey label to <strong>Line 1 Cursors</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>Ch n Source</strong></td>
<td>Displays the channel n source output value and changes the sofkey label to <strong>Ch n Limit</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>Ch n Limit</strong></td>
<td>Hides the channel n source output value and displays the limit value. Also changes the sofkey label to <strong>Hide Ch n</strong>.</td>
<td></td>
</tr>
<tr>
<td><strong>Hide Ch n</strong></td>
<td>Hides the channel n limit value and changes the sofkey label to <strong>Ch n Source</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

In the above descriptions, **Ch n** indicates **Ch 1** or **Ch 2**.
Status Information

The status information is common for all display modes. It is displayed above the bottom softkeys associated with the function keys.

<table>
<thead>
<tr>
<th>Label</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUTO</td>
<td>white</td>
<td>Trigger auto. Automatic trigger is enabled now.</td>
</tr>
<tr>
<td>ARM</td>
<td>white</td>
<td>Trigger active. Trigger system is active now.</td>
</tr>
<tr>
<td>HV</td>
<td>yellow</td>
<td>High voltage. Output voltage setting is over ±42 V.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Channel 1 floating status. Channel 1 is not grounded.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Channel 2 floating status. Channel 2 is not grounded.</td>
</tr>
<tr>
<td>REM</td>
<td>white</td>
<td>Remote. Instrument is in the remote state.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Local lockout. Instrument is in the local lockout (LLO) status.</td>
</tr>
<tr>
<td>ERR</td>
<td>white</td>
<td>Error. At least one error is detected.</td>
</tr>
<tr>
<td>EDIT</td>
<td>green</td>
<td>Edit mode. The field specified by the pointer can be edited. Not in the move mode.</td>
</tr>
<tr>
<td>MOVE</td>
<td>blue</td>
<td>Move mode. The field pointer can be moved. Not in the edit mode.</td>
</tr>
<tr>
<td>LAN</td>
<td>green or red</td>
<td>LXI LAN status indicator. Green indicates normal LAN status. Red indicates abnormal condition. Blinking indicates the LAN identification status.</td>
</tr>
<tr>
<td>D</td>
<td>white</td>
<td>Display mode: Dual view</td>
</tr>
<tr>
<td>1</td>
<td>white</td>
<td>Display mode: Single view for channel 1</td>
</tr>
<tr>
<td>2</td>
<td>white</td>
<td>Display mode: Single view for channel 2</td>
</tr>
<tr>
<td>G</td>
<td>white</td>
<td>Display mode: Graph view</td>
</tr>
<tr>
<td>R</td>
<td>white</td>
<td>Display mode: Roll view</td>
</tr>
</tbody>
</table>
## Function Keys

Keysight B2900 has six function keys below the front panel display, and provides the following softkeys.

<table>
<thead>
<tr>
<th>Function Keys 1</th>
<th>Config</th>
<th>SMU configuration setup. Displays the softkeys for setting several functions of the SMU. See “Config key group” on page 4-26.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Function</td>
<td>Math, limit test, and trace function setup. Displays the softkeys for setting these functions. See “Function key group” on page 4-32.</td>
</tr>
<tr>
<td></td>
<td>Trigger</td>
<td>Trigger configuration and control. Displays the softkeys for setting and controlling the trigger system. See “Trigger key group” on page 4-37.</td>
</tr>
<tr>
<td></td>
<td>Result</td>
<td>Measurement, limit test, and trace result display. Displays the softkeys for displaying these results. See “Result key group” on page 4-40.</td>
</tr>
<tr>
<td></td>
<td>File</td>
<td>File operation. Displays the softkeys for saving and loading a file. See “File key group” on page 4-43.</td>
</tr>
<tr>
<td></td>
<td>More...</td>
<td>Changes the function keys to Function keys 2.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Function Keys 2</th>
<th>Program</th>
<th>Program configuration and control. Displays the softkeys for setting and controlling the program memory. See “Program key group” on page 4-44.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>I/O</td>
<td>I/O setup. Displays the softkeys for setting the I/O interfaces. See “I/O key group” on page 4-45.</td>
</tr>
<tr>
<td></td>
<td>Display</td>
<td>Display setup. Displays the softkeys for setting the display functions. See “Display key group” on page 4-50.</td>
</tr>
<tr>
<td></td>
<td>System</td>
<td>System setup. Displays the softkeys used for several system setups. See “System key group” on page 4-52.</td>
</tr>
<tr>
<td></td>
<td>LED Demo</td>
<td>For demonstration. If a LED is connected between the High Force and Low Force terminals, pressing OK starts the LED IV measurement demonstration.</td>
</tr>
<tr>
<td></td>
<td>More...</td>
<td>Changes the function keys to Function keys 1.</td>
</tr>
</tbody>
</table>
Config key group

Pressing the Config key displays the following softkeys for setting several functions of the SMU.

**Source**

Displays the following softkeys for setting the SMU source operation.

- **Connection**
  
  Channel operation and connection setup. See “Output Connection dialog box” on page 4-28.

- **Filter**
  
  Output filter setup. See “Output Filter dialog box” on page 4-27.

- **Sweep**
  
  Sweep source detail setup. See “Sweep dialog box” on page 4-29.

**Measure**

Displays the following softkeys for setting the SMU measurement operation.

- **R Compen**
  
  Resistance compensation ON or OFF. See “Resistance Compensation” on page 6-16.

  On a 1-channel model, pressing this key displays the ON and OFF keys used to set the resistance compensation on or off.

  On a 2-channel model, pressing this key displays the ALL, Ch 1, and Ch 2 keys. They are used to specify the channel for setting the resistance compensation on or off.

  - ALL specifies channels 1 and 2.
  - Ch 1 specifies channel 1 only.
  - Ch 2 specifies channel 2 only.

- **Ranging**
  
  Measurement range detail setup. See “Ranging dialog box” on page 4-30.

**Common**

Displays the following softkeys for setting the SMU’s miscellaneous function.

- **Wait**
  
  Source and measurement wait time setup. See “Wait Control dialog box” on page 4-31.

- **Group**
  
  Only on 2-channel models. Channel grouping ON or OFF. If this function is ON, the channels perform synchronous channel operation. The present setting is indicated by an asterisk on the softkey label.
Save, Recall

Saves/recalls all setup information of the B2900. Five storage areas are available in the built-in non-volatile memory (NVRAM) for this purpose.

Press the Save or Recall softkey to display the softkeys #1, #2, #3, #4, and #5 used for selecting the storage area. Press a softkey to save or recall the setup information.

Output Filter dialog box

This dialog box provides the following parameters for setting the output filter.

Ch

Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

Filter State

Output filter, ON or OFF

Set the filter ON to obtain clean source output without spikes and overshooting. Note, however, that using a filter may increase the SMU settling time.

Automatic Filter

Automatic filter, ON or OFF

Set the function ON to automatically set the output filter which provides the best filter characteristics and cutoff frequency.

Time Constant

Filter time constant, 5 μs to 500 μs
Output Connection dialog box

This dialog box provides the following parameters for setting the channel operation and connection.

**Ch**

- Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)
- This field specifies the channel set by this dialog box.

**Sensing Type**

- Sensing type, 2-wire connection (2-WIRE) or 4-wire connection (4-WIRE). Set 4-WIRE for remote sensing.

**Low Terminal State**

- Low sense terminal connection, grounded (GROUND) or floating (FLOAT)

**High Capacitance Mode**

- High capacitance mode, ON or OFF
- Set the mode to ON to perform high capacitive load measurements. See “High Capacitance Mode” on page 6-15.

**Over Voltage/Current Protection**

- Over voltage or current protection, ON or OFF
- Set the function ON to turn off the channel output automatically and immediately when it reaches its compliance.

**Output-Off State**

- Output-off state, high impedance (HIGH Z), normal (NORMAL), or zero volt (ZERO)
- This is the source setup condition after output off. See Table 6-1 on page 6-13.

**Auto Output-On**

- Automatic output on function, ON or OFF
- Set the function ON to turn on the channel output automatically just before the trigger system is initiated by the SCPI command (not by front panel operation).

**Auto Output-Off**

- Automatic output off function, ON or OFF
- Set the function ON to turn off the channel output automatically and immediately when all trigger system changes the status from busy to idle.
Sweep dialog box

This dialog box provides the following parameters for setting details of the sweep source operation.

### Ch

Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

### Sweep Ranging

Ranging mode used for the sweep source operation, BEST, AUTO, or FIXED. See Table 4-5 on page 4-29.

### Sweep Direction

Sweep direction, UP (start to stop direction) or DOWN (stop to start direction)

### Output after Sweep

The value the source channel applies after it completes the sweep output

- **START VALUE (START):** The source channel changes the output to the DC output value just before applying the sweep output start value.
- **END VALUE (END):** The source channel keeps the output value when the sweep output is stopped.

#### Table 4-5 Ranging Mode used for Sweep Source Operation

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BEST</strong></td>
</tr>
<tr>
<td>In the linear sweep mode, the sweep source channel automatically uses the minimum range which covers the whole sweep output.</td>
</tr>
<tr>
<td>In the log sweep mode, the sweep source channel automatically uses the range which provides the best resolution for each sweep step output.</td>
</tr>
<tr>
<td><strong>AUTO</strong></td>
</tr>
<tr>
<td>The sweep source channel automatically changes and sets the range which provides the best resolution to apply the source output for each sweep step.</td>
</tr>
<tr>
<td><strong>FIXED</strong></td>
</tr>
<tr>
<td>The sweep source channel sets the range specified by the range parameter <em>Source Volts: Spot</em> or <em>Source Amps: Spot</em>. See “Range parameters” on page 4-12.</td>
</tr>
</tbody>
</table>
Ranging dialog box

This dialog box provides the following parameters for setting details of the auto ranging operation for measurements.

**Ch**

Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

**Current Auto Ranging**

Current measurement auto range operation, NORMAL, SPEED, or RESOLUTION (RESOLN). See Table 4-6.

**Voltage Auto Ranging**

Voltage measurement auto range operation, NORMAL, SPEED, or RESOLUTION (RESOLN). See Table 4-6.

**Threshold**

Sets the rate value of the formula shown below.

### Table 4-6 Measurement Auto Range Operation

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NORMAL</td>
<td>Supports basic operation and downward changing operation described below</td>
</tr>
<tr>
<td>SPEED</td>
<td>Supports basic operation and upward and downward changing operations described below</td>
</tr>
<tr>
<td>RESOLN</td>
<td>Supports basic operation and upward changing operation described below</td>
</tr>
</tbody>
</table>

- **Basic operation**
  The channel automatically sets the range which provides the best resolution in performing the measurement.

- **Upward changing operation**
  If measured data ≥ value₁, the range changes up after the measurement.
  \[
  value₁ = \text{measurement range} \times \frac{\text{rate}}{100}
  \]

- **Downward changing operation**
  If measured data ≤ value₂, the range changes down immediately.
  \[
  value₂ = \text{measurement range} \times \frac{\text{rate}}{1000}
  \]
Wait Control dialog box

This dialog box provides the following parameters for setting the source and measurement wait time.

The source wait time is defined as the time the source channel cannot change the output after the start of a DC output or the trailing edge of a pulse.

The measurement wait time is defined as the time the measurement channel cannot start measurement after the start of a DC output or the trailing edge of a pulse.

Ch

Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

State

Wait time, ON or OFF

Automatic

Automatic wait time, ON or OFF

Gain and Offset

Parameters for calculating the wait time. See the following formula.

- If State=ON and Automatic=ON:
  wait time = \( \text{Gain} \times \text{initial wait time} + \text{Offset} \)

- If State=ON and Automatic=OFF:
  wait time = \( \text{Offset} \)

- If State=OFF:
  wait time=0

The initial wait time is automatically set by the instrument, and cannot be changed.
Function key group

Pressing the Function key displays the following softkeys for setting the math, limit test, and trace functions.

Math

Math function setup. See “Math Expression dialog box” on page 4-32.

Limit Test

Displays the following softkeys for setting the limit test function.

- **Composite**
  Composite limit test setup. See “Composite Limit Test Setup dialog box” on page 4-33.

- **Limits**
  Limit test setup. See “Limit Test Setup dialog box” on page 4-34.

Trace

Trace function setup. See “Trace Buffer Setup dialog box” on page 4-36.

Math Expression dialog box

This dialog box provides the following parameters for setting the math function. If the math function is ON, the measurement data can be calculated by using the specified math expression.

- **Ch**
  Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)
  This field specifies the channel set by this dialog box.

- **Status**
  Math function, ON or OFF

- **Unit String**
  Unit for the calculation result of the math expression

The available math expressions are listed in the area below the Unit String field. This area can be used to select the math expression for data calculation. To select a math expression, highlight the name in this area.

The data calculation is effective for data measured after the math function is set by this dialog box. The calculation result can be displayed on the dialog box opened by using the Result key group. See “Result key group” on page 4-40.

Math expressions can be defined by using the SCPI commands while the B2900 is in the remote mode.

For the predefined math expressions, see “Predefined Math Expressions” on page 6-17.
Composite Limit Test Setup dialog box

This dialog box provides the following parameters for setting the limit test.

**Ch**
Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)
This field specifies the channel set by this dialog box.

**Limit Test**
Composite limit test, ON or OFF

**Mode**
Operation mode, GRADING (GRADE) or SORTING (SORT)
GRADING: Grading mode. See Figure 6-5 for the operation.
SORTING: Sorting mode. See Figure 6-6 for the operation.

**Auto Clear**
Automatic clear of the composite limit test result, ON or OFF
If this parameter is ON, the composite limit test results and the DIO lines are automatically cleared.

**Update**
Only for the GRADING mode. Test result output timing, IMMEDIATE (IMM.) or END. See “Immediate?” shown in Figure 6-5.
IMMEDIATE: Output after every test (Immediate? Yes)
END: Output after the last test (Immediate? No)

**Offset Cancel**
Offset cancel, ON or OFF
If this parameter is ON, the data for the limit test judgement will be as follows.
Data for judgement = measurement data – offset value

**Offset**
Offset value used for the offset cancel, –9.999999E+20 to +9.999999E+20

**Pass Pattern**
Bit pattern for the limit test pass state. For the GRADING mode.

**Fail Pattern**
Bit pattern for the limit test fail state. For the SORTING mode.

**GPIO Pins**
Displays the DIO pins assigned to the bit pattern output. To set the pins, use the :CALC:DIG:BIT command.

**/BUSY**
DIO pin assigned to the BUSY (busy) signal output

**/SOT**
DIO pin assigned to the SOT (start of test) signal input

**/EOT**
DIO pin assigned to the EOT (end of test) signal output
For the DIO pin assignment, see “Using Digital I/O” on page 3-34.

DIO pins assigned to the GPIO Pins, /BUSY, /SOT, or /EOT must be set to the DIGITAL I/O function by using the DIO Configuration dialog box.

NOTE

Values of GPIO Pins, /BUSY, /SOT, and /EOT

0 to 14 (integer). Numbers 1 to 14 indicate the DIO pins 1 to 14, respectively. 0 indicates that it is not used.

For GPIO Pins, multiple continuous pins are assigned. For example, “1, 2, 3, 4” indicates that the DIO pins 1 to 4 are assigned. Then LSB is DIO pin 1.

Limit Test Setup dialog box

This dialog box provides the following parameters for setting the limit test, which is a part of the composite limit test.

Ch

Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

Feed Data

Type of data used for the pass/fail judgement of the limit test, MATH, VOLTS, AMPS, or OHMS.

MATH: Calculation result data of math expression

VOLTS: Voltage measurement data (Vmeas)

AMPS: Current measurement data (Imeas)

OHMS: Resistance data (=Vmeas/Imeas)

For details on using resistance compensation, see “Resistance Compensation” on page 6-16.

Test Index

Index of limit test, No. 1 to 12.

The index numbers 1 to 12 are associated with the bin numbers 1 to 12. See “Limit Test Result dialog box” on page 4-41.

Limit Test

Limit test, ON or OFF

Function

Test mode, COMPLIANCE (COMP.) or LIMIT

COMPLIANCE: Compliance check

LIMIT: Limit test

Pass Pattern

Bit pattern for the limit test pass state. For the SORTING mode.
| **Fail on** | Only for compliance check. OUT or IN.  
Fail on=IN judges limit test failure if the channel goes into the compliance state.  
Fail on=OUT judges limit test failure if the channel comes out of the compliance state. |
| **Fail Pattern** | Only for compliance check. Bit pattern for the limit test fail state. |
| **Up Pattern** | Not available for compliance check. Bit pattern for the failed-by-exceeding-upper-limit state. Used for the GRADING mode. |
| **Up Limit** | Not available for compliance check. Upper limit for the pass/fail judgement. Used for the GRADING mode. |
| **Low Pattern** | Only for limit test. Bit pattern for the failed-by-exceeding-lower-limit state. Used for the GRADING mode. |
| **Low Limit** | Only for limit test. Lower limit for the pass/fail judgement. Used for the GRADING mode. |

Bit pattern is sent to the DIO pins specified by the GPIO Pins field on the Composite Limit Test Setup dialog box.
Trace Buffer Setup dialog box

This dialog box provides the following parameters for setting the trace function. The data specified by the Feed Data parameter can be stored in the trace buffer if the Buffer Control parameter is NEXT. The maximum data size is specified by the Buffer Size parameter. See Figure 6-7 on page 6-24 for the trace buffer.

**Ch**

Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)

This field specifies the channel set by this dialog box.

**Feed Data**

Type of data placed in the trace buffer, SENSE, MATH, or LIMIT

SENSE: Measurement result data

MATH: Calculation result data of math expression

LIMIT: Limit test data

The data contains the voltage measurement data, current measurement data, resistance measurement data, source output setting data, calculation result data, limit test data, time data, or status data selected by using the Format keys of the I/O key group. See “I/O key group” on page 4-45.

**Buffer Control**

Trace buffer control mode, NEVER or NEXT

NEVER: Disables the write operation to the trace buffer.

NEXT: Enables the write operation until buffer full.

Buffer full will change the mode to NEVER.

**Buffer Size**

Size of the trace buffer, 1 to 100000 data
Trigger key group

Pressing the Trigger key displays the following softkeys for setting the trigger parameters in detail and controlling the trigger system. See Figure 6-8 on page 6-28.

**Config**

Opens a dialog box. See “Trigger Configuration dialog box” on page 4-38.

**Initiate**

Displays the softkeys for selecting the device action to initiate (to go to the arm layer of the trigger system). See Table 4-7.

**Abort**

Displays the softkeys for selecting the device action to abort (to return to the idle state of the trigger system). See Table 4-7.

**Immediate**

Displays the following softkeys for selecting the arm layer or trigger layer for sending the immediate trigger.

- **Trigger**: Selects the trigger layer.
- **Arm**: Selects the arm layer.

Selecting the layer displays the softkeys for selecting the device action to send the immediate trigger. See Table 4-7.

**Table 4-7 Softkeys to Select Device Action and Channel**

<table>
<thead>
<tr>
<th>Softkey label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALL</td>
<td>Selects the transient and acquire device actions.</td>
</tr>
<tr>
<td>Trans.</td>
<td>Selects the transient (source output) device action only.</td>
</tr>
<tr>
<td>Acq.</td>
<td>Selects the acquire (measurement) device action only.</td>
</tr>
</tbody>
</table>

On a 1-channel model, selecting the device action executes Initiate, Abort, or Immediate for the specified device action.

On a 2-channel model, selecting the device action displays the following softkeys for selecting the channel.

- **ALL**: Selects channels 1 and 2.
- **Ch 1**: Selects channel 1 only.
- **Ch 2**: Selects channel 2 only.

Selecting the channel executes Initiate, Abort, or Immediate for the specified device action of the specified channel.
Front Panel Reference
Trigger key group

Trigger Configuration dialog box

This dialog box is used to set the trigger parameters in detail. Note that the overlapped parameter values are ignored and replaced with the settings made on the Single view. See “Trigger parameters” on page 4-17.

Ch
Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)
This field specifies the channel set by this dialog box.

Layer
Specifies the layer or device action set by this dialog box.
ARM: Arm layer
TRIGGER: Trigger layer
ACTION: Device action
For ACTION, the available parameters are Ch, Layer, Action, and Trigger Output.

Action
Specifies the device action type set by this dialog box.
TRANS.: Transient (source output) device action
ACQ.: Acquire (measurement) device action

Count
Count, 1 to 100000 or INF. (infinity), for the action specified by the Ch, Layer, and Action parameters

Bypass
Bypass, ON or OFF
Bypass=ON enables the bypass only for the first passage to the event detector for the action specified by the Ch, Layer, and Action parameters.
Bypass=OFF disables the bypass.

Trigger Source
Event for the action specified by the Ch, Layer, and Action parameters. AUTO, BUS, TIMER, INT1, INT2, LAN, EXT1, EXT2, EXT3, EXT4, EXT5, EXT6, EXT7, EXT8, EXT9, EXT10, EXT11, EXT12, EXT13, or EXT14. See Table 4-8.

Period
Only for the TIMER event.
Interval of the TIMER event for the action specified by the Ch, Layer, and Action parameters, 20 µs to 100000 s for B2901A/B2902A, 10 µs to 100000 s for B2911A/B2912A

Trigger Delay
Delay time for the action specified by the Ch, Layer, and Action parameters, 0 to 100000 s
Trigger Output

Trigger output, ON or OFF

Trigger output terminal, an internal bus (INT1, INT2), LAN port (LAN), or a digital I/O pin EXTn (n=1 to 14)

If this parameter is ON, B2900 sends an output trigger when it changes the trigger state for the action specified by the Ch, Layer, and Action parameters. See Figure 6-8 on page 6-28.

For using a digital I/O pin, it is necessary to set function of the pin, output trigger polarity, type, pulse width, and so on. See “DIO Configuration dialog box” on page 4-48 and “Using Digital I/O” on page 3-34.

<table>
<thead>
<tr>
<th>Table 4-8 Trigger Source</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger Source</td>
</tr>
<tr>
<td>AUTO</td>
</tr>
<tr>
<td>BUS</td>
</tr>
<tr>
<td>TIMER</td>
</tr>
<tr>
<td>INT1 or INT2</td>
</tr>
<tr>
<td>LAN</td>
</tr>
<tr>
<td>EXTn</td>
</tr>
</tbody>
</table>
Result key group

Pressing the Result key displays the following softkeys for displaying the measurement, limit test, and trace results.

**Measure**
Displays the measurement result. See “Measure Result dialog box” on page 4-40.

**Limit Test**
Displays the limit test result. See “Limit Test Result dialog box” on page 4-41.

**Trace**
Displays the trace result. See “Trace Statistical Result dialog box” on page 4-42.

**Measure Result dialog box**

This dialog box is used to display the last single (one shot) measurement result (maximum 100000 data) stored in the data buffer.

This dialog box provides the following GUI for displaying the measurement result. The result data is shown in the index and data table below the Type field. Also, the data is plotted in the graph area above the Points fields.

<table>
<thead>
<tr>
<th><strong>Ch</strong></th>
<th>Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Type of data to display, AMPS, VOLTS, OHMS, WATTS, MATH, or TIME</td>
</tr>
<tr>
<td>AMPS:</td>
<td>Current measurement data</td>
</tr>
<tr>
<td>VOLTS:</td>
<td>Voltage measurement data</td>
</tr>
<tr>
<td>OHMS:</td>
<td>Resistance data given by Resistance=Vmeas/Imeas</td>
</tr>
<tr>
<td>WATTS:</td>
<td>Power data given by Power=Vmeas×Imeas</td>
</tr>
<tr>
<td>MATH:</td>
<td>Calculation result data of math expression</td>
</tr>
<tr>
<td>TIME:</td>
<td>Time data</td>
</tr>
</tbody>
</table>

In the above formula, Vmeas is the voltage measurement data, and Imeas is the current measurement data.

For details on using resistance compensation, see “Resistance Compensation” on page 6-16.

| **Points** | Number of data points |
Max. Y-axis maximum value of the graph.
Min. Y-axis minimum value of the graph.

Limit Test Result dialog box

This dialog box provides the following GUI for displaying the limit test result. The result data is shown in the data list area below the Length field.

Ch Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)
This field specifies the channel of the data to display.

Length Data length

The limit test data contains the following information.

(aa) BIN: bb DATA: +c.ccccccE+dd

(aa) Data index aaaa

BIN: Bin number bb (01 to 12)
The bin numbers 1 to 12 are associated with the index numbers 1 to 12. See “Limit Test Setup dialog box” on page 4-34.
If the limit test data is out of the bins, 00 is set for the GRADING mode and 15 is set for the SORTING mode.

DATA: Limit test data +c.ccccccE+dd
Trace Statistical Result dialog box

This dialog box provides the following GUI for displaying the trace statistical result. The result data is displayed in the Mean, Std. Dev., Min., and Max. fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ch</strong></td>
<td>Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)</td>
</tr>
<tr>
<td><strong>Feed</strong></td>
<td>Always SENSE</td>
</tr>
<tr>
<td><strong>Element</strong></td>
<td>Type of data to display, AMPS, VOLTS, or OHMS</td>
</tr>
<tr>
<td>AMPS</td>
<td>Current measurement data</td>
</tr>
<tr>
<td>VOLTS</td>
<td>Voltage measurement data</td>
</tr>
<tr>
<td>OHMS</td>
<td>Resistance data given by Resistance=Vmeas/Imeas</td>
</tr>
<tr>
<td></td>
<td>In the above formula, Vmeas is the voltage measurement data, and Imeas is the current measurement data.</td>
</tr>
<tr>
<td></td>
<td>For details on using resistance compensation, see “Resistance Compensation” on page 6-16.</td>
</tr>
<tr>
<td><strong>Length</strong></td>
<td>Data length</td>
</tr>
<tr>
<td><strong>Mean</strong></td>
<td>Mean value</td>
</tr>
<tr>
<td><strong>Std. Dev.</strong></td>
<td>Standard deviation</td>
</tr>
<tr>
<td><strong>Min.</strong></td>
<td>Minimum value</td>
</tr>
<tr>
<td><strong>Max.</strong></td>
<td>Maximum value</td>
</tr>
</tbody>
</table>
File key group

Pressing the File key displays the following softkeys for saving a file on and loading a file from a USB memory connected to the front panel USB-A connector.

**Save**

Displays the following softkeys for saving a file. Pressing a softkey displays the File Selection dialog box. See “File Selection dialog box” on page 4-43.

- **Measure** Saves a measurement data file.
- **Math** Saves a math result data file.
- **Limit Test** Saves a limit test result data file.
- **Trace** Saves a trace buffer data file.
- **Config** Saves a system setting data file.

**Load**

Displays the following softkey for loading a file. Pressing the softkey displays the File Selection dialog box. See “File Selection dialog box” on page 4-43.

- **Config** Loads a system setting data file.
- **License** Loads a license file.

**NOTE**

The license file enables the functions secured by license. To get the file, follow instructions described in the Software Entitlement Certificate sheet supplied with an upgrade product B2901AU, B2902AU, B2911AU, or B2912AU.

File Selection dialog box

This dialog box provides the following GUI for saving or loading a file.

- **Path** Folder name for saving or loading a file.
- **File Name** File name to save or load.

The files and folders saved in the specified folder are listed in the area between the Path field and the File Name field. This area can be used for selecting a file by highlighting its name.

For saving a system setting file, if the file extension is not specified, “.sta” is added automatically. For saving the other data file, “.csv” is added automatically.
Program key group

Pressing the Program key displays the following softkeys for setting and controlling the program memory.

The program memory can be defined by using the SCPI commands while the B2900 is in the remote mode.

Catalog
Displays the Program Catalog dialog box which lists the programs saved in the program memory. This dialog box is also used to specify the memory program to use. To select a memory program, highlight its name in this list.

View
Displays the Program View dialog box which shows the program code of the specified program.

Variable
Displays the Variable dialog box which lists the variables used in the memory programs. Available index is 1 to 100.

Control
Displays the following softkeys for controlling the operation of the program memory.

- **Run**: Starts the specified memory program.
- **Pause**: Pauses the execution of the memory program.
- **Step**: Starts the step execution of the specified memory program.
- **Stop**: Stops the execution of the memory program.
- **Continue**: Continues the execution of the memory program presently paused.
I/O key group
Pressing the I/O key displays the following softkeys for setting the I/O interfaces.

**Format**
Displays the softkeys for setting the data output format. See “Data Output Format” on page 4-46.

**LAN**
Displays the following softkeys for managing the LAN interface.

- **Config**
  Displays the LAN Configuration dialog box used to set the configuration of the LAN interface. See “LAN Configuration dialog box” on page 4-48.

- **Status**
  Displays the LAN Status dialog box which displays the status of the LAN interface.

- **Reset**
  Resets all of the LAN connections.

- **Defaults**
  Sets the LAN settings to the factory default settings.

Pressing the Reset softkey or the Defaults softkey displays a confirmation dialog box. Press the OK softkey to confirm the specified action, or press the Cancel/Local key to cancel the action.

**USB**
 Displays the USB Status dialog box.

- **Easy File Access**
  File access function setup, ON (enable) or OFF (disable).
  When this is set to ON, restart this instrument. When you use this function, connect this instrument to a PC using a USB cable. See “File Access Function (Easy File Access)” on page 6-32.

- **Text display field**
  Displays the VISA USB connect string.
  Example:
  `USB0::2391::36376::MY12345678::0::INSTR`

**GPIB**
 Displays the GPIB Configuration dialog box used to set the GPIB address of the B2900. This dialog also displays the VISA GPIB connect string.

  Example: `GPIB0::23::INSTR`

**DIO**
 Displays the following softkeys for managing the Digital I/O interface.
Front Panel Reference
I/O key group

**Config**
Displays the DIO Configuration dialog box used to set the configuration of the Digital I/O interface. See “DIO Configuration dialog box” on page 4-48.

**R/W**
Displays the DIO Read/Write dialog box used to read or write a value set to the Digital I/O interface. See “DIO Read/Write dialog box” on page 4-49.

**Data Output Format**
Pressing the Format softkey displays the following softkeys for setting the format and elements of the output data.

**Measure**
Displays the Format (Measure) dialog box used to set the elements of the measurement data output. See “Format (Measure) dialog box” on page 4-47.

**Math/Limit**
Displays the Format (Math/Limit) dialog box used to set the elements of the math result data output and the limit test result data output. See “Format (Math/Limit) dialog box” on page 4-47.

**Trace**
Displays the Format (Trace) dialog box used to set the elements of the trace data output. See “Format (Trace) dialog box” on page 4-47.

**Data Type**
Displays the following softkeys for specifying the data output format. The present setting is indicated by an asterisk on the softkey label.

- **ASCII**
  - ASCII format

- **REAL32**
  - IEEE-754 single precision format, 4-byte

- **REAL64**
  - IEEE-754 double precision format, 8-byte

**Data Swap**
Displays the following softkeys for enabling or disabling the byte swap for the IEEE-754 precision format data output. The present setting is indicated by an asterisk on the softkey label.

- **OFF**
  - Disables the byte swap. Normal byte order.

- **ON**
  - Enables the byte swap. Reverse byte order.

If Data Swap=ON, the byte order is reversed. Byte 1 to byte 4 are sent in the order of byte 4 to byte 1 for the IEEE-754 single precision format, and byte 1 to byte 8 are sent in the order of byte 8 to byte 1 for the IEEE-754 double precision format.
Format (Measure) dialog box

This dialog box provides the following parameters for setting the elements of the measurement data output.

- **Voltage**: Voltage data output, ON or OFF
- **Current**: Current data output, ON or OFF
- **Resistance**: Resistance data output, ON or OFF
- **Source**: Source data output, ON or OFF
- **Time**: Time data output, ON or OFF
- **Status**: Status data output, ON or OFF

Format (Math/Limit) dialog box

This dialog box provides the following parameters for setting the elements of the math result data output and the limit test result data output.

- **Data**: Result data output, ON or OFF
- **Time**: Time data output, ON or OFF
- **Status**: Status data output, ON or OFF

Format (Trace) dialog box

This dialog box provides the following parameters for setting the elements of the trace statistical data output.

- **Ch**: Only on 2-channel models. Channel 1 (Ch 1) or 2 (Ch 2)
  This field specifies the channel set by this dialog box.
- **Data**: Trace data. Selects one from the following data elements.
  - **MEAN**: Mean value
  - **STD.DEV.**: Standard deviation
  - **MIN.**: Minimum value
  - **MAX.**: Maximum value
  - **PK-PK**: Peak to peak value
- **Timestamp**: Timestamp data format. Selects one from the following selections.
ABSOLUTE Absolute value (ABS.). Returns the incremental value for the first timestamp data.

DELTA Delta value (DELTA). Returns the incremental value for the previous timestamp data.

LAN Configuration dialog box
This dialog box provides the following parameters for setting the configuration of the LAN interface.

mDNS mDNS (multicast DNS) status, ON or OFF
IP Address Config. IP address configuration, AUTO or MANUAL
Auto configuration uses the DHCP server.
IP Address IP address of this instrument, used for the MANUAL IP address configuration
Subnet Subnet mask, used for the MANUAL IP address configuration
Gateway IP address of gateway, used for the MANUAL IP address configuration
DNS Server Config. DNS server configuration, AUTO or MANUAL
DNS Server IP address of DNS server, primary and secondary, used for the MANUAL DNS server configuration
Hostname Host name of this instrument
WINS Server IP address of WINS server, primary and secondary

DIO Configuration dialog box
This dialog box provides the following parameters for setting the configuration of the Digital I/O interface.

Pin # Digital I/O pin number, 1 to 14
This field specifies the pin set by this dialog box.
Function Function of the specified pin of the Digital I/O interface, digital signal input/output (DIGITAL I/O), digital signal input (DIGITAL IN), trigger output (TRIGGER OUT),
trigger input (TRIGGER IN), or high voltage state (HIGH VOLTAGE LAMP, HI-VOLT LAMP, only for pin 14)

If Function is set to HIGH VOLTAGE LAMP, other setup parameters on this dialog box is ignored.

**Polarity**

Polarity of the input/output function, positive (POSITIVE, POS.) or negative (NEGATIVE, NEG.)

**Output Trigger Type**

Type of output trigger, edge (EDGE) or level (LEVEL)

**Output Trigger Timing**

Timing of the output trigger, after action (arm, trigger, and device action) (AFTER), before action (BEFORE), or both (BOTH)

**Output Pulse Width**

Pulse width of the output trigger, 10 μs to 10 ms

For more information about the trigger function, see “Trigger key group” on page 4-37.

### DIO Read/Write dialog box

This dialog box provides the following parameters for reading or writing a value set to the Digital I/O interface.

**Format**

Format of the value set to the Mask Value field and the Value field, binary (BIN), decimal (DEC), or hexadecimal (HEX)

**Mask Value**

Mask value which indicates the pattern of the un-used bits of the Digital I/O interface

The READ assist key is used to read the mask value presently set to the Digital I/O interface.

The WRITE assist key is used to set the specified mask value to the Digital I/O interface.

**Value**

Value set to the Digital I/O interface

The READ assist key is used to read the value presently set to the Digital I/O interface.

The WRITE assist key is used to write the specified value to the Digital I/O interface.
Display key group

Pressing the Display key displays the following softkeys for setting the display functions. The present setting is indicated by an asterisk on the softkey label.

Remote
Displays the following softkeys for enabling or disabling the front panel display when the B2900 is in the remote mode.

OFF
Disables the front panel display. Effective for fast operation.

ON
Enables the front panel display.

Color
Displays the following softkeys for specifying the display color set.

Set 1
Sets the color set 1.

Set 2
Sets the color set 2.

Zoom
Displays the following softkeys for enabling or disabling the display zoom.

OFF
Disables the zoom. Normal display.

ON
Enables the zoom. Only the measured data is displayed.

Zoom-in can be cancelled by pressing the Zoom Out assist key.

In the zoom-in state, setup information is not displayed, and the measurement result is zoomed. Then,

• the Dual view displays the primary measurement data with a large font, and the secondary measurement data for each channel with a small font.

• the Single view displays the primary and secondary measurement data with a large font.

Digits
Displays the following softkeys for specifying the data display resolution.

4
Sets 3½ digit resolution.

5
Sets 4½ digit resolution.

6
Sets 5½ digit resolution.

7
Sets 6½ digit resolution.

Pref.
Displays the Display Preference dialog box. See “Display Preference dialog box” on page 4-51.
Display Preference dialog box

This dialog box is used to set the following parameters. The settings are saved to the non-volatile memory.

- **Immediate V/I Update by Knob**
  Selects the channel operation when the Source value or the Limit (Compliance) value is changed by using the digit pointer and the rotary knob.
  
  **ON**
  Real time update ON
  Turning the rotary knob changes the display value and updates the channel output in real time. In this status, the decimal point cannot be moved by the digit pointer.

  **OFF**
  Real time update OFF
  Turning the rotary knob just changes the display value. The value is applied to the channel output by pressing the rotary knob.

- **Restore Trigger Mode on Local**
  Stores the trigger mode setting on entering GP-IB remote state, ON or OFF.
  
  **ON**
  Saves the trigger mode setting in the non-volatile memory on entering GPIB remote state and restores the saved trigger mode setting when returning to GPIB local mode.

  **OFF**
  Disables this function.
System key group

Pressing the System key displays the following softkeys used for several system setups.

Error
Displays the following softkeys to view or clear errors.

Log
Displays the Error Log dialog box which displays the SCPI errors.

Clear
Cuts the error buffer immediately.

Reset
Initializes the B2900.

Press the Reset softkey to display a confirmation dialog box and press one of the following softkeys to perform the initialization. To cancel the initialization and close the confirmation dialog box, press the Cancel/Local key.

Display
Initializes the display settings.

H/W
Initializes the hardware settings.

ALL
Initializes all settings.

Cal/Test
Displays the following softkeys for performing self-calibration or self-test.

Self-Cal
Performs self-calibration.

Self-Test
Performs self-test.

Pressing the softkey displays a confirmation dialog box. Press the OK softkey to start self-calibration or self-test, or the Cancel/Local key to cancel.

PLC
Displays the following softkeys to specify the power line frequency. The present setting is indicated by an asterisk on the softkey label.

50 Hz
Specifies the power line frequency 50 Hz.

60 Hz
Specifies the power line frequency 60 Hz.

Timestamp
Displays the following softkeys to clear timestamp.

Clear
Clears the timestamp. Pressing this softkey displays the confirmation dialog box. Press the OK softkey to clear the timestamp, or the Cancel/Local key to cancel.
Auto CLR
Displays the following softkeys for setting the automatic clear of the timestamp. The present setting is indicated by an asterisk on the softkey label.

OFF   Disables the automatic clear of the timestamp.
ON    Enables the automatic clear of the timestamp.

Start-up
Displays the System Start-up dialog box which provides the following setup parameters.

Power-on State
Power-on state, RST, RCL0, RCL1, RCL2, RCL3, or RCL4
The power-on state can be selected from the factory default reset condition (RST) and user conditions RCL0, RCL1, RCL2, RCL3, and RCL4 which can be defined by using the *SAV 0, *SAV 1, *SAV 2, *SAV 3, and *SAV 4 commands, respectively, while the B2900 is in the remote mode.

Power-on Program
Power-on program execution ON or OFF
If this parameter is ON, the power-on program is automatically executed when the B2900 is turned on.
The power-on program can be defined by using the :PROG:PON:COPY command while the B2900 is in the remote mode.

Sound
Displays the following softkeys to enable or disable the beep and sound. The present setting is indicated by an asterisk on the softkey label.

OFF   Disables the beep and sound.
ON    Enables the beep and sound.

Language
Displays the following softkeys for specifying the B2900 remote control command set. The present setting is indicated by an asterisk on the softkey label.

Default  Specifies the default command set which supports all B2900 functions.

2400  Specifies the conventional command set designed for using the existing programs which you created to control existing instruments, such as Series 2400 by Keithley Instruments, Inc.

Script  Not effective.
The default command set and the conventional command set are available.
Front Panel Reference
System key group

**Info.**

Displays the following softkeys.

- **Revision**: Displays the Revision dialog box which displays the model number, serial number, and firmware revision of the B2900.
- **Date/Time**: Displays the Date and Time dialog box which is used to view or set the date and time.
- **Update**: Used for firmware update.
- **Demo.**: Performs demonstration. Pressing this softkey displays a confirmation dialog box. Press the OK softkey to start demonstration, or the Cancel/Local key to cancel.

**Factory**

Returns the B2900 to the condition when it is shipped from the factory. Pressing this softkey displays a confirmation dialog box. Press the OK softkey to start the initialization, or the Cancel/Local key to cancel.
5 Front Panel Operations
Front Panel Operations

This chapter explains how to use the Keysight B2900.

- “Basic Operations”
- “To Use Functions other than Measurement”
- “To Set Source Output”
- “To Execute Measurement”
- “To Use Math Function”
- “To Execute Limit Test”
- “To Use Trace Buffer”
- “To Use Program Memory”

---

**NOTE**

**Turning the instrument on or off**
Press the standby switch. When the power is on, the LED below the switch is turned green.

---

**NOTE**

**Setting the instrument to local mode**
Press the Cancel/Local key.
The front panel keys are available when the instrument is in local mode.

---

**NOTE**

**Enabling or disabling the channel**
Press the On/Off switch.
The channel status is indicated by the lighting status of the switch as follows.
Off: The channel is disabled.
Green: The channel is enabled.
Red: The channel is in the high voltage state.

---

**NOTE**

**Starting measurement**
Press the Trigger key. According to the setting conditions, the single (one shot) measurement is performed with the DC bias output, staircase sweep output, pulsed bias output, or pulsed sweep output.
Press the Auto key. The repeat (continuous) measurement is performed with the DC bias output (of the Source value).
Basic Operations
Use the field pointer to specify a setup field in the setup screen. The field pointer can take the following states. Change the status as needed during the setup of B2900.

**MOVE status** Highlighted in blue. You can move the pointer from field to field.

**EDIT status** Highlighted in green. You can change the value of the current field.

To Change the Setting in a Field

1. If the field pointer is in the EDIT status, press the rotary knob. The pointer status is changed to MOVE.
2. Turn the rotary knob or press the arrow keys to move the field pointer.
3. Move the field pointer to the item to be changed and press the rotary knob. The pointer status is changed to EDIT.
4. Enter a value or character by pressing the numeric/alpha keys, turning the rotary knob, or pressing the arrow keys. Press the rotary knob to fix the setting value. The pointer status is changed to MOVE.
   Or press the assist key corresponding to the setting value to fix the setting value. The pointer status is changed to MOVE.

**NOTE**

Digit pointer
In numeric value entry fields such as the Source and Limit (Compliance) fields, you can specify only one digit to change its value.

When the field pointer is in the EDIT status (i.e., all digits in the entry field are highlighted in green), pressing the arrow keys changes the pointer to the digit pointer, which points only one digit in the entry field. In this status, the following operations are allowed.

The arrow keys are used to move the pointer.

The numeric/alpha keys and rotary knob are used to change the value of the digit indicated by the pointer.
Front Panel Operations
Basic Operations

When the pointer is on the decimal point, turning the knob moves the decimal point if the real-time update (Immediate V/I Update by Knob) is OFF.

NOTE

Channel operation when using the rotary knob
If the field pointer is in the EDIT (green) status on the Source or Limit (Compliance) field, turning the knob changes/updates the setting value of the source channel in real time.

Channel operation when using the knob and the digit pointer depends on the setting of the real-time update (Immediate V/I Update by Knob).

• Real time update ON
  Setting value is applied to the channel immediately.

• Real time update OFF
  Setting value is not applied immediately. It is applied to the channel by pressing the knob.

To Change the Settings on a Dialog Box

1. Set the items on the dialog box in the same way as described in “To Change the Setting in a Field” on page 5-3.

2. To apply the settings, press Apply.
   To apply all settings and close the dialog box, press OK.
   To cancel the setting change, press the Cancel/Local key instead of pressing Apply.
To Use Functions other than Measurement

This section describes the following miscellaneous operations other than the source output and measurement functions.

- “To Set Power Line Frequency”
- “To Return to Factory Shipment Condition”
- “To Apply Initial Settings”
- “To Set Beeper”
- “To Set Date and Time”
- “To Perform Self-Test”
- “To Perform Self-Calibration”
- “To Set Operations at Power On”
- “To Display Error Message”
- “To Clear Error Buffer”
- “To Clear Timestamp”
- “To Set Automatic Clear of Timestamp”
- “To Display Firmware Revision”
- “To Display License Information”
- “To Set GPIB Address”
- “To Set Remote Control Command Set”
- “To Set Remote Display Mode”
- “To Save/Recall All Setup Information”
- “To Enable/Disable Media Transfer Protocol for Easy File Access”
- “To Enable/Disable the Function to Restore the Trigger Mode Settings on the Local State”
- “To Enable/Disable Source/Limit Real Time Update by Using Digit Pointer and Knob”
Front Panel Operations
To Use Functions other than Measurement

**To Set Power Line Frequency**
1. Press the More > System > PLC function keys.
2. Press 50 Hz or 60 Hz. To cancel the setting change, press the Cancel/Local key.

**To Return to Factory Shipment Condition**
1. Press the More > System > More > Factory function keys.
2. Press OK to apply. To cancel the operation, press the Cancel/Local key.

**To Apply Initial Settings**
1. Press the More > System > Reset function keys.
   - The Confirmation dialog box and the following function keys appear.
     - **Display**: Initializes the display settings.
     - **H/W**: Initializes the hardware settings.
     - **ALL**: Initializes all settings.
2. Press one of these keys. To cancel the operation, press the Cancel/Local key.

**To Set Beeper**
1. Press the More > System > More > Sound function keys.
2. To enable the beeper, press ON. To disable it, press OFF. To cancel the setting change, press the Cancel/Local key.

**To Set Date and Time**
2. Press Date/Time.
   - The Date and Time dialog box opens.
3. Set the date and time.
4. To apply the settings, press Apply.
   - To apply the settings and close the dialog box, press OK.
   - To cancel the setting change, press the Cancel/Local key.
To Perform Self-Test

1. Press the On/Off switch and confirm that the switch is turned off.
2. Disconnect test leads and cables from the channel terminals.
3. Press the More > System > Cal/Test > Self-Test function keys.
   The Confirmation dialog box opens.
4. Press OK to perform the self-test. To cancel the operation, press the Cancel/Local key.

To Perform Self-Calibration

The self-calibration must be performed after warming-up of 60 minutes.
1. Press the On/Off switch and confirm that the switch is turned off.
2. Disconnect test leads and cables from the channel terminals.
   The Confirmation dialog box opens.
4. Press OK to perform the self-calibration. To cancel the operation, press the Cancel/Local key.

To Set Operations at Power On

1. Press the More > System > More > Start-up function keys.
   The System Start-up dialog box opens.
2. See “Start-up” on page 4-53 to set each parameter.

To Display Error Message

1. Press the More > System > Error function keys.
2. Press Log.
   The error message is displayed in the Error Log dialog box.
3. Press OK to close the dialog box.
To Clear Error Buffer

1. Press the More > System > Error function keys.
2. To clear the error buffer, press Clear. To cancel the operation, press the Cancel/Local key.

To Clear Timestamp

1. Press the More > System > Timestamp function keys.
3. To perform the operation, press OK. To cancel the operation, press the Cancel/Local key.

To Set Automatic Clear of Timestamp

1. Press the More > System > Timestamp function keys.
2. Press Auto CLR.
3. To enable the automatic clear, press ON. To disable it, press OFF. To cancel the setting change, press the Cancel/Local key.

To Display Firmware Revision

2. Press Revision.
   
   The revision information is displayed in the Revision dialog box.
   
   Press OK to close the dialog box.

To Display License Information

Perform the following steps to display the license applied to the B2900.

2. Press Revision.
   
   The license information is displayed in the Revision dialog box.
   
   Press OK to close the dialog box.
License is required for each instrument (every serial number) to use the functions secured by license.

**To Set GPIB Address**

1. Press the More > I/O function keys.
2. Press GPIB.
   
   The GPIB Configuration dialog box opens.
3. Set the GPIB address.
4. To apply the settings, press Apply.
   
   To apply the settings and close the dialog box, press OK.
   
   To cancel the setting change, press the Cancel/Local key.

**To Set Remote Control Command Set**

2. To use the default command set, press Default. To use the conventional command set, press 2400.
3. If the command set is changed, the Confirmation dialog box opens. To apply the setting change, press OK. To cancel the setting change, press the Cancel/Local key.

**To Set Remote Display Mode**

1. Press the More > Display function keys.
2. Press Remote.
3. To enable the screen display in remote mode, press ON. To disable it, press OFF.
   
   To cancel the setting change, press the Cancel/Local key.
Front Panel Operations
To Use Functions other than Measurement

**To Save/Recall All Setup Information**

This function saves/recalls all setup information of the B2900. For this function, five storage areas are available in the built-in non-volatile memory (NVRAM).

To save the setup information, do the following steps.
1. Press the Config > Save function keys.
2. Press a function key #1, #2, #3, #4, or #5 corresponding to the storage area.

To recall the setup information, do the following steps.
1. Press the Config > Recall function keys.
2. Press a function key #1, #2, #3, #4, or #5 corresponding to the storage area which stores the setup information to recall.

**To Enable/Disable Media Transfer Protocol for Easy File Access**

For details on this function, see “File Access Function (Easy File Access)” on page 6-32.

2. Set the Easy File Access field to ON (enable) or OFF (disable).
3. To apply the settings and close the dialog box, press OK.
   - To cancel the setting change, press the Cancel/Local key.
   - Changing the setting needs rebooting the B2900.

**To Enable/Disable the Function to Restore the Trigger Mode Settings on the Local State**

For details on this function, see “Display Preference dialog box” on page 4-51.

1. Press the More > Display > Pref. function keys. The Display Preference dialog box opens.
2. Set the Restore Trigger Mode on Local field to ON (enable) or OFF (disable).
3. To apply the settings and close the dialog box, press OK.
   - To cancel the setting change, press the Cancel/Local key.
To Enable/Disable Source/Limit Real Time Update by Using Digit Pointer and Knob

For details on this function, see “Display Preference dialog box” on page 4-51.

1. Press the More > Display > Pref. function keys. The Display Preference dialog box opens.
2. Set the Immediate V/I Update by Knob field to ON (enable) or OFF (disable).
3. To apply the settings and close the dialog box, press OK.
   To cancel the setting change, press the Cancel/Local key.
To Set Source Output

This section describes the following source output operations.

- “To Set Source Output Mode”
- “To Apply DC Voltage/Current”
- “To Stop Source Output”
- “To Set Limit Value”
- “To Set Output Range”
- “To Set Pulse Output”
- “To Set Sweep Output”
- “To Set List Sweep Output”
- “To Set Source Output Trigger Parameters”
- “To Set Source Wait Time”
- “To Set Output Filter”
- “To Set Connection Type”
- “To Set Low Terminal State”
- “To Enable or Disable High Capacitance Mode”
- “To Enable or Disable Over Voltage/Current Protection”
- “To Specify Output-Off Status”
- “To Enable or Disable Automatic Output-On Function”
- “To Enable or Disable Automatic Output-Off Function”
- “To Set Ranging Mode of the Sweep Source”
- “To Set Sweep Direction”
- “To Set Source Output Value after Sweep”
To Set Source Output Mode

1. For the Single view, press the Mode assist key. For the Dual view, press the Ch1 Mode or Ch2 Mode assist key.
   The field pointer moves to the Source mode setup field.
2. Press VOLTS (V) for the voltage output or AMPS (I) for the current output.

To Apply DC Voltage/Current

1. For the Single view, press the Source assist key. For the Dual view, press the Ch1 Source or Ch2 Source assist key.
   The field pointer moves to the Source value setup field.
2. Enter the output value by using the numeric/alpha keys, rotary knob, and arrow keys.
3. Press the rotary knob or assist key to fix the setting value.
4. Press the On/Off switch for channel 1 or 2 (Ch 1 or Ch 2).
   The channel starts the specified voltage/current output. While the switch is turned green, the channel continues the output and changes the value immediately if it is changed.

To Stop Source Output

1. Press the On/Off switch for channel 1 or 2 (Ch 1 or Ch 2).
   The output and measurement are stopped and the switch turns off.

To Set Limit Value

For details on this function, see “Limit/Compliance” on page 6-3.

1. For the Single view, press the Limit assist key. For the Dual view, press the Ch1 Limit or Ch2 Limit assist key.
   The field pointer moves to the Limit (Compliance) field.
2. Enter the limit value by using the numeric/alpha keys, rotary knob, and arrow keys.
3. Press the rotary knob or assist key to fix the setting value.
Front Panel Operations
To Set Source Output

**To Set Output Range**

For details on this function, see “Ranging Mode” on page 6-4 and “Range parameters” on page 4-12.

1. Press the View key to display the Single view. If the Range parameters are not displayed, press the Hide XXXX assist key.

2. Move the field pointer to the Source Volts: Spot (voltage source range) or Source Amps: Spot (current source range) field.

3. Press the rotary knob to change the pointer status to EDIT.

4. Press AUTO to set the auto range operation or FIXED to set the fixed range operation. The pointer status is changed to MOVE.

5. Move the field pointer to the range value setup field (on the right side of the Source Volts: Spot or Source Amps: Spot field).

6. Press the rotary knob to change the pointer status to EDIT.

7. Press an assist key to set the following value.
   - For the auto range operation: Minimum range of the range operation
   - For the fixed range operation: Range used for source output

**To Set Pulse Output**

For details on this function, see “Pulse Output” on page 6-7.

1. Press the View key to display the Single view.

2. Press the Show Pulse assist key to display the Pulse parameters. For details on the parameters, see “Pulse parameters” on page 4-16.

3. Move the field pointer to the Pulse field.

4. Press the rotary knob to change the pointer status to EDIT.

5. Press the ON assist key. The pointer status is changed to MOVE.

6. Move the field pointer to the pulse parameter setup field (Peak, Delay, or Width).

7. Press the rotary knob to change the pointer status to EDIT.

8. Enter the pulse peak value (Peak), delay time (Delay), or pulse width (Width).

9. Press the rotary knob or assist key to fix the setting value.
Front Panel Operations
To Set Source Output

10. Repeat steps 6 to 9 for all parameters.

**NOTE**

**Applying the pulse voltage/current**

Press the On/Off switch to start the Source value output. The Source value is used as the pulse base value.

Press the Trigger key to perform the specified pulse output and measurement.

To Set Sweep Output

For details on the sweep output function, see “Sweep parameters” on page 4-13 and “Sweep Output” on page 6-9.

The following procedure sets the staircase sweep output.

To set the pulsed sweep output, it is necessary to set the staircase sweep output and the pulse output. For details on setting the pulse output, see “To Set Pulse Output” on page 5-14.

1. Press the View key to display the Single view.
2. Press the Show Sweep assist key to display the Sweep parameters.
3. Move the field pointer to the Sweep Parameters field.
4. Press the rotary knob to change the pointer status to EDIT.
5. Press the LINEAR SINGLE, LINEAR DOUBLE, LOG SINGLE, or LOG DOUBLE assist key to select the relevant sweep operation. The pointer status is changed to MOVE.
6. Move the field pointer to the sweep parameter setup field (Start, Stop, Points, or Step).
7. Press the rotary knob to change the pointer status to EDIT.
8. Enter the sweep start value (Start), sweep stop value (Stop), number of sweep steps (Points), or sweep step value (Step).
9. Press the rotary knob or assist key to fix the setting value.
10. Repeat steps 6 to 9 for all parameters.

**NOTE**

**Applying the sweep voltage/current**

Press the On/Off switch to start the Source value output.

Press the Trigger key to perform the specified sweep output and measurement.
Front Panel Operations
To Set Source Output

To Set List Sweep Output
For details on this function, see “List Sweep” on page 6-10.

1. Press the View key to display the Single view.
2. Press the Show Sweep assist key to display the Sweep parameters.
3. Move the field pointer to the Sweep Parameters field.
4. Press the rotary knob to change the pointer status to EDIT.
5. Press the LIST assist key. The pointer status is changed to MOVE.
6. Move the field pointer to the sweep parameter setup field (Start, Stop, or Points).
7. Press the rotary knob to change the pointer status to EDIT.
8. Press the Edit assist key. The List Sweep dialog box opens.
9. Set the list sweep source using the List Sweep dialog box. For details, see “List sweep setup” on page 4-14.
10. To apply the settings, press Apply.
    - To apply the settings and close the dialog box, press OK.
    - To cancel the setting change, press the Cancel/Local key.

NOTE
Load assist key
If you press the Load assist key instead of the Edit assist key in step 8, the Load List Sweep Data dialog box opens to allow you to load list sweep data from a USB memory.
For details, see “List sweep setup” on page 4-14.

NOTE
Applying the list sweep voltage/current
Press the On/Off switch to start the Source value output.
Press the Trigger key to perform the specified list sweep output and measurement.

To Set Source Output Trigger Parameters
For details on this function, see “Trigger System” on page 6-27 and “Trigger parameters” on page 4-17.

1. Press the View key to display the Single view.
Front Panel Operations

To Set Source Output

2. Press the Show Trigger assist key to display the Trigger parameters.
3. Move the field pointer to the Trigger field.
4. Press the rotary knob to change the pointer status to EDIT.
5. Press the AUTO, SYNC, TIMER, or MANUAL assist key to set the trigger type. The pointer status is changed to MOVE.
6. Move the field pointer to the trigger parameter setup field (Count, Delay, Period, or Trigger in the Source column).
7. Press the rotary knob to change the pointer status to EDIT.
8. Enter the trigger count (Count), trigger delay time (Delay), trigger period (Period), or trigger source (Trigger).
9. Press the rotary knob or assist key to fix the setting value.
10. Repeat steps 6 to 9 for all parameters.

**NOTE**

If you want to set the trigger parameters in detail, select the MANUAL trigger type and use the Trigger Configuration dialog box opened by pressing the Trigger > Config function keys. See “Trigger key group” on page 4-37.

**To Set Source Wait Time**

For details on this function, see “Measurement Time” on page 6-5 and “Wait Control dialog box” on page 4-31.

1. Press the Config > Common > Wait function keys.
   The Wait Control dialog box opens.
2. Set each parameter in the Source column.
3. To apply the settings, press Apply.
   To apply the settings and close the dialog box, press OK.
   To cancel the setting change, press the Cancel/Local key.

**To Set Output Filter**

For details on this function, see “Output Filter” on page 6-11 and “Output Filter dialog box” on page 4-27.

1. Press the Config > Source > Filter function keys.
Front Panel Operations
To Set Source Output

The Output Filter dialog box opens.
2. Set each parameter.
3. To apply the settings, press Apply.
   To apply the settings and close the dialog box, press OK.
   To cancel the setting change, press the Cancel/Local key.

To Set Connection Type
For details on this function, see “2-Wire Connections or 4-Wire Connections” on page 3-15.
1. Press the Config > Source > Connection function keys.
   The Output Connection dialog box opens.
2. In the Ch field, set the channel to which the setting change is applied.
3. Set 2-WIRE or 4-WIRE in the Sensing Type field.
4. To apply the settings, press Apply.
   To apply the settings and close the dialog box, press OK.
   To cancel the setting change, press the Cancel/Local key.

To Set Low Terminal State
For details on this function, see “Floating” on page 3-16.
1. Press the Config > Source > Connection function keys.
   The Output Connection dialog box opens.
2. In the Ch field, set the channel to which the setting change is applied.
3. Set GROUNDED or FLOATING in the Low Terminal State field.
4. To apply the settings, press Apply.
   To apply the settings and close the dialog box, press OK.
   To cancel the setting change, press the Cancel/Local key.

To Enable or Disable High Capacitance Mode
For details on this function, see “High Capacitance Mode” on page 6-15.
Front Panel Operations
To Set Source Output

1. Press the Config > Source > Connection function keys.
   The Output Connection dialog box opens.
2. In the Ch field, set the channel to which the setting change is applied.
3. Set ON (enable) or OFF (disable) in the High Capacitance Mode field.
4. To apply the settings, press Apply.
   To apply the settings and close the dialog box, press OK.
   To cancel the setting change, press the Cancel/Local key.

To Enable or Disable Over Voltage/Current Protection
For details on this function, see “Over Voltage/Current Protection” on page 6-12.
1. Press the Config > Source > Connection function keys.
   The Output Connection dialog box opens.
2. In the Ch field, set the channel to which the setting change is applied.
3. Set ON (enable) or OFF (disable) in the Over Voltage/Current Protection field.
4. To apply the settings, press Apply.
   To apply the settings and close the dialog box, press OK.
   To cancel the setting change, press the Cancel/Local key.

To Specify Output-Off Status
For details on this function, see “Output-Off Status” on page 6-13.
1. Press the Config > Source > Connection function keys.
   The Output Connection dialog box opens.
2. In the Ch field, set the channel to which the setting change is applied.
3. Set HIGH Z (high impedance), NORMAL (normal), or ZERO (zero volt) in the Output-Off State field.
4. To apply the settings, press Apply.
   To apply the settings and close the dialog box, press OK.
   To cancel the setting change, press the Cancel/Local key.
Front Panel Operations
To Set Source Output

**To Enable or Disable Automatic Output-On Function**
For details on this function, see “Automatic Output-ON/OFF Function” on page 6-14.

1. Press the Config > Source > Connection function keys.
   The Output Connection dialog box opens.
2. In the Ch field, set the channel to which the setting change is applied.
3. Set ON (enable) or OFF (disable) in the Auto Output-On field.
4. To apply the settings, press Apply.
   To apply the settings and close the dialog box, press OK.
   To cancel the setting change, press the Cancel/Local key.

**To Enable or Disable Automatic Output-Off Function**
For details on this function, see “Automatic Output-ON/OFF Function” on page 6-14.

1. Press the Config > Source > Connection function keys.
   The Output Connection dialog box opens.
2. In the Ch field, set the channel to which the setting change is applied.
3. Set ON (enable) or OFF (disable) in the Auto Output-Off field.
4. To apply the settings, press Apply.
   To apply the settings and close the dialog box, press OK.
   To cancel the setting change, press the Cancel/Local key.

**To Set Ranging Mode of the Sweep Source**
For details on this function, see “Ranging Mode” on page 6-4.

1. Press the Config > Source > Sweep function keys.
   The Sweep dialog box opens.
2. In the Ch field, set the channel to which the setting change is applied.
3. Set BEST, AUTO, or FIXED in the Sweep Ranging field. For details, see “Sweep dialog box” on page 4-29.
To Set Source Output

4. To apply the settings, press Apply.
   To apply the settings and close the dialog box, press OK.
   To cancel the setting change, press the Cancel/Local key.

To Set Sweep Direction

1. Press the Config > Source > Sweep function keys.
   The Sweep dialog box opens.
2. In the Ch field, set the channel to which the setting change is applied.
3. Set UP or DOWN in the Sweep Direction field. For details, see “Sweep dialog box” on page 4-29.
4. To apply the settings, press Apply.
   To apply the settings and close the dialog box, press OK.
   To cancel the setting change, press the Cancel/Local key.

To Set Source Output Value after Sweep

1. Press the Config > Source > Sweep function keys.
   The Sweep dialog box opens.
2. In the Ch field, set the channel to which the setting change is applied.
3. Set START VALUE or END VALUE in the Output after Sweep field. For details, see “Sweep dialog box” on page 4-29.
4. To apply the settings, press Apply.
   To apply the settings and close the dialog box, press OK.
   To cancel the setting change, press the Cancel/Local key.
To Execute Measurement

This section describes the following measurement operations.

- “To Enable Resistance Measurement”
- “To Set Measurement Mode”
- “To Perform Spot Measurement”
- “To Stop Measurement”
- “To Set Measurement Time”
- “To Set Measurement Range”
- “To Perform Sweep Measurement”
- “To Set Measurement Trigger Parameters”
- “To Set Measurement Wait Time”
- “To Set Measurement Auto Range Operation”
- “To Enable or Disable Resistance Compensation”

To Enable Resistance Measurement

1. Press the View key to display the Single view. If the Range parameters are not displayed, press the Hide XXXX assist key.

2. Move the field pointer to the Measure Ohms (resistance measurement range) field. If this field is set to OFF, the resistance measurement is disabled.

3. Press the rotary knob to change the pointer status to EDIT.

4. Press the AUTO, FIXED, or V/I assist key to set the resistance measurement operation. The pointer status is changed to MOVE.

   For details on the resistance measurement operation, see “Range parameters” on page 4-12.

   To set the measurement range continuously, see “To Set Measurement Range” on page 5-24.
To Execute Measurement

To Set Measurement Mode

1. For the Single view, press the Measure assist key. For the Dual view, press the Ch1 Measure or Ch2 Measure assist key.

2. Press AMPS (I) for the current measurement, VOLTS (V) for the voltage measurement, OHMS (R) for the resistance measurement, or WATTS (P) for the power measurement.

To Perform Spot Measurement

1. Set the measurement mode (see “To Set Measurement Mode” on page 5-23).

2. Set the output voltage or current (see “To Apply DC Voltage/Current” on page 5-13).

3. Press the On/Off switch for channel 1 or 2 (Ch1 or Ch2).

   The channel starts the specified voltage/current output. While the switch is turned green, the channel continues the output and changes the value immediately if it is changed.

4. Press the Trigger key.

   The spot measurement is performed.

   **NOTE**

   To change the Limit value, see “To Set Limit Value” on page 5-13.

To Stop Measurement

1. Press the On/Off switch for channel 1 or 2 (Ch1 or Ch2) to turn the switch off.

   The channel stops source output and measurement.

To Set Measurement Time

For details on this function, see “Measurement Time” on page 6-5 and “Speed” on page 4-11.

1. Press the View key to display the Single view.

2. Press the Speed assist key.

3. Press the AUTO, SHORT, MEDIUM, NORMAL, LONG, or MANUAL assist key to set the measurement time.
Front Panel Operations
To Execute Measurement

4. When MANUAL is specified, the aperture time setup field and PLC setup field are displayed. Enter and fix a value in either of the fields to set the measurement time.

To Set Measurement Range
For details on this function, see “Ranging Mode” on page 6-4 and “Range parameters” on page 4-12.

1. Press the View key to display the Single view. If the Range parameters are not displayed, press the Hide XXXX assist key.

2. Move the field pointer to the Measure Volts (voltage measurement range), Measure Amps (current measurement range), or Measure Ohms (resistance measurement range) field.

3. Press the rotary knob to change the pointer status to EDIT.

4. Press AUTO to set the auto range operation or FIXED to set the fixed range operation. The pointer status is changed to MOVE.

5. Move the field pointer to the range value setup field (on the right side of the Measure Volts, Measure Amps, or Measure Ohms field).

6. Press the rotary knob to change the pointer status to EDIT.

7. Press an assist key to set the following value.
   - For the auto range operation: Minimum range of the range operation
   - For the fixed range operation: Range used for measurement

To Perform Sweep Measurement
For details on this function, see “Sweep Output” on page 6-9.

1. Press the View key to display the Single view.

2. Set the source function (see “To Set Source Output Mode” on page 5-13).

3. Set the Source value and Limit (Compliance) value (see “To Apply DC Voltage/Current” on page 5-13 and “To Set Limit Value” on page 5-13).

4. Set the measurement mode (see “To Set Measurement Mode” on page 5-23).

5. Set the sweep source (see “To Set Sweep Output” on page 5-15).

6. Press the View key to display the Graph view.

7. Press the On/Off switch for channel 1 or 2 (Ch1 or Ch2).
The channel starts the specified voltage/current output. While the switch is turned green, the channel continues the output and changes the value immediately if it is changed.

8. Press the Trigger key.

The sweep measurement is performed and the measurement result is displayed in a graph.

To Set Measurement Trigger Parameters

For details on this function, see “Trigger System” on page 6-27 and “Trigger parameters” on page 4-17.

1. Press the View key to display the Single view.

2. Press the Show Trigger assist key to display the Trigger parameters.

3. Move the field pointer to the Trigger field.

4. Press the rotary knob to change the pointer status to EDIT.

5. Press the AUTO, SYNC, TIMER, or MANUAL assist key to set the trigger type. The pointer status is changed to MOVE.

6. Move the field pointer to the trigger parameter setup field (Count, Delay, Period, or Trigger in the Measure column).

7. Press the rotary knob to change the pointer status to EDIT.

8. Enter the trigger count (Count), trigger delay time (Delay), trigger period (Period), or trigger source (Trigger).

9. Press the rotary knob or assist key to fix the setting value.

10. Repeat steps 6 to 9 for all parameters.

**NOTE**

If you want to set the trigger parameters in detail, select the MANUAL trigger type and use the Trigger Configuration dialog box opened by pressing the Trigger > Config function keys. See “Trigger key group” on page 4-37.

To Set Measurement Wait Time

For details on this function, see “Measurement Time” on page 6-5 and “Wait Control dialog box” on page 4-31.

1. Press the Config > Common > Wait function keys.
Front Panel Operations
To Execute Measurement

The Wait Control dialog box opens.
2. Set each parameter in the Measure column.
3. To apply the settings, press Apply.
   To apply the settings and close the dialog box, press OK.
   To cancel the setting change, press the Cancel/Local key.

To Set Measurement Auto Range Operation
For details on this function, see “Ranging dialog box” on page 4-30.
1. Press the Config > Measure > Ranging function keys.
   The Ranging dialog box opens.
2. In the Ch field, set the channel to which the setting change is applied.
3. Set the current measurement auto range operation (NORMAL, SPEED, or RESOLN) in the Current Auto Ranging field.
   Also, set the threshold of the auto range operation in the Threshold field.
4. Set the voltage measurement auto range operation (NORMAL, SPEED, or RESOLN) in the Voltage Auto Ranging field.
   Also, set the threshold of the auto range operation in the Threshold field.
5. To apply the settings, press Apply.
   To apply the settings and close the dialog box, press OK.
   To cancel the setting change, press the Cancel/Local key.

To Enable or Disable Resistance Compensation
1. Press the Config > Measure > R Compen function keys.
2. For the 2-channel models, specify the channel to which the setting change is applied by using the following function keys.
   ALL: Channels 1 and 2 (Ch 1 and Ch 2)
   Ch 1: Channel 1 (Ch 1) only
   Ch 2: Channel 2 (Ch 2) only
3. To enable the resistance compensation, press ON.
   To disable it, press OFF.
   To cancel the setting change, press the Cancel/Local key.
To Use Math Function

This section describes how to use the math function. For details on this function, see “Math Expression” on page 6-17. Also, for details on the setup parameters, see “Math Expression dialog box” on page 4-32.

1. Press the Function > Math function keys.
   The Math Expression dialog box opens.
2. In the Ch field, set the channel to which the setting change is applied.
3. In the Status field, set the math function ON (enable) or OFF (disable).
4. In the Unit String field, enter the unit for the calculation result data.
   To enter alphabets, press the ABC assist key and then use the numeric/alpha keys.
   To enter numbers, press the 123 assist key and then use the numeric/alpha keys.
   To delete a character, highlight the character to be deleted and then press the Delete function key.
   To insert a character, highlight the character at the position where to insert the character and then press the Insert function key.
5. Select a math expression to use.
   To select a math expression, highlight the name of the math expression in the list area below the Unit String field.
6. To apply the settings, press Apply.
   To apply the settings and close the dialog box, press OK.
   To cancel the setting change, press the Cancel/Local key.
To Execute Limit Test

This section describes how to set the limit test and how to display the result of the limit test. For details on this function, see “Limit Test” on page 6-20.

To perform the limit test, set the composite limit test, individual limit tests, and source output and measurement conditions, and then press the Trigger key.

- “To Set Composite Limit Test”
- “To Set Individual Limit Tests”
- “To Display Limit Test Result”

To Set Composite Limit Test

For details on the setup parameters, see “Composite Limit Test Setup dialog box” on page 4-33.

1. Press the Function > Limit Test > Composite function keys.
   The Composite Limit Test dialog box opens.
2. In the Ch field, set the channel to which the setting change is applied.
3. In the Limit Test field, set the composite limit test ON (enable) or OFF (disable).
4. In the Mode field, set the operation mode GRADING (grading mode) or SORTING (sorting mode).
5. In the Auto Clear field, set the automatic clear ON (enable) or OFF (disable) for the composite limit test result.
6. When the operation mode is GRADING, set the test result output timing IMMEDIATE (after every test) or END (after the last test) in the Update field.
7. In the Offset Cancel field, set the offset cancel ON (enable) or OFF (disable).
8. In the Offset field, set the offset value used for the offset cancel.
9. When the operation mode is GRADING, set a bit pattern that represents the limit test pass state (Pass) in the Pass Pattern field.
10. When the operation mode is SORTING, set a bit pattern that represents the limit test fail state (Fail) in the Fail Pattern field.
11. In the /BUSY field, set the DIO pin number used for the BUSY signal output.
12. In the /SOT field, set the DIO pin number used for the start-of-test (SOT) signal output.

13. In the /EOT field, set the DIO pin number used for the end-of-test (EOT) signal output.

14. To apply the settings, press Apply.

   To apply the settings and close the dialog box, press OK.

   To cancel the setting change, press the Cancel/Local key.

**To Set Individual Limit Tests**

For details on the setup parameters, see “Limit Test Setup dialog box” on page 4-34.

1. Press the Function > Limit Test > Limits function keys.

   The Limit Test Setup dialog box opens.

2. In the Ch field, set the channel to which the setting change is applied.

3. In the Feed Data field, set the type of data used for the pass/fail judgement of the limit test.
   - MATH: Calculation result data of math expression
   - VOLTS: Voltage measurement data (Vmeas)
   - AMPS: Current measurement data (Imeas)
   - OHMS: Resistance data (=Vmeas/Imeas)

4. In the Test Index field, set the index of the limit test between numbers 1 and 12.

   The index numbers 1 to 12 are associated with the bin numbers 1 to 12. See “To Display Limit Test Result” on page 5-31.

5. In the Limit Test field, set the limit test ON (enable) or OFF (disable) for the test identified by Test Index.

6. In the Function field, set the test mode COMPLIANCE (compliance check) or LIMIT (limit test).

7. When the operation mode is SORTING, set a bit pattern that represents the limit test pass state (Pass) in the Pass Pattern field.

8. When the test mode is COMPLIANCE, configure the following settings:

   - In the Fail on field, set the fail judgement method IN or OUT.
     - IN: Failure if the channel goes into the compliance state.
Front Panel Operations
To Execute Limit Test

OUT: Failure if the channel comes out of the compliance state.

- In the Fail Pattern field, set a bit pattern that represents the limit test fail state (Fail).

9. When the test mode is LIMIT and the operation mode is GRADING, configure the following settings:

- In the Up Pattern field, set a bit pattern that represents the failed-by-exceeding-upper-limit state.
- In the Low Pattern field, set a bit pattern that represents the failed-by-exceeding-lower-limit state.
- In the Up Limit field, set the upper limit for the pass/fail judgement.
- In the Low Limit field, set the lower limit for the pass/fail judgement.

10. To apply the settings, press Apply.

To apply the settings and close the dialog box, press OK.

To cancel the setting change, press the Cancel/Local key.

**NOTE**
For using MATH in the pass/fail judgement of the limit test, see “To Use Math Function” on page 5-27.

For using the resistance compensation, see “To Enable or Disable Resistance Compensation” on page 5-26.
To Execute Limit Test

To Display Limit Test Result

For details on the setup parameters, see “Limit Test Result dialog box” on page 4-41.

1. Press the Result > Limit Test function keys.
   The Limit Test Result dialog box opens.
2. In the Ch field, set the channel for the data to be displayed.
   The limit test result is displayed in the area below the Length field.
3. Press OK to close the dialog box.

The Length field displays the number of data.

In the area below the Length field, the limit test result is displayed in the following format:

\[(aaaaa) \text{ BIN: } bb \quad \text{DATA: } +c.ccccccE+ddd\]

- **(aaaaa)** Data index aaaaa
- **BIN:** Bin number bb (01 to 12)

  The bin numbers 1 to 12 are associated with the index numbers 1 to 12. See “To Set Individual Limit Tests” on page 5-29.

  If the limit test data is out of the bins, 00 is set for the GRADING mode and 15 is set for the SORTING mode.

- **DATA:** Limit test data +c.ccccccE+ddd
To Use Trace Buffer

This section describes how to set the trace buffer and how to display the statistical data. For details on this function, see “Trace Buffer” on page 6-23.

To use the trace buffer, set the trace buffer and source output and measurement conditions, and then press the Trigger key.

- “To Set Trace Buffer”
- “To Display Statistical Data”

To Set Trace Buffer

For details on the setup parameters, see “Trace Buffer Setup dialog box” on page 4-36.

1. Press the Function > Trace function keys.
   The Trace Buffer Setup dialog box opens.
2. In the Ch field, set the channel to which the setting change is applied.
3. In the Feed Data field, set SENSE (for collecting the measurement result data), MATH (for collecting the calculation result data), or LIMIT (for collecting the limit test result data).
4. In the Buffer Control field, set NEXT (for enabling the write operation to the trace buffer) or NEVER (for disabling it).
5. In the Buffer Size field, set the size of the trace buffer (1 to 100000).
6. To apply the settings, press Apply.
   To apply the settings and close the dialog box, press OK.
   To cancel the setting change, press the Cancel/Local key.

**NOTE**

To specify the measurement result data (SENSE) to be collected, use “Format (Measure) dialog box” on page 4-47.
To specify the calculation result data (MATH) or limit test result data (LIMIT) to be collected, use “Format (Math/Limit) dialog box” on page 4-47.
To change the statistical data to be saved in the trace buffer, use “Format (Trace) dialog box” on page 4-47.
To Display Statistical Data

For details on the setup parameters, see “Trace Statistical Result dialog box” on page 4-42.

1. Press the Result > Trace function keys.
   The Trace Statistical Result dialog box opens.
2. In the Ch field, set the channel for the data to be displayed.
3. In the Element field, set the data type SOURCE (source output data), VOLTS (voltage measurement data), AMPS (current measurement data), OHMS (resistance measurement data) for the statistical calculation.
   The statistical data for the data specified here is displayed in the area below the Length field.
4. Press OK to close the dialog box.

The Length field displays the number of data.

The statistical data is displayed in the following fields:
Mean: Mean value
Std. Dev.: Standard deviation
Min.: Minimum value
Max.: Maximum value
To Use Program Memory

This section describes how to select and run a memory program. For details on this function, see “Program Memory” on page 6-25.

See also “Program key group” on page 4-44.

• “To Select a Program”
• “To Control Program Operation”

To Select a Program

1. Press the More > Program > Catalog function keys.
   The Program Catalog dialog box opens.
2. Highlight the name of the memory program to run.
3. Press OK.

NOTE

To set a value for a variable used in the memory program, use the Variable dialog box. For details, see “Program key group” on page 4-44.

To Control Program Operation

1. Press the More > Program > Control function keys.
2. Use the following keys to control the operation of a memory program.

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run</td>
<td>Starts the execution of the specified memory program.</td>
</tr>
<tr>
<td>Pause</td>
<td>Pauses the execution of the memory program.</td>
</tr>
<tr>
<td>Step</td>
<td>Starts the step execution of the specified memory program.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops the execution of the memory program.</td>
</tr>
<tr>
<td>Continue</td>
<td>Continues the execution of the memory program presently paused.</td>
</tr>
</tbody>
</table>
6 Function Details
This chapter describes the following functions of the Keysight B2900.

- “Limit/Compliance”
- “Ranging Mode”
- “Measurement Time”
- “Pulse Output”
- “Sweep Output”
- “List Sweep”
- “Output Filter”
- “Over Voltage/Current Protection”
- “Output-Off Status”
- “Automatic Output-ON/OFF Function”
- “High Capacitance Mode”
- “Resistance Measurement”
- “Math Expression”
- “Limit Test”
- “Trace Buffer”
- “Program Memory”
- “Channel Grouping”
- “Trigger System”
- “File Access Function (Easy File Access)”
- “Interlock Function”
- “Over Temperature Protection”
- “Initial Settings”
Limit/Compliance

Limit/Compliance is the output limiter for preventing damage to the test device from overcurrent or overvoltage. Voltage compliance is for current output channels, and current compliance is for voltage output channels.

When a channel reaches compliance, the channel acts as a constant voltage source or a constant current source. The channel keeps the output value once compliance has been reached.

Compliance can be set with the same resolution and accuracy as output current or output voltage.

To Set Compliance

The following points must be noted when setting the compliance.

- The minimum compliance value is limited as follows.
  - Current compliance
    - 1% of the range (at 100 nA Range)
    - 1 nA (at 10 nA Range)
  - Voltage compliance
    - 20 mV (at 0.2 V range)
- If the current compliance value is too low, the SMU will require a long settling time.
Ranging Mode

The following ranging modes are available for performing source output or measurement.

- **FIXED** (fixed range)
  The channel uses the specified range only.

- **AUTO** (auto range)
  The channel automatically uses the range which provides the best resolution for the source output value or the measurement value. It is possible to specify the minimum range effective for the auto range operation.

- **BEST** (best, only for the sweep source channel)
  In the linear sweep mode, the channel automatically uses the minimum range which covers the whole sweep output.
  In the log sweep mode, the channel automatically uses the range which provides the best resolution for each sweep step output.

Setting the Ranging Mode

The following points must be noted when setting the ranging mode.

- The measurement channel does not use ranges higher than the minimum range which covers the Limit (Compliance) value.
- The pulsed source channel uses the fixed range for measurement. If the ranging mode other than FIXED is set, the channel automatically uses the minimum range which covers the Limit (Compliance) value.
- For the source side measurement, the channel uses the present output range.
- To set the ranging mode of the DC (constant) source or measurement channel, see “Range parameters” on page 4-12.
- To set the ranging mode of the sweep source channel, see “Sweep dialog box” on page 4-29.
- To set the detail of the auto ranging operation for measurements, see “Ranging dialog box” on page 4-30.
Measurement Time

Measurement time depends on aperture time, measurement range, and other measurement conditions, and can be expressed by the following formula:

\[ \text{Measurement time} = \text{Aperture time} + \text{Overhead time} \]

Aperture time is the time required for measurement, and does not include such factors as range change or data compensation, which would be the overhead time.

Aperture Time

Aperture time is the time required to acquire the measurement data. For accurate and reliable measurement, the aperture time should be increased.

The aperture time is set by using the Measure Speed parameter on the Single view. See “Speed” on page 4-11.

Overhead Time

Overhead time is the time required for range change, etc. This time depends on the measurement condition, and cannot be specified. Major elements of the overhead time are:

- Range change time during measurement (when measurement ranging mode is set to AUTO)
- Range change time at the start of a measurement (when the measurement range is less than the compliance value)

To Control Source/Measure Timing

The source output and measurement timing can be controlled by the following parameters. See Figure 6-1. This figure shows an example of sweep output. For a bias output, focus the shape of a sweep step only.

1. Source delay

The source delay time is defined as the time from trigger to start of a source output.
Function Details
Measurement Time

2. Measure delay
The measurement delay time is defined as the time from trigger to start of a measurement.

3. Source wait
The source wait time is defined as the time the source channel cannot change the output value after starting an output.

4. Measure wait
The measurement wait time is defined as the time the measurement channel cannot start measurement after starting an output.

5. Period
The period is the trigger interval. It can be defined for the TIMER or MANUAL trigger type (trigger source) and for the source output and measurement actions individually.

Figure 6-1 Source Output and Measurement Timing, Sweep Output Example

To set the delay time and the period, see “Trigger parameters” on page 4-17.
To set the wait time, see “Wait Control dialog box” on page 4-31.
For more information about the trigger setup, see “Trigger key group” on page 4-37.
Pulse Output

The source/measure unit SMU can apply the pulsed voltage or current. Figure 6-2 shows a pulsed sweep output example. For a pulsed bias output, focus the shape of a pulse only.

To Control Pulse Output/Measure Timing

The pulse output and measurement timing can be controlled by the following parameters. See Figure 6-2.

1. Source delay
   
   The source delay time is defined as the time from trigger to start of a source output.

2. Measure delay
   
   The measurement delay time is defined as the time from trigger to start of a measurement.

3. Pulse delay
   
   The pulse delay time is defined as the time from the start of a source output to the start of a pulse (peak) output.

4. Source wait
   
   The source wait time is defined as the time the source channel cannot change the output value after the trailing edge of a pulse.

5. Measure wait
   
   The measurement wait time is defined as the time the measurement channel cannot start measurement after the trailing edge of a pulse.

6. Pulse width
   
   The pulse width is the time from the start of a pulse output to the end of a pulse (peak) output. However, it is strictly defined as the time from 10 % of peak level at the leading edge to 90 % of peak level at the trailing edge. The available values are 50 μs to 100000 s.
Function Details
Pulse Output

Figure 6-2  Pulse Output and Measurement Timing, Sweep Output Example

Voltage or current

To set the delay time, see “Trigger parameters” on page 4-17.

To set the pulse delay time and the pulse width, see “Pulse parameters” on page 4-16.

To set the wait time, see “Wait Control dialog box” on page 4-31.

For more information about the trigger setup, see “Trigger key group” on page 4-37.

To Set Pulse Output

The following points must be noted when setting the pulse output.

• Pulse base value is set by the Source value on the Single or Dual view.
• Pulse peak value is set by the Single view.

Set the Peak value of “Pulse parameters” on page 4-16 for the pulsed bias output.

Or set the Start, Stop, and Points values of “Sweep parameters” on page 4-13 for the pulsed sweep output.
Sweep Output

The source/measure unit SMU can apply a sweep voltage or current. It supports several shapes of sweep output, as shown in Figure 6-3. The SMU not only performs the sweep output but performs the measurement for each sweep step as shown in Figures 6-1 and 6-2.

![Figure 6-3 Variety of Sweep Outputs](image)

To Set Sweep Output

The following points must be noted when setting the sweep output.

- To set the staircase sweep source, see “Sweep parameters” on page 4-13.
- To set the ranging mode of the sweep source, see “Sweep dialog box” on page 4-29.
- To set the sweep direction, see “Sweep dialog box” on page 4-29.
- To set the output condition after sweep, see “Sweep dialog box” on page 4-29.
- To set the pulse delay time and the pulse width, see “Pulse parameters” on page 4-16.
- To set the list sweep source, see “List sweep setup” on page 4-14.
List Sweep

The list sweep function is effective for performing an arbitrary waveform output. The source/measure unit (SMU) can apply the waveform as shown in Figure 6-4, and measure voltage or current at each output value. The source output and the measurement can be performed in the following minimum interval.

- B2901A/B2902A: 20 μs
- B2911A/B2912A: 10 μs

The source output and measurement timing is controlled by the trigger system. And the interval can be set to a constant value if the trigger type is set to TIMER.

To set these trigger parameters, see “Trigger parameters” on page 4-17. The interval can be set by the Period parameter. The number of output values can be set by the Count parameter.

To set the source output values, use the List Sweep dialog box. See “List sweep setup” on page 4-14.

Figure 6-4 shows an example setup of the List Sweep dialog box with an image of the output waveform.

Figure 6-4 List Sweep Dialog Box
Output Filter

The filter is mounted on the source/measure unit (SMU). It assures clean source output without spikes, noise, and overshooting. However, using a filter may increase the SMU settling time.

To set the filter, see “Output Filter dialog box” on page 4-27.
Function Details
Over Voltage/Current Protection

Over Voltage/Current Protection

The over voltage/current protection is effective for preventing damage to the test device from overcurrent or overvoltage. If this function is enabled, the source/measure unit (SMU) sets the output to 0 V and sets the output switch to off automatically and immediately when it reaches the compliance status.

To set the over voltage/current protection, see “Output Connection dialog box” on page 4-28.
Output-Off Status

The output-off status is the condition which is set on the source/measure unit (SMU) automatically, immediately after its output is turned off. The status must be specified before enabling the source output. The available conditions are shown in Table 6-1.

To set the output-off status, see “Output Connection dialog box” on page 4-28.

<table>
<thead>
<tr>
<th>Name</th>
<th>Conditions after output-off</th>
</tr>
</thead>
</table>
| HIGH Z, high impedance | • Output relay: off (open or break)  
• Voltage source setup is not changed if the source applies 40 V or less.  
• Current source setup is not changed if the source uses the 100 mA range or lower. |
| NORMAL | • Source function: Voltage source  
• Output voltage: 0 V  
• Current compliance: 100 μA at the 100 μA range  
• Output relay: off (open or break) |
| ZERO | • Source function: Voltage source  
• Output voltage: 0 V  
• Current compliance: 100 μA at the 100 μA range |

**NOTE**

This setting is not applied to the output-off process triggered by the emergency condition such as the over voltage/current protection, interlock open, and over temperature protection. Then the output voltage is immediately set to 0 V and the output switch is set to off.
Automatic Output-ON/OFF Function

The automatic output-ON/OFF function defines the source channel’s output ON/OFF operation when the trigger system changes the status.

- Automatic-ON function
  
  If this function is enabled, the source/measure unit (SMU) automatically turns the channel output ON just before the trigger system is initiated by an SCPI command, not by a front panel operation.

- Automatic-OFF function
  
  If this function is enabled, the SMU automatically turns the channel output OFF immediately when all trigger system changes the status from busy to idle.

To set the automatic output ON/OFF function, see “Output Connection dialog box” on page 4-28.
High Capacitance Mode

High capacitance mode is effective for the measurement of a capacitive load greater than 0.01 μF.

If the measurement result data is not stable, set this function ON. The measurement data may come stable. This function is effective for measurements of capacitive devices up to 50 μF.

High capacitance mode is available for the following source/measure condition.

- Operation mode: voltage source (Source Volts) and current measurement (Measure Amps)
- Measurement ranging mode: FIXED
- Measurement range: 1 μA to 10 A

To set the high capacitance mode, see “Output Connection dialog box” on page 4-28.
Resistance Measurement

B2900 supports resistance measurement. If the measurement parameter is set to resistance OHMS (R), the source/measure unit (SMU) automatically sets the current source and voltage measurement operation to perform resistance measurement.

For performing accurate measurement, B2900 provides the compensation function.

NOTE

To Enable Resistance Measurement

The resistance measurement operation must be specified. See “Range parameters” on page 4-12 and “To Enable Resistance Measurement” on page 5-22.

In the initial setting, the resistance measurement operation is set to OFF.

Resistance Compensation

Resistance compensation (R Compen) is effective for performing low resistance measurements accurately. If R Compen is set to ON, the channel performs measurement twice and returns the compensated measurement result given by the following formula. This technique is effective for reducing the thermal EMF.

\[ R_{\text{compen}} = \frac{(V_2 - V_1)}{(I_2 - I_1)} \]

where, \( V_1 \) is the measurement results at the 0 A source condition, and \( I_1 \) is the measurement results at the 0 V source condition.

To enable resistance compensation, press the Config > Measure > R Compen > ON function key on a 1-channel model, or the Config > Measure > R Compen > ALL or Ch 1 or Ch2 > ON function key on a 2-channel model.

To disable resistance compensation, press the Config > Measure > R Compen > OFF function key on a 1-channel model, or the Config > Measure > R Compen > ALL or Ch 1 or Ch2 > OFF function key on a 2-channel model.
Math Expression

B2900 provides a math function for performing calculations using the measurement result data. The calculation result can be displayed and used for the limit test and trace statistics.

For the predefined math expressions, see “Predefined Math Expressions”.

To define a math expression, see the Keysight B2900 SCPI Command Reference. Math expressions can be defined by using the :CALC:MATH commands. For resources effective for the expression, see “Resources Used in the Expressions”.

To use the math function, see “Math Expression dialog box” on page 4-32.

To display the calculation result, see “Graph View” on page 4-19 and “Measure Result dialog box” on page 4-40.

Predefined Math Expressions

The following math expressions have already been defined in B2900. The predefined math expressions are not cleared by the power off and on operations.

- Power (POWER)
- Offset Compensated Ohms (OFFCOMPOHM)
- Varistor Alpha (VARALPHA)
- Voltage Coefficient (VOLTCOEF)

In the following formula, \([c]\) specifies the channel (1 or 2) used for the measurement.

**POWER**

Calculates power using the following formula.

\[
\text{POWER} = \text{VOLT}[c] \times \text{CURR}[c]
\]

**OFFCOMPOHM**

Calculates offset compensated ohms (resistance) using the following formula.

\[
\text{OFFCOMPOHM} = \frac{(\text{VOLT}[c][1] - \text{VOLT}[c][0])}{(\text{CURR}[c][1] - \text{CURR}[c][0])}
\]

where, \(\text{VOLT}[c][0]\) and \(\text{CURR}[c][0]\) are the data measured with a current output level, and \(\text{VOLT}[c][1]\) and \(\text{CURR}[c][1]\) are the data measured with a different current output level or zero output.
Function Details
Math Expression

This function is effective for reducing measurement errors in low resistance measurements.

**VARALPHA**
Calculates varistor alpha using the following formula.

\[
\text{VARALPHA} = \frac{\log(\text{CURR}[c][1] / \text{CURR}[c][0])}{\log(\text{VOLT}[c][1] / \text{VOLT}[c][0])}
\]

where, \(\text{CURR}[c][0]\) and \(\text{VOLT}[c][0]\) are the measurement data at a point on a varistor’s non-linear I-V characteristics curve, and \(\text{CURR}[c][1]\) and \(\text{VOLT}[c][1]\) are the data at the another point.

**VOLTCOEF**
Calculates voltage coefficient using the following formula.

\[
\text{VOLTCOEF} = \frac{(\text{RES}[c][1] - \text{RES}[c][0])}{(\text{RES}[c][1] \times (\text{VOLT}[c][1] - \text{VOLT}[c][0]))} \times 100\%
\]

where, \(\text{RES}[c][0]\) and \(\text{RES}[c][1]\) are the resistance measurement data at the first and second measurement points, respectively, and \(\text{VOLT}[c][0]\) and \(\text{VOLT}[c][1]\) are the voltage measurement data at the first and second measurement points, respectively.

The voltage coefficient is known as the ratio of the fractional change for a resistor whose resistance varies with voltage.

**Resources Used in the Expressions**
The following resources can be used in user-defined math expressions.

- **Reserved variables**
  The variables listed in Table 6-2 are reserved for reading the channel output or measurement data.
  Scalar variable is used for spot measurement data.
  Vector (array) variable is used for sweep measurement data.

- **Math operators**
  The following operators are available.
  - Arithmetic operators: +, -, *, /, ^, see Table 6-3
  - Elementary functions: ln, log, sin, cos, tan, exp

  The functions log and ln perform the operation after calculating the absolute value. So if a negative value is specified, they do not cause an error but calculate as a positive value. For example, log(−10) results in log(10)=1.
Table 6-2  Reserved Variables

<table>
<thead>
<tr>
<th>Reserved variable $^a$</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scalar</td>
<td>Vector</td>
</tr>
<tr>
<td>SOUR$[c]$</td>
<td>SOUR$[c][]$</td>
</tr>
<tr>
<td>VOLT$[c]$</td>
<td>VOLT$[c][]$</td>
</tr>
<tr>
<td>CURR$[c]$</td>
<td>CURR$[c][]$</td>
</tr>
<tr>
<td>RES$[c]$</td>
<td>RES$[c][]$</td>
</tr>
<tr>
<td>TIME$[c]$</td>
<td>TIME$[c][]$</td>
</tr>
</tbody>
</table>

a. The numeric suffix $[c]$ is effective for specifying the channel. For example, use CURR2 to read the current spot measurement data of the channel 2.

Table 6-3  Arithmetic and Unary Operators

<table>
<thead>
<tr>
<th>Priority of task</th>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>( )</td>
<td>Parentheses</td>
</tr>
<tr>
<td>:</td>
<td>+ and −</td>
<td>Unary plus operator and unary minus operator</td>
</tr>
<tr>
<td>:</td>
<td>^</td>
<td>Exponentiation operator</td>
</tr>
<tr>
<td>:</td>
<td>* and /</td>
<td>Multiplication operator and division operator</td>
</tr>
<tr>
<td>Low</td>
<td>+ and −</td>
<td>Additive operator and subtraction operator</td>
</tr>
</tbody>
</table>
Limit Test

Limit test is a pass/fail judgement performed for a measurement data or math result data obtained by a channel. It can be performed if both individual limit test and composite limit test are set to ON. Maximum of twelve limit tests can be defined and used for the bins of composite limit test.

Composite limit test supports the following two operation modes.

- Grading mode
  Performs limit test for up to 12 test limits (bins) until a failure is detected. See Figure 6-5 for an example flowchart.

- Sorting mode
  Performs limit test for up to 12 test limits (bins) until a pass is detected. See Figure 6-6 for an example flowchart.

In the figures, SOT is the start-of-test strobe pulse sent by the component handler connected to B2900 via the Digital I/O connector.

To set the composite limit test, see “Composite Limit Test Setup dialog box” on page 4-33.

To set the individual limit tests, see “Limit Test Setup dialog box” on page 4-34.

The composite limit test result Pass or Fail is displayed with the measurement result data on the Single or Dual view. To display the limit test result log, see “Limit Test Result dialog box” on page 4-41.

**NOTE**

**Limit test for the math result**

If the math expression refers to a measurement result data by multiple channels, the acquire trigger count for the channels must be the same.

If the math expression contains a vector operation, the acquire trigger count must be equal to or greater than the maximum number of the vector.
Figure 6-5  Composite Limit Test Flowchart Example for Grading Mode

Display example of PASS status when Zoom is ON:

Single view
-062.7822 mV
PASS

Dual view
-062.7822 mV
+000.0944 µA

START
Wait for SOT
Source and Sense

Perform Limit X?
No

Yes

Pass?
No

Immediate?
Yes

Immediate?
No

Pass?
Yes

First Failure?
No

Yes

Display "PASS"

Display "FAIL"

Last Limit?
Yes

Save Fail Pattern

Output Fail Pattern

Immediate?
No

Yes

Output Pass Pattern

Yes

Another Data?

No

Another Device?

Yes

Yes

Output Saved Fail Pattern

No

No

No

Yes

No

Yes

Yes

No

No

Yes

Yes

GRADING MODE
Figure 6-6  Composite Limit Test Flowchart Example for Sorting Mode

START

Wait for SOT

Source and Sense

Perform Limit X ?
  No
  Yes

Pass ?
  Yes
  No

Last Limit ?
  Yes
  No

Display “FAIL”

Output Fail Pattern

Another Device ?
  Yes
  No

Display “PASS”

Output Pass Pattern

SORTING MODE

Yes

No

Display example of PASS status when Zoom is ON:

Single view

Dual view

-062.7822 mV
PASS

-000.0944 μA

-021.7846 mV
Trace Buffer

The trace buffer collects the test result data until a buffer full is detected. The maximum data size is 100,000 blocks for each channel. The data flow is shown in Figure 6-7. One data block may contain multiple data, such as voltage measurement data, current measurement data, resistance measurement data, source output data, calculation result data, limit test data, time data, and status data. They are selected by using the Format keys of the I/O key group. See “I/O key group” on page 4-45.

For setting the trace buffer, see “Trace Buffer Setup dialog box” on page 4-36.

In Figure 6-7, the variables indicate the following data.

- **VOLT**: Voltage measurement data
- **CURR**: Current measurement data
- **RES**: Resistance measurement data
- **TIME**: Time data (timestamp of the measurement start trigger)
- **STAT**: Status data or limit test status
- **SOUR**: Source output data
- **CALC**: Math (calculation) result data or limit test data (= raw data - offset data)

If data is stored in the trace buffer, its statistical data can be calculated. Calculable statistical data is as follows.

- **MEAN**: Mean value
- **SDEV**: Standard deviation
- **MIN**: Minimum value
- **MAX**: Maximum value
- **PKPK**: Peak to peak value

The statistical data (except for PKPK) of VOLT, CURR, or RES data can be displayed on the Trace Statistical Result dialog box. See “Trace Statistical Result dialog box” on page 4-42 for displaying the data.

Use an external computer to display the data which cannot be displayed on the B2900 screen. The data can be saved in an USB memory connected to the front panel USB-A connector or can be read by using SCPI commands.
Function Details
Trace Buffer

**NOTE**
Do not forget to save or read the data before turning the B2900 off. The trace buffer is cleared by turning the instrument off.

**Figure 6-7** Data Flow to Trace Buffer for Each Channel

![Diagram showing data flow to trace buffer for each channel.]
Program Memory

The program memory stores command strings temporarily. The stored program can be executed by using the front panel keys, or automatically when B2900 is turned on. See “Program key group” on page 4-44 and “Start-up” on page 4-53. The keys used for controlling the program memory are shown in Table 6-4. This table also shows the status changed by pressing the program control keys.

The program memory can eliminate several processes in the program execution, such as transferring commands, checking command syntax, and converting commands to the internal codes. Thus, using the program memory speeds up program execution. If frequently used command strings are stored in the program memory, interface/computer activity is minimized.

The program memory can be defined by using SCPI commands while B2900 is in the remote mode. See Keysight B2900 series SCPI Command Reference.

- Number of programs saved in the memory: 100
- Number of programs used for start-up automatic execution: 1
- Total memory size: 100 KB
- Maximum length for a line: 256 bytes
- Maximum number of characters of program name: 32 with alphabets, numbers, hyphens, and underscores

Table 6-4  Program Control Keys (Function Keys) and Status Changes

<table>
<thead>
<tr>
<th>Control key</th>
<th>Present execution status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Running</td>
</tr>
<tr>
<td>Run</td>
<td>Error to Running</td>
</tr>
<tr>
<td>Pause</td>
<td>to Paused</td>
</tr>
<tr>
<td>Step</td>
<td>Error to Running to Paused</td>
</tr>
<tr>
<td>Stop</td>
<td>to Stopped</td>
</tr>
<tr>
<td>Continue</td>
<td>Error to Running</td>
</tr>
</tbody>
</table>
Channel Grouping

This section applies only to 2-channel models. This function is used to control the channel output timing automatically so that the channel keeps the output while the other channel performs measurement.

The grouped channels start the source output in the order of channel number, then start the measurement at the same time, and keep the output until the measurement is completed. If delay time and wait time are set, this is adjusted by these values.

If the grouping is released, the channels work independently regardless of the condition of the other channel.

To enable the channel grouping, press the Config > Common > Group > ON function keys.

To disable the channel grouping, press the Config > Common > Group > OFF function keys.

Conditions for the channels to group:

• Trigger source (Trigger value) must be the same.

• If the trigger source is set to TIMER, the trigger period (Period value) of the source output trigger (transient action) must be the same. This is not applicable if the trigger count (Count value) is set to 1.

NOTE

About Wait Time

If wait time is set, channels cannot start measurement or source output change until the wait time elapses. See “Wait Control dialog box” on page 4-31 for setting the wait time.

For the grouped channels, the wait time starts at the timing of the last output change (DC output change or pulse level transition from peak to base) by the last source output channel.
Trigger System

B2900 supports the ARM-TRIGGER model described in *1999 SCPI Command Reference*. Operation summary of this trigger model is described below. Also see Figure 6-8.

The trigger system can be initiated by pressing the Trigger key on the front panel. For the trigger setup parameters, see “Trigger parameters” on page 4-17 and “Trigger Configuration dialog box” on page 4-38.

1. Moves to the ARM layer if the trigger system was initiated.
2. Waits for the ARM event which is a signal from the ARM trigger source.
3. Moves to the TRIGGER layer if the ARM event was detected and the ARM delay time elapsed.
4. Waits for the TRIGGER event which is a signal from the TRIGGER trigger source.
5. Executes the device action if the TRIGGER event was detected and the TRIGGER delay time elapsed.
6. Repeats 4 and 5 until the TRIGGER count reaches the specified count. And then moves to the ARM layer.
7. Repeats 2 to 6 until the ARM count reaches the specified count. And then moves to the Idle layer.

This trigger model is applied to two device actions, Transient (source output) and Acquire (measurement) independently. Two actions can start simultaneously or separately.

Also for the 2-channel models, two channels can perform synchronous operation or asynchronous operation.

**NOTE**

**Auto key**

The Auto key sets the operation of the trigger system to AUTO or off.

In the AUTO status, the channel in the DC output status (On/Off switch is ON) repeats measurement (Acquire device action) under the predefined trigger conditions. The Transient device action is not performed.

For the predefined trigger conditions, see “Auto” on page 4-3.
Function Details
Trigger System

Figure 6-8  B2900 Trigger System

![Diagram of the B2900 Trigger System]

- **Initiated?**
  - No
  - Yes

**ARM Layer**

- **Trigger key**
  - Auto key

- **Event detector**
  - ARM event
  - ARM count = 0

- **ARM delay**
  - No
  - Yes

**TRIGGER Layer**

- **TRIGGER key**
  - Auto key

- **Event detector**
  - TRIGGER event
  - TRIGGER count = 0

- **TRIGGER delay**
  - No
  - Yes

**Device action (Transient or Acquire)**

**Trigger output**

- before ARM
- after ARM

- before TRIGGER
- after TRIGGER

- before Device action
- after Device action

**Last count?**

- No
- Yes

**ARM count + 1**

**TRIGGER count + 1**

**TRIGGER count**

1 to 10000
INF. (infinity)

**Integer count**

1 to 10000
INF. (infinity)
Trigger Source

B2900 supports the following trigger sources. The trigger source must be set to the ARM event and the TRIGGER event individually.

- AUTO (automatic internal, AINT): Trigger source best suited for the present operating mode is automatically selected by the internal algorithms.
- BUS: Remote interface trigger command such as GET, TRIGger, and *TRG
- TIMER (timer, TIMer): Signal internally generated every interval set by the Period field
- INT1 or INT2 (internal): Signal from the internal bus 1 or 2
- EXT1, EXT2, EXT3, EXT4, EXT5, EXT6, EXT7, EXT8, EXT9, EXT10, EXT11, EXT12, EXT13, or EXT14 (external): Signal from the DIO pin \( n \), which is an I/O port of the Digital I/O D-sub connector on the rear panel. \( n = 1 \) to 14
- LAN: LXI trigger

Device Actions

B2900 supports the following device actions. Also see Figure 6-9.

- Transient device action (source output)
  Source channel starts source output for applying one output value if the TRIGGER event was detected and the Source delay time elapsed.
- Acquire device action (measurement)
  Measurement channel starts measurement for obtaining one measurement data if the TRIGGER event was detected and the Measure delay time elapsed.

**NOTE**

To synchronize the channel operation, for the 2-channel models

If channels are set as shown below, the device actions start simultaneously.

- To synchronize source output:
  - Trigger source is set to the same mode.
  - Delay time is set to the same value.
  - Source output ranging mode is set to the fixed mode.
  - Source wait time control is set to OFF.
Function Details
Trigger System

- Measurement wait time control is set to OFF.
- Measurement ranging mode is set to the fixed mode.
- To synchronize measurement:
  - Trigger source is set to the same mode.
  - Delay time is set to the same value.
  - Measurement wait time control is set to OFF.
  - Measurement ranging mode is set to the fixed mode.

Figure 6-9 Transient and Acquire Device Actions

- Transient device action - for voltage or current output -

- Acquire device action - for voltage or current measurement -
Trigger Output

B2900 can output trigger at the timing of Trigger output shown in Figure 6-8. The trigger output terminal can be selected from the following terminals.

- Internal bus, INT1, INT2
- LAN port
- Digital I/O pin, EXT1, EXT2, EXT3, EXT4, EXT5, EXT6, EXT7, EXT8, EXT9, EXT10, EXT11, EXT12, EXT13, EXT14

The trigger output can be set by using “Trigger Configuration dialog box” on page 4-38. The trigger output timing and the setup parameters are shown in Table 6-5.

Table 6-5

<table>
<thead>
<tr>
<th>Trigger output timing</th>
<th>Layer</th>
<th>Action</th>
<th>Trigger Output</th>
<th>Output Trigger Timing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting ARM loop</td>
<td>ARM</td>
<td>TRANS. for transient action or ACQ. for acquire action</td>
<td>ON</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Ending ARM loop</td>
<td>ARM</td>
<td></td>
<td>ON</td>
<td>AFTER</td>
</tr>
<tr>
<td>Starting TRIGGER loop</td>
<td>TRIGGER</td>
<td></td>
<td>ON</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Ending TRIGGER loop</td>
<td>TRIGGER</td>
<td></td>
<td>ON</td>
<td>AFTER</td>
</tr>
<tr>
<td>Starting Transient device action</td>
<td>ACTION</td>
<td>TRANS.</td>
<td>ON</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Ending Transient device action</td>
<td>ACTION</td>
<td>TRANS.</td>
<td>ON</td>
<td>AFTER</td>
</tr>
<tr>
<td>Starting Acquire device action</td>
<td>ACTION</td>
<td>ACQ.</td>
<td>ON</td>
<td>BEFORE</td>
</tr>
<tr>
<td>Ending Acquire device action</td>
<td>ACTION</td>
<td>ACQ.</td>
<td>ON</td>
<td>AFTER</td>
</tr>
</tbody>
</table>

For using a digital I/O pin, it is necessary to set function of the pin, output trigger polarity, type, pulse width, and the Output Trigger Timing parameter. See “DIO Configuration dialog box” on page 4-48 and “Using Digital I/O” on page 3-34.
Function Details
File Access Function (Easy File Access)

File Access Function (Easy File Access)

File access function uses MTP (media transfer protocol) to easily download B2900 files (measurement data, instrument settings, and screen images) to your PC.

**NOTE**
This function is available for the B2900 firmware revision 3.0 or later. And the “SWS” license is required to enable this function. See “To Use Functions other than Measurement” on page 5-5 to confirm the firmware revision and the license applied to the B2900. Also see “File key group” on page 4-43 for the license.

To use this function, do the steps below.

1. Set ON to the Easy File Access field on the USB Status dialog box opened by More > IO > USB operations.
   Changing the setting needs rebooting the B2900.
2. Connect the B2900 to your PC using the furnished USB cable.
   The first time you do this, a driver is installed. On subsequent plug-ins an AutoPlay dialog box will pop up on your PC screen, then you will be able to open the device to access the files that are stored on the B2900 internal memory and the USB memory connected to the B2900. The B2900 will appear as a read/writeable drive on your PC’s file system, and the internal memory and external USB memory will appear as sub-devices of the drive.
   For more details, see Readme.html in the root folder in the internal memory.

**NOTE**
To control the B2900 using a PC, it must be installed with Keysight IO Libraries Suite or equivalent. However, it is not required if you do not do remote control or if you use the file access function in manual operation.
Interlock Function

The interlock function is designed to prevent electrical shock when a user touches the measurement terminals. If the interlock terminal is open, maximum output is limited to ±42 V.

To perform high voltage measurement greater than ±42 V, connect the interlock terminal to an interlock circuit of a test fixture or a shielding box. The interlock circuit must have one LED and two mechanical switches that are connected together and placed near the shielding box opening doors. For details on installing the interlock circuit, see “Installing the Interlock Circuit” on page 3-24.

The interlock function works as shown below.

- When the interlock terminal is open, maximum output is limited to ±42 V.
- When the interlock terminal is shorted, source channel can apply its maximum output value.
- When the interlock terminal is opened in a high voltage condition greater than ±42 V, the output voltage is immediately set to 0 V and the output switch is set to off.

**WARNING**

Open the interlock terminal so that the SMU cannot apply dangerous voltage when the source/measure terminal is touchable or opened.

Ouvrir la borne de verrouillage afin que le délivreur de tension ne puisse pas appliquer de tension dangereuse lorsque la borne source/de mesure est à portée de main ou ouverte.
**Over Temperature Protection**

The over temperature protection is effective for preventing damage to a channel from over temperature. If B2900 is used in an environment over 30 °C, channel outputs are limited to the value less than the maximum value. If a channel output reaches the limit, all channels automatically and immediately set the output to 0 V and set the output switch to off. And the causal channel is locked automatically.

To unlock the channel, the self-test must be performed. If the self-test does not report any problem, you can use the channel soon. For performing the self-test, see “Self-test” on page 3-11.

The maximum output for the condition over 30 °C is less than the maximum output for the specification condition of 23 °C ± 5 °C. The channel output limit is given by the following formula.

\[
DC_{\text{MAX}} \leq \left( \left[ \left( \frac{P_{CS} + 30 - T_{\text{AMB}}}{V_{OAB} \times |I_B|} \right) - \frac{V_{OAB} \times |I_p|}{|V_{P}|} \right] / |V_{OAP} \times |I_p| \right)^2 \times 100
\]

The parameters are described below.

- **DC_{\text{MAX}}**: Allowable maximum duty ratio in %, or 0 for DC bias output
- **P_{CS}**: Maximum power, 64 W
- **T_{\text{AMB}}**: Ambient temperature, in °C
- **V_{OAB}**: 250 V, for |I_B| ≤ 105 mA
  - 39 V, for |I_B| > 105 mA and |V_{B}| > 6V
  - 21 V, for |I_B| > 105 mA and |V_{B}| ≤ 6V
- **V_{B}**: Pulse base voltage setting value or DC bias voltage setting value, in V
- **I_{B}**: Current at pulse base or DC current, in A
- **V_{OAP}**: 250 V, for |I_p| ≤ 105 mA
  - 39 V, for |I_p| > 105 mA and |V_{p}| > 6V
  - 21 V, for |I_p| > 105 mA and |V_{p}| ≤ 6V
- **V_{p}**: Pulse peak voltage setting value, in V
- **I_{p}**: Current at pulse peak, in A
Initial Settings

The B2900 is initialized by turning the B2900 on, the *RST command, or the device clear. Initial settings of the B2900 are shown in this section.

<table>
<thead>
<tr>
<th>Setup item</th>
<th>Power on</th>
<th>Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPIO function</td>
<td>DIGITAL IN</td>
<td>→</td>
</tr>
<tr>
<td>GPIO function (D14)</td>
<td>HIGH VOLTAGE LAMP</td>
<td>→</td>
</tr>
<tr>
<td>GPIO polarity</td>
<td>NEGATIVE</td>
<td>→</td>
</tr>
<tr>
<td>GPIO output trigger type</td>
<td>EDGE</td>
<td>→</td>
</tr>
<tr>
<td>GPIO output trigger timing</td>
<td>BOTH</td>
<td>→</td>
</tr>
<tr>
<td>GPIO output trigger pulse width</td>
<td>100 μs</td>
<td>→</td>
</tr>
<tr>
<td>Display digits</td>
<td>7</td>
<td>→</td>
</tr>
<tr>
<td>Zoomed display</td>
<td>OFF</td>
<td>Not changed</td>
</tr>
<tr>
<td>Display image format</td>
<td>JPG</td>
<td>→</td>
</tr>
<tr>
<td>User message enable</td>
<td>Disabled</td>
<td>→</td>
</tr>
<tr>
<td>User message</td>
<td>***</td>
<td>→</td>
</tr>
<tr>
<td>Byte swap (measurement data)</td>
<td>OFF</td>
<td>→</td>
</tr>
<tr>
<td>Data format (measurement data)</td>
<td>ASCII</td>
<td>→</td>
</tr>
<tr>
<td>Data format (GPIO data)</td>
<td>ASCII</td>
<td>→</td>
</tr>
<tr>
<td>Data format (status register)</td>
<td>ASCII</td>
<td>→</td>
</tr>
<tr>
<td>Data elements (measurement data)</td>
<td>All (V/I/R/S/T/Stat)</td>
<td>→</td>
</tr>
<tr>
<td>Data elements (calculate)</td>
<td>CALC</td>
<td>→</td>
</tr>
<tr>
<td>Automatic timestamp reset</td>
<td>ON</td>
<td>→</td>
</tr>
<tr>
<td>Mass storage directory</td>
<td>(Root)</td>
<td>→</td>
</tr>
</tbody>
</table>
### Function Details

#### Initial Settings

<table>
<thead>
<tr>
<th>Setup item</th>
<th>Power on</th>
<th>Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program variables</td>
<td>None</td>
<td>Not changed</td>
</tr>
<tr>
<td>Program selection</td>
<td>None</td>
<td>→</td>
</tr>
<tr>
<td>Program status</td>
<td>Idle</td>
<td>→</td>
</tr>
</tbody>
</table>

Table 6-7

#### SMU Initial Settings

<table>
<thead>
<tr>
<th>Setup item</th>
<th>Power on</th>
<th>Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low terminal state</td>
<td>GROUNDED</td>
<td>Not changed</td>
</tr>
<tr>
<td>Output state</td>
<td>OFF</td>
<td>→</td>
</tr>
<tr>
<td>Output auto filter enable</td>
<td>ON</td>
<td>→</td>
</tr>
<tr>
<td>Output filter enable</td>
<td>ON</td>
<td>→</td>
</tr>
<tr>
<td>Output filter time constant</td>
<td>5 μs</td>
<td>→</td>
</tr>
<tr>
<td>Output filter frequency</td>
<td>31.8309886 kHz</td>
<td>→</td>
</tr>
<tr>
<td>Output OFF state</td>
<td>NORMAL</td>
<td>→</td>
</tr>
<tr>
<td>Output protection</td>
<td>OFF</td>
<td>→</td>
</tr>
<tr>
<td>Source mode</td>
<td>VOLTS</td>
<td>→</td>
</tr>
<tr>
<td>Source shape</td>
<td>DC</td>
<td>→</td>
</tr>
<tr>
<td>Automatic output-on</td>
<td>ON</td>
<td>→</td>
</tr>
<tr>
<td>Automatic output-off</td>
<td>OFF</td>
<td>→</td>
</tr>
<tr>
<td>Voltage source</td>
<td>0 V</td>
<td>→</td>
</tr>
<tr>
<td>Voltage protection level</td>
<td>2 V</td>
<td>→</td>
</tr>
<tr>
<td>Voltage source auto ranging</td>
<td>ON</td>
<td>→</td>
</tr>
<tr>
<td>Voltage source range</td>
<td>2 V</td>
<td>→</td>
</tr>
<tr>
<td>Voltage source range lower limit</td>
<td>0.2 V</td>
<td>→</td>
</tr>
<tr>
<td>Voltage source mode</td>
<td>Constant voltage</td>
<td>→</td>
</tr>
</tbody>
</table>
### Function Details

#### Initial Settings

<table>
<thead>
<tr>
<th>Setup item</th>
<th>Power on</th>
<th>Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage sweep points</td>
<td>1</td>
<td>→</td>
</tr>
<tr>
<td>Voltage sweep start</td>
<td>0 V</td>
<td>→</td>
</tr>
<tr>
<td>Voltage sweep stop</td>
<td>0 V</td>
<td>→</td>
</tr>
<tr>
<td>Voltage list points</td>
<td>1</td>
<td>→</td>
</tr>
<tr>
<td>Voltage list values</td>
<td>0 V</td>
<td>→</td>
</tr>
<tr>
<td>Current source</td>
<td>100 μA</td>
<td>→</td>
</tr>
<tr>
<td>Current protection level</td>
<td>100 μA</td>
<td>→</td>
</tr>
<tr>
<td>Current source auto ranging</td>
<td>ON</td>
<td>→</td>
</tr>
<tr>
<td>Current source range</td>
<td>100 μA</td>
<td>→</td>
</tr>
<tr>
<td>Current source range lower limit</td>
<td>10 nA for B291x</td>
<td>→</td>
</tr>
<tr>
<td></td>
<td>100 nA for B290x</td>
<td></td>
</tr>
<tr>
<td>Current source mode</td>
<td>Constant current</td>
<td>→</td>
</tr>
<tr>
<td>Current sweep points</td>
<td>1</td>
<td>→</td>
</tr>
<tr>
<td>Current sweep start</td>
<td>0 A</td>
<td>→</td>
</tr>
<tr>
<td>Current sweep stop</td>
<td>0 A</td>
<td>→</td>
</tr>
<tr>
<td>Current list points</td>
<td>1</td>
<td>→</td>
</tr>
<tr>
<td>Current list values</td>
<td>0 A</td>
<td>→</td>
</tr>
<tr>
<td>Sweep direction</td>
<td>UP</td>
<td>→</td>
</tr>
<tr>
<td>Double sweep</td>
<td>OFF</td>
<td>→</td>
</tr>
<tr>
<td>Sweep ranging</td>
<td>BEST</td>
<td>→</td>
</tr>
<tr>
<td>Continuous triggered source</td>
<td>ON</td>
<td>→</td>
</tr>
<tr>
<td>Pulse delay</td>
<td>0 s</td>
<td>→</td>
</tr>
<tr>
<td>Pulse width</td>
<td>50 μs</td>
<td>→</td>
</tr>
<tr>
<td>Auto settling time</td>
<td>ON</td>
<td>→</td>
</tr>
</tbody>
</table>
## Function Details
### Initial Settings

<table>
<thead>
<tr>
<th>Setup item</th>
<th>Power on</th>
<th>Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settling time</td>
<td>0 s</td>
<td>→</td>
</tr>
<tr>
<td>Measure function</td>
<td>Current measure</td>
<td>→</td>
</tr>
<tr>
<td>Auto aperture</td>
<td>ON</td>
<td>→</td>
</tr>
<tr>
<td>Aperture time</td>
<td>0.1 PLC</td>
<td>→</td>
</tr>
<tr>
<td>Voltage measure range mode</td>
<td>AUTO</td>
<td>→</td>
</tr>
<tr>
<td>Voltage measure range limit</td>
<td>0.2 V</td>
<td>→</td>
</tr>
<tr>
<td>Voltage measure range</td>
<td>2 V</td>
<td>→</td>
</tr>
<tr>
<td>Current measure mode</td>
<td>AUTO</td>
<td>→</td>
</tr>
<tr>
<td>Current measure range limit</td>
<td>1 μA</td>
<td>→</td>
</tr>
<tr>
<td>Current measure range</td>
<td>100 μA</td>
<td>→</td>
</tr>
<tr>
<td>Resistance measure mode</td>
<td>OFF</td>
<td>→</td>
</tr>
<tr>
<td>Res. meas. range</td>
<td>2 Ω</td>
<td>→</td>
</tr>
<tr>
<td>Res. meas. range limit (Low)</td>
<td>2 Ω</td>
<td>→</td>
</tr>
<tr>
<td>Res. meas. range limit (High)</td>
<td>200 MΩ</td>
<td>→</td>
</tr>
<tr>
<td>Res. meas. compensation</td>
<td>OFF</td>
<td>→</td>
</tr>
<tr>
<td>Remote sensing</td>
<td>OFF</td>
<td>→</td>
</tr>
<tr>
<td>Measurement auto range operation</td>
<td>NORMAL</td>
<td>→</td>
</tr>
<tr>
<td>Measurement auto range threshold</td>
<td>90</td>
<td>→</td>
</tr>
</tbody>
</table>
### Table 6-8

**Trigger System Initial Settings**

<table>
<thead>
<tr>
<th>Setup item</th>
<th>Power on</th>
<th>Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARM count</td>
<td>1</td>
<td>→</td>
</tr>
<tr>
<td>ARM source</td>
<td>AINT</td>
<td>→</td>
</tr>
<tr>
<td>ARM timer</td>
<td>100 µs</td>
<td>→</td>
</tr>
<tr>
<td>ARM delay time</td>
<td>0 s</td>
<td>→</td>
</tr>
<tr>
<td>ARM bypass</td>
<td>OFF</td>
<td>→</td>
</tr>
<tr>
<td>Trigger count</td>
<td>1</td>
<td>→</td>
</tr>
<tr>
<td>Trigger source</td>
<td>AINT</td>
<td>→</td>
</tr>
<tr>
<td>Trigger timer</td>
<td>10 µs for B291x&lt;br&gt;20 µs for B290x</td>
<td>→</td>
</tr>
<tr>
<td>Trigger delay time</td>
<td>0 s</td>
<td>→</td>
</tr>
<tr>
<td>Trigger bypass</td>
<td>OFF</td>
<td>→</td>
</tr>
<tr>
<td>External trigger output</td>
<td>EXT1</td>
<td>→</td>
</tr>
<tr>
<td>External trigger output (LAN)</td>
<td>LAN0-7 (all)</td>
<td>→</td>
</tr>
<tr>
<td>External trigger output enable</td>
<td>OFF</td>
<td>→</td>
</tr>
</tbody>
</table>
### LXI Trigger Events Initial Settings

<table>
<thead>
<tr>
<th>Setup item</th>
<th>Power on</th>
<th>Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event domain</td>
<td>0</td>
<td>→</td>
</tr>
<tr>
<td>Delay time</td>
<td>0</td>
<td>→</td>
</tr>
<tr>
<td>Input/output filter string</td>
<td>“ALL:5044”</td>
<td>→</td>
</tr>
<tr>
<td>Input/output status</td>
<td>OFF</td>
<td>→</td>
</tr>
<tr>
<td>Input detection</td>
<td>RISE</td>
<td>→</td>
</tr>
<tr>
<td>Output drive</td>
<td>OFF</td>
<td>→</td>
</tr>
<tr>
<td>Output slope</td>
<td>Positive</td>
<td>→</td>
</tr>
<tr>
<td>Output source</td>
<td>“”</td>
<td>→</td>
</tr>
<tr>
<td>Output timestamp delta</td>
<td>0</td>
<td>→</td>
</tr>
<tr>
<td>Event logging</td>
<td>ON</td>
<td>→</td>
</tr>
<tr>
<td>Circular event logging</td>
<td>ON</td>
<td>→</td>
</tr>
<tr>
<td>Event log size</td>
<td>100</td>
<td>→</td>
</tr>
</tbody>
</table>
### Table 6-10  Calculate Functions Initial Settings

<table>
<thead>
<tr>
<th>Setup item</th>
<th>Power on</th>
<th>Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td>Composite limit test result transfer timing</td>
<td>IMM</td>
<td>→</td>
</tr>
<tr>
<td>Composite limit test result automatic clearance</td>
<td>ON</td>
<td>→</td>
</tr>
<tr>
<td>Composite limit test fail bit pattern</td>
<td>All 0</td>
<td>→</td>
</tr>
<tr>
<td>Composite limit test pass bit pattern</td>
<td>All 0</td>
<td>→</td>
</tr>
<tr>
<td>Composite limit test mode</td>
<td>GRADing</td>
<td>→</td>
</tr>
<tr>
<td>DIO pins for bit pattern output</td>
<td>None</td>
<td>→</td>
</tr>
<tr>
<td>DIO pin for BUSY signal output</td>
<td>None</td>
<td>→</td>
</tr>
<tr>
<td>DIO pin for EOT signal output</td>
<td>None</td>
<td>→</td>
</tr>
<tr>
<td>DIO pin for SOT signal input</td>
<td>None</td>
<td>→</td>
</tr>
<tr>
<td>Limit test feed source</td>
<td>VOLTage</td>
<td>→</td>
</tr>
<tr>
<td>Compliance check fail bit pattern</td>
<td>All 0</td>
<td>→</td>
</tr>
<tr>
<td>Compliance check fail condition</td>
<td>IN</td>
<td>→</td>
</tr>
<tr>
<td>Limit test function</td>
<td>LIM</td>
<td>→</td>
</tr>
<tr>
<td>Upper limit</td>
<td>+1</td>
<td>→</td>
</tr>
<tr>
<td>Lower limit</td>
<td>-1</td>
<td>→</td>
</tr>
<tr>
<td>Upper bit pattern</td>
<td>All 0</td>
<td>→</td>
</tr>
<tr>
<td>Pass bit pattern</td>
<td>All 0</td>
<td>→</td>
</tr>
<tr>
<td>Lower bit pattern</td>
<td>All 0</td>
<td>→</td>
</tr>
<tr>
<td>Limit test enable</td>
<td>OFF</td>
<td>→</td>
</tr>
<tr>
<td>Math function enable</td>
<td>OFF</td>
<td>→</td>
</tr>
<tr>
<td>Math function expression</td>
<td>(VOLT*CURR)</td>
<td>→</td>
</tr>
<tr>
<td>Math function expression name</td>
<td>“POWER”</td>
<td>→</td>
</tr>
</tbody>
</table>
### Function Details

#### Initial Settings

<table>
<thead>
<tr>
<th>Setup item</th>
<th>Power on</th>
<th>Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td>Math function catalog</td>
<td>“POWER”, “OFFCOMPOHM”, “VOLTCOEF”, “VARALPHA”</td>
<td>→</td>
</tr>
<tr>
<td>Math function unit name</td>
<td>“W”</td>
<td>→</td>
</tr>
<tr>
<td>Offset value for test</td>
<td>0</td>
<td>→</td>
</tr>
<tr>
<td>Offset value enable</td>
<td>OFF</td>
<td>→</td>
</tr>
<tr>
<td>Trace feed source</td>
<td>SENSE</td>
<td>→</td>
</tr>
<tr>
<td>Trace control</td>
<td>NEVER</td>
<td>→</td>
</tr>
<tr>
<td>Trace points</td>
<td>100000</td>
<td>→</td>
</tr>
<tr>
<td>Trace statistics format</td>
<td>MEAN</td>
<td>→</td>
</tr>
<tr>
<td>Trace timestamp format</td>
<td>ABS</td>
<td>→</td>
</tr>
</tbody>
</table>
### Table 6-11  Non-volatile Communication Settings

<table>
<thead>
<tr>
<th>Setup item</th>
<th>Factory default setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>DHCP</td>
<td>Enabled</td>
</tr>
<tr>
<td>IP address</td>
<td>169.254.5.2</td>
</tr>
<tr>
<td>Subnet mask</td>
<td>255.255.0.0</td>
</tr>
<tr>
<td>Default gateway</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>Obtain DNS server from DHCP</td>
<td>Enabled</td>
</tr>
<tr>
<td>DNS server</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>WINS server</td>
<td>0.0.0.0</td>
</tr>
<tr>
<td>Hostname</td>
<td>K-B29xxA-nnnnn</td>
</tr>
<tr>
<td>Desired hostname</td>
<td>B29xxA: model number</td>
</tr>
<tr>
<td>Desired service name</td>
<td>nnnnn: suffix of serial number.</td>
</tr>
<tr>
<td>mDNS</td>
<td>Enabled</td>
</tr>
<tr>
<td>Use DNS naming service</td>
<td>Enabled</td>
</tr>
<tr>
<td>Use NetBIOS naming service</td>
<td>Enabled</td>
</tr>
<tr>
<td>Domain name</td>
<td>Not set</td>
</tr>
<tr>
<td>GPIB address</td>
<td>23</td>
</tr>
<tr>
<td>LXI identify</td>
<td>Disabled</td>
</tr>
<tr>
<td>GPIB command interface</td>
<td>Enabled</td>
</tr>
<tr>
<td>USB command interface</td>
<td>Enabled</td>
</tr>
<tr>
<td>VXI-11 command interface</td>
<td>Enabled</td>
</tr>
<tr>
<td>SCPI telnet command interface</td>
<td>Enabled</td>
</tr>
<tr>
<td>SCPI socket command interface</td>
<td>Enabled</td>
</tr>
<tr>
<td>SCPI HiSLIP command interface</td>
<td>Enabled</td>
</tr>
</tbody>
</table>
### Initial Settings

<table>
<thead>
<tr>
<th>Setup item</th>
<th>Factory default setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web interface</td>
<td>Enabled</td>
</tr>
<tr>
<td>Command prompt for a Telnet session</td>
<td>B2900A&gt;</td>
</tr>
<tr>
<td>Welcome message for a Telnet session</td>
<td>Welcome to Keysight B2900A Series</td>
</tr>
</tbody>
</table>

Table 6-12  **Other Non-volatile Settings**

<table>
<thead>
<tr>
<th>Setup item</th>
<th>Factory default setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel grouping</td>
<td>“1” for 1-ch models</td>
</tr>
<tr>
<td></td>
<td>“1-2” for 2-ch models</td>
</tr>
<tr>
<td>Remote display</td>
<td>Enabled</td>
</tr>
<tr>
<td>Display color set</td>
<td>1</td>
</tr>
<tr>
<td>Beeper</td>
<td>Enabled</td>
</tr>
<tr>
<td>Graphical web interface (web server)</td>
<td>Enabled</td>
</tr>
<tr>
<td>SCPI language mode</td>
<td>Default</td>
</tr>
<tr>
<td>Power-on program</td>
<td>Not set</td>
</tr>
<tr>
<td>Line frequency</td>
<td>50 Hz</td>
</tr>
<tr>
<td>Fan control mode</td>
<td>Normal</td>
</tr>
<tr>
<td>Immediate V/I update by knob</td>
<td>OFF</td>
</tr>
<tr>
<td>Restore trigger mode on Local</td>
<td>OFF</td>
</tr>
</tbody>
</table>